The Showfoto Handbook
The Showfoto Handbook
# Contents

## 1 Introduction
1.1 Background ............................................................ 13
   1.1.1 About Showfoto .................................................... 13
   1.1.2 Reporting Bugs ................................................... 13
   1.1.3 Support .......................................................... 13
   1.1.4 Getting Involved ................................................ 13

## 1.2 Supported Image Formats .......................................... 14
   1.2.1 Introduction ..................................................... 14
   1.2.2 Still Image Compression ....................................... 14
   1.2.3 JPEG ............................................................ 14
   1.2.4 TIFF ............................................................ 15
   1.2.5 PNG ............................................................. 15
   1.2.6 PGF ............................................................. 15
   1.2.7 RAW ............................................................ 15

## 2 The Showfoto sidebar .................................................. 17
2.1 The Showfoto Right Sidebar ........................................ 17
   2.1.1 Introduction to the Right Sidebar ............................. 17
   2.1.2 Properties ....................................................... 17
   2.1.3 Metadata ........................................................ 18
      2.1.3.1 EXIF Tags .................................................... 19
         2.1.3.1.1 What is EXIF ............................................ 19
         2.1.3.1.2 How to Use EXIF Viewer ............................. 19
      2.1.3.2 Makernote Tags ............................................. 20
         2.1.3.2.1 What is Makernote ................................... 20
         2.1.3.2.2 How to Use Makernote Viewer ....................... 20
      2.1.3.3 IPTC Tags ................................................... 20
         2.1.3.3.1 What is IPTC .......................................... 20
         2.1.3.3.2 How to Use IPTC Viewer ............................ 21
      2.1.3.4 XMP Tags .................................................... 21
         2.1.3.4.1 What is XMP ........................................... 21
         2.1.3.4.2 How to Use XMP Viewer ............................ 21
   2.1.4 Colors ........................................................... 21
The Showfoto Handbook

2.1.4.1 Histogram Viewer ........................................... 21
2.1.4.2 How To Use an Histogram .............................. 23
2.1.5 Maps .............................................................. 25
2.1.6 Captions ............................................................ 26
2.1.6.1 Introduction .................................................. 26
2.1.6.2 Comment View ............................................. 27
2.1.6.3 Date & Time ............................................... 27
2.1.6.4 Rating ....................................................... 28
2.1.6.5 Tag Tree ..................................................... 28
2.1.6.6 Information View ........................................ 28
2.1.7 Versions view .................................................. 28
2.1.8 Filters ............................................................. 30
2.1.9 Tools view ........................................................ 31
2.1.9.1 Sidebar Tools of the Image Editor .................. 31
3 Using Showfoto ....................................................... 32
3.1 Photographic Editing - Workflow ............................. 32
3.1.1 Image Editing/Workflow Tools ............................ 32
3.1.1.1 A Standard Workflow Proposal .................... 32
3.1.1.2 Introduction to common editing tools features .... 33
3.1.1.3 The Showfoto tool set .................................. 34
3.1.2 Processing RAW image files, RAW work-flow .......... 35
3.1.3 Color editing tools ............................................. 35
3.1.3.1 Encoding Depth .......................................... 35
3.1.3.2 Color Management ..................................... 35
3.1.3.3 Introduction ............................................... 35
3.1.3.4 Black and White Conversion Filters ................ 38
3.1.3.4.1 The Legacy Black and White Films Emulation . 38
3.1.3.4.2 Simulate Infrared Film ......................... 42
3.1.3.5 Correcting Colors ....................................... 43
3.1.3.6 Introduction ............................................... 45
3.1.3.6.1 Using Adjust Curves ............................. 46
3.1.3.6.2 The Adjust Curves in action .................... 47
3.1.3.7 Introduction ............................................... 48
3.1.3.7.1 Using the Adjust Levels tool .................. 49
3.1.3.7.2 The Adjust Levels tool in action ............... 50
3.1.3.8 Correcting Exposure ..................................... 51
3.1.3.9 Introduction ............................................... 52
3.1.3.9.1 Using the Channel Mixer ....................... 52
3.1.3.9.2 The channel mixer in action ................... 53
3.1.3.10 Introduction ............................................. 53
3.1.3.10.1 Using the Whitebalance Tool ................. 54
3.1.3.11 Color Negative Tool ........................................ 56

3.1.4 Image Enhancement ............................................. 56

3.1.4.1 Introduction ................................................ 56

3.1.4.1.1 Using the lens distortion tool ....................... 56

3.1.4.1.2 The lens distortion tool in action ................. 58

3.1.4.2 Introduction ................................................ 58

3.1.4.2.1 Create the Black Frames ......................... 59

3.1.4.2.2 Using the hotpixel tool .......................... 59

3.1.4.2.3 The hotpixels tool in action .................... 60

3.1.4.3 Improve Photos exposure with Local Contrast Tool ...... 60

3.1.4.4 Introduction ................................................ 61

3.1.4.4.1 Using the noisereduction Tool .................. 62

3.1.4.4.2 Noisereduction in action ........................ 63

3.1.4.5 Softening a Photograph .................................. 64

3.1.4.6 Introduction ................................................ 65

3.1.4.6.1 Using the Restoration tool ..................... 65

3.1.4.6.2 The Restoration tool in action ................ 67

3.1.4.7 Introduction ................................................ 68

3.1.4.7.1 Using the vignetting correction tool .......... 69

3.1.4.7.2 The vignetting correction tool in action .... 70

3.1.4.8 Introduction ................................................ 71

3.1.4.8.1 Using the Inpainting tool ..................... 72

3.1.4.8.2 The Inpainting tool in action ................ 73

3.1.4.9 Remove Red Eyes in a Photograph .................... 74

3.1.4.10 Introduction .............................................. 75

3.1.4.10.1 Adjusting Sharpness .............................. 75

3.1.4.10.2 Unblurring a Photograph ....................... 75

3.1.4.10.3 Reducing Graininess In a Photograph ........ 76

3.1.4.10.4 Softening a Photograph ......................... 76

3.1.4.10.5 The Unsharp Masking Filter .................... 76

3.1.4.10.6 The Unsharp Mask in action ................ 77

3.1.4.10.7 Refocus a Photograph .......................... 78

3.1.4.10.8 Using the Refocus Tool ......................... 79

3.1.4.10.9 Refocus comparison with other techniques ... 80

3.1.4.11 Lens Auto Correction Tool ............................ 82

3.1.5 Image transformation tools .................................. 82

3.1.5.1 Cropping a Photograph .................................. 82

3.1.5.1.1 Manual Crop ........................................ 82

3.1.5.1.2 Auto Crop .......................................... 83

3.1.5.1.3 Proportional Crop ................................. 83
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.5.4</td>
<td>Introduction</td>
<td>82</td>
</tr>
<tr>
<td>3.1.5.4.1</td>
<td>Resizing a Photograph</td>
<td>82</td>
</tr>
<tr>
<td>3.1.5.4.2</td>
<td>Increasing image size (Restoration)</td>
<td>82</td>
</tr>
<tr>
<td>3.1.5.4.3</td>
<td>The blow-up tool in action</td>
<td>87</td>
</tr>
<tr>
<td>3.1.5.5</td>
<td>The Liquid Rescale Tool</td>
<td>87</td>
</tr>
<tr>
<td>3.1.5.6</td>
<td>Rotating or Flipping a Photograph</td>
<td>87</td>
</tr>
<tr>
<td>3.1.5.7</td>
<td>Introduction</td>
<td>88</td>
</tr>
<tr>
<td>3.1.5.7.1</td>
<td>Using the Sheartool</td>
<td>88</td>
</tr>
<tr>
<td>3.1.5.7.2</td>
<td>The Sheartool in action</td>
<td>88</td>
</tr>
<tr>
<td>3.1.6</td>
<td>Adding decorative elements</td>
<td>89</td>
</tr>
<tr>
<td>3.1.6.1</td>
<td>Introduction</td>
<td>89</td>
</tr>
<tr>
<td>3.1.6.1.1</td>
<td>Using the Texture Tool</td>
<td>89</td>
</tr>
<tr>
<td>3.1.6.1.2</td>
<td>The Texture tool in action</td>
<td>89</td>
</tr>
<tr>
<td>3.1.6.2</td>
<td>Introduction</td>
<td>90</td>
</tr>
<tr>
<td>3.1.6.2.1</td>
<td>Using the Add-border tool</td>
<td>90</td>
</tr>
<tr>
<td>3.1.6.2.2</td>
<td>The Add-border tool in action</td>
<td>90</td>
</tr>
<tr>
<td>3.1.6.3</td>
<td>Introduction</td>
<td>91</td>
</tr>
<tr>
<td>3.1.6.3.1</td>
<td>Using the Insert Text tool</td>
<td>91</td>
</tr>
<tr>
<td>3.1.6.3.2</td>
<td>The Insert Text tool in action</td>
<td>91</td>
</tr>
<tr>
<td>3.1.7</td>
<td>Special Effects (Filters)</td>
<td>92</td>
</tr>
<tr>
<td>3.1.7.1</td>
<td>Introduction</td>
<td>92</td>
</tr>
<tr>
<td>3.1.7.1.1</td>
<td>Using the Blurfx</td>
<td>92</td>
</tr>
<tr>
<td>3.1.7.1.2</td>
<td>The Blurfx in action</td>
<td>92</td>
</tr>
<tr>
<td>3.1.7.2</td>
<td>Introduction</td>
<td>93</td>
</tr>
<tr>
<td>3.1.7.2.1</td>
<td>Using the Charcoal filter</td>
<td>93</td>
</tr>
<tr>
<td>3.1.7.2.2</td>
<td>The Charcoal filter in action</td>
<td>93</td>
</tr>
<tr>
<td>3.1.7.3</td>
<td>Introduction</td>
<td>94</td>
</tr>
<tr>
<td>3.1.7.3.1</td>
<td>The Solarization Effect</td>
<td>94</td>
</tr>
<tr>
<td>3.1.7.3.2</td>
<td>The Vivid Effect (Velvia filter)</td>
<td>94</td>
</tr>
<tr>
<td>3.1.7.3.3</td>
<td>The Neon Effect</td>
<td>95</td>
</tr>
<tr>
<td>3.1.7.3.4</td>
<td>The Edge Effect</td>
<td>95</td>
</tr>
<tr>
<td>3.1.7.3.5</td>
<td>The Lut3D Effect</td>
<td>95</td>
</tr>
<tr>
<td>3.1.7.4</td>
<td>Introduction</td>
<td>96</td>
</tr>
<tr>
<td>3.1.7.4.1</td>
<td>Using the filter</td>
<td>96</td>
</tr>
<tr>
<td>3.1.7.4.2</td>
<td>The Distortion filter in action</td>
<td>96</td>
</tr>
</tbody>
</table>
3.1.7.5 Introduction ............................................. 112
  3.1.7.5.1 Using the Emboss filter .......................... 112
  3.1.7.5.2 The Emboss filter in action ....................... 112
3.1.7.6 Introduction ............................................. 113
  3.1.7.6.1 Using the Filmgrain filter ......................... 113
  3.1.7.6.2 The filter in action ................................ 113
3.1.7.7 Introduction ............................................. 114
  3.1.7.7.1 Using the Oil Paint filter ......................... 114
  3.1.7.7.2 The Oil Paint filter in action ..................... 114
3.1.7.8 Introduction ............................................. 115
  3.1.7.8.1 Using the Raindrops filter ....................... 115
  3.1.7.8.2 The Raindrops filter in action .................... 116
3.2 RAW File Treatment and Color Management .............................. 116
  3.2.1 Introduction ............................................. 116
    3.2.1.1 Which buttons do I push? ......................... 117
    3.2.1.2 Is there anyone who doesn’t need to worry about color management? ......................... 117
  3.2.2 More definitions about Color Management ......................... 117
  3.2.3 The Color Space Connections ................................ 119
    3.2.3.1 Where to find camera profiles ..................... 120
    3.2.3.2 Soft Proofing ...................................... 125
    3.2.3.3 Rendering intention ............................... 125
    3.2.3.4 Links ............................................ 125
  3.2.4 The Working Space ...................................... 125
    3.2.4.1 So I told Showfoto where to find my monitor profile and I have a camera profile that I applied to the image file produced by my raw processing software. What’s the next step in color management? 125
    3.2.4.2 Why cannot I just edit my images in the color space described by the camera profile? ......................... 126
    3.2.4.3 Which working space should I choose? ............. 126
    3.2.4.4 What gamma should my working space have? ....... 126
    3.2.4.5 How many discrete tonal steps are there in a digital image? 127
    3.2.4.6 Should I use a large-gamut or a small-gamut working space? 127
  3.2.5 The sRGB color space .................................... 128
    3.2.5.1 What is so special about the sRGB color space? 128
    3.2.5.2 How small is sRGB? ............................... 129
  3.2.6 Calibrating and Profiling Your Monitor RGB ....................... 130
    3.2.6.1 If I choose to work exclusively in the sRGB color space, do I need to calibrate my monitor? ......................... 130
    3.2.6.2 What are the consequences of working with an uncalibrated monitor? ......................... 130
    3.2.6.3 The meaning of “black point” and “brightness” seems pretty clear, but what does “gamma” mean? 131
3.2.6.4 What’s the difference between calibrating a monitor and profiling a monitor? ................................................................. 131
3.2.6.5 Can I calibrate my monitor without a spectrophotometer? ...... 132
3.2.6.6 Assuming I’ve decided to work exclusively in the sRGB color space, what “Showfoto buttons” should I push after I calibrate my monitor? ................................................................. 132
3.2.6.7 Where are all the icc profiles are located on my computer? .... 133
3.2.6.8 Does the lighting and wall/ceiling/drape/furniture colors near my monitor matter? ................................................................. 133

3.2.7 The Camera Profile and Raw File Development .................................. 133
3.2.7.1 What’s the next step in color management? ................................. 133
3.2.7.2 Why doesn’t the image produced by raw converters like dcraw or ufraw look like the embedded preview displayed by digikam? 133
3.2.7.3 The embedded jpeg preview looks so much nicer than dcraw’s output. What is the value in scene-referred tonality? ................. 134
3.2.7.4 I can see the value in starting my image-editing with a scene-referred rendition instead of the eye-popping rendition that I see in the embedded jpeg. But I’m telling you, the images produced by digiKam/libraw look really really bad! Why? .................... 134
3.2.7.5 Where do I find good information on digital noise? .................... 135
3.2.7.6 Why are the Canon and Nikon colors better than the colors produced by Libraw? ................................................................. 135
3.2.7.7 Why is a camera profile specific to a given make and model of camera? ................................................................. 135
3.2.7.8 What does “analog-to-digital conversion” mean? ......................... 136
3.2.7.9 Why is a camera profile specific to the raw processing program used to develop the raw file? ................................................................. 136
3.2.7.10 Where do I find a generic profile for my camera? .................... 136
3.2.7.11 How do I get a camera profile specific to my camera, lighting conditions, and raw workflow? ................................................................. 137
3.2.7.12 How do I apply a camera profile to the 16-bit image file produced by my open source raw processing software? ................. 137

3.2.8 The Profiles Point to Real Colors in the Real World .......................... 138
3.2.8.1 Camera, scanner, working space, monitor, printer - what do all these color profiles really do? ................................................................. 138
3.2.8.2 How can a color profile point to a real color in the real world? ...... 138

3.2.9 Printer Profiles with Rendering Intents and Soft-Proofing ................. 139
3.2.9.1 Where do I get a printer profile? ................................................................. 139
3.2.9.2 What about rendering intents? ................................................................. 139
3.2.9.3 What rendering intent should I use for displaying images on my monitor? ................................................................. 140
3.2.9.4 What is soft-proofing? ................................................................. 140
3.2.9.5 What rendering intent should I use when I soft-proof? ................. 140
3.2.9.6 And what about black point compensation? ................................................................. 140
3.2.9.7 Can all of the rendering intents be used when converting from one color space to another? .............................................. 140
3.2.9.8 Why does the perceptual rendering intent get recommended so often as the "photographic" rendering intent? ...................... 141

3.3 Showfoto Configuration .................................................. 141
  3.3.1 Introduction ................................................................. 141
  3.3.2 Tooltip Settings .......................................................... 141
  3.3.3 Metadata Settings ....................................................... 142
    3.3.3.1 Introduction ....................................................... 142
    3.3.3.2 Behavior Settings ................................................. 142
      3.3.3.2.1 Rotate Actions .............................................. 142
    3.3.3.3 Metadata Filters ............................................... 142
  3.3.4 Editor Settings .......................................................... 144
    3.3.4.1 Editor Window Settings ....................................... 144
    3.3.4.2 Save Image Options ............................................. 145
    3.3.4.3 Image Versioning Settings .................................... 146
    3.3.4.4 RAW Decoding Settings ....................................... 147
    3.3.4.5 RAW Default Settings ......................................... 148
  3.3.5 Color Management Settings ......................................... 150
  3.3.6 Slide-Show Settings ................................................ 152
  3.3.7 Miscellaneous Settings ............................................. 153
    3.3.7.1 General Settings ............................................... 153
    3.3.7.2 Application Behavior Settings ............................... 154
  3.3.8 The Theme Setup ..................................................... 154

4 Acquire Images Tool .......................................................... 155
  4.1 Scanner Selection ....................................................... 155
  4.2 Main Dialog ............................................................... 156
  4.3 Scanning ................................................................. 156
  4.4 Scanning Multiple Selections ....................................... 156
  4.5 Help and Close .......................................................... 157

5 Geolocation ................................................................. 158
  5.1 Geolocation Editor .......................................................... 159
    5.1.1 The map ............................................................... 160
    5.1.2 Edit Coordinates ................................................... 161
    5.1.3 The Correlator ....................................................... 161
    5.1.4 Undo/Redo ............................................................. 163
    5.1.5 Reverse Geocoding ............................................... 164
    5.1.6 Search ................................................................. 166
List of Figures

6.1 The Presentation Dialog ....................................................... 168
6.2 The Presentation Tool in Action ............................................. 169
Abstract

Showfoto is a stand alone Photo Editor based on digiKam Image Editor. Showfoto is a part of digiKam project.
Chapter 1

Introduction

1.1 Background

1.1.1 About Showfoto
Showfoto is a fast Image Editor with powerful image editing tools. You can use it to view your photographs and improve them.

1.1.2 Reporting Bugs
Showfoto is an Open Source project. This means that it relies on its users to play their part by, at least, reporting problems and suggesting possible improvements.
Showfoto makes it as easy as possible for you to report bugs or suggest improvements. Wherever you are in the application the Help menu will include a Report Bugs option. This will display a message box with a highlighted link. Click on the link and your web browser will open the page for the reporting system. All the information required will already be filled in, just follow the instructions for completing your report.

1.1.3 Support
Showfoto is a community supported project, which means that users and developers support one another. If you become a regular user of Showfoto you are encouraged to join the Showfoto Users Mailing List. You can start off by asking questions to other Showfoto users and hopefully soon you will be answering the support questions of others.
Showfoto Users Mailing List joining instructions.
You can also visit the Showfoto Home Page. for news of new releases and other Showfoto related information.

1.1.4 Getting Involved
There are many ways that you can get involved with the continued development of Showfoto. You do not need to be a software developer. You can help with documentation, translation and user interface design or just contribute really good ideas to the wish-list. You can also get involved by testing early development code as it is being developed and providing feedback to the
developers. Of course, if you are a software developer then you can help to make Showfoto the best digital photograph application there is.

The best way to start getting involved with Showfoto is to join the Developers Mailing List. Showfoto Developer Mailing List joining instructions.

1.2 Supported Image Formats

1.2.1 Introduction

Showfoto relies on a number of libraries and support packages to load and save image formats. Which image formats are available will depend on the availability of these libraries on your system and, in some cases, on the way that those libraries have been compiled. On most distributions you will find that a wide range of image formats are viewable within Showfoto.

This dependence on other libraries means that it is not possible to give a definitive list of all of the formats that will be available on your system. At the very least JPEG, PNG, and TIFF should be available.

Showfoto only displays files that are in formats that it understands. It does this by looking at the file extension on the files and checking this against a predefined list. If the file extension is in the list Showfoto will show the file in the Image View, provided the appropriate library is installed. You can change the list of file extensions that Showfoto will accept, see the Configuration section for more details.

Almost all digital cameras store photographs in one of two formats: JPEG or TIFF. Many cameras enable you to select which of these formats to use. A full description of these formats can be found at the Wikipedia. Showfoto supports both of these formats.

1.2.2 Still Image Compression

Image compression is the application of data compression schemes on digital images. It is done through reducing redundancy of the image data in order to be able to store or transmit data in an efficient form.

Image compression can be lossy or lossless. Lossless compression methods are always preferred for their high preservation value for archival purposes before applying transformations like cropping, resizing, color corrections, etc. This is because lossy compression methods, especially when used at low bit rates, introduce compression artifacts. Lossy methods are suitable for natural images such as photos in applications where minor (sometimes imperceptible) loss of fidelity is acceptable to achieve a substantial reduction in file size. Lossy compression is good for image publishing on the Internet.

1.2.3 JPEG

JPEG is a compressed format, that trades some of the image quality to keep file sizes small. In fact, most cameras save their images in this format unless you specify otherwise. A JPEG image is stored using lossy compression and you can vary the amount of compression. This allows you to choose between lower compression and higher image quality or greater compression and poorer quality. The only reason to choose higher compression is because it creates smaller file so you can store more images, and it’s easier to send them by e-mail or post them on the Web. Most cameras give you two or three choices equivalent to good, better, best although the names vary.

JPEG 2000 is supported as well. It provides for the same compression ratio the better (smoother) results compared to JPEG. The 2000 version has the option of being lossless if so specified in the settings.
1.2.4  TIFF

TIFF has been widely accepted and widely supported as an image format. Commonly, TIFF may be stored by the camera in uncompressed form or using lossless compression algorithm (Deflate). It maintains higher image quality but at the expense of much larger file sizes. Some cameras let you save your images in this format and it is a popular format because of its lossless compression algorithm. The problem is that the format has been altered by so many people that there are now 50 or more flavors and not all are recognizable by programs.

1.2.5  PNG

PNG is an image format that was developed as a replacement for a number of older, in the 1990’s widely used, image file formats. It is a lossless format like TIFF but it is much more compact and saves disk space. Although your camera is unlikely to support PNG, some people like to convert their photographs to PNG as soon as they get them on their computer. Unlike JPEG, PNG images do not lose quality every time you re-encode them after modification. Showfoto fully supports PNG images and the Batch Queue Manager can convert a batch of images from any supported format to PNG (and other formats) in one step.

PNG is an extensible file format for the lossless, portable, well-compressed storage of raster images. PNG provides a patent-free replacement for GIF and can also replace many common uses of TIFF. PNG is designed to work well in on-line viewing applications, such as the World Wide Web, so it is fully streamable with a progressive display option. Also, PNG can store gamma and chromaticity data for improved color matching on heterogeneous platforms. PNG supports 8 and 16 bits / colors / pixels depth. It’s the perfect file format to archive your photographs. For more information about the PNG format see the PNG homepage.

1.2.6  PGF

“Progressive Graphics File” is another not so known but open file image format. Wavelet-based, it allows lossless and lossy data compression. PGF compares well with JPEG 2000 but it was developed for speed (compression/decompression) rather than to be the best at compression ratio. At the same file size a PGF file looks significantly better than a JPEG one, while remaining very good at progressive display too. Thus it should be well-suited to the web but at the moment few browsers can display it. For more information about the PGF format see the libPGF homepage.

1.2.7  RAW

Some, typically more expensive, cameras allow you to store images in RAW format. RAW format is not really an image standard at all. It is different for every make of camera. RAW format images contain all the data that is taken directly from the camera’s image sensor before the software in the camera applies things like white balance, sharpening etc. Storing photographs in a camera’s RAW format allows you to alter settings, such as white balance, after the photograph has been taken. Most professional photographers use RAW format, because it offers them maximum flexibility. The downside is that RAW image files can be very large indeed.

If you want to learn more about RAW image format visit the very helpful guides Wikipedia, The Luminous Landscape, and Cambridge in Colour. You can convert RAW format images into JPEG, PNG, or TIFF in Showfoto using the Image Editor.

Showfoto supports RAW image loading only, relying on the Libraw library which is included in Showfoto core and supports over 800 RAW file formats. All supported cameras are listed at the bottom of Dave Coffin’s web page. The table below shows a short list of camera RAW files supported by Showfoto:
<table>
<thead>
<tr>
<th>RAW File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRW, CR2</td>
<td>Canon digital camera RAW file formats</td>
</tr>
<tr>
<td>NEF</td>
<td>Nikon digital camera RAW file format</td>
</tr>
<tr>
<td>ORF</td>
<td>Olympus digital camera RAW file format</td>
</tr>
<tr>
<td>RAF</td>
<td>Fuji digital camera RAW file format</td>
</tr>
<tr>
<td>RWL</td>
<td>Leica camera RAW file format</td>
</tr>
<tr>
<td>PEF, PTX</td>
<td>Pentax digital camera RAW file format</td>
</tr>
<tr>
<td>X3F</td>
<td>Sigma digital camera RAW file format</td>
</tr>
<tr>
<td>DCR, KDC, DC2, K25</td>
<td>Kodak digital camera RAW file format</td>
</tr>
<tr>
<td>SRF, ARW, MRW, MDC</td>
<td>Sony/Minolta digital camera RAW file format</td>
</tr>
<tr>
<td>RAW</td>
<td>Panasonic, Casio, Leica digital camera RAW file format</td>
</tr>
<tr>
<td>DNG (CSI, HDR)</td>
<td>Adobe RAW file format (Digital Negative)</td>
</tr>
<tr>
<td>BAY</td>
<td>Casio RAW (Bayer)</td>
</tr>
<tr>
<td>ERF</td>
<td>Epson digital camera RAW file format</td>
</tr>
<tr>
<td>FFF</td>
<td>Imacon/Hasselblad RAW format</td>
</tr>
<tr>
<td>MOS</td>
<td>CREO Photo RAW</td>
</tr>
<tr>
<td>PXN</td>
<td>Fotoman RAW</td>
</tr>
<tr>
<td>RDC</td>
<td>Ricoh RAW format</td>
</tr>
</tbody>
</table>
Chapter 2

The Showfoto sidebar

2.1 The Showfoto Right Sidebar

2.1.1 Introduction to the Right Sidebar

The Showfoto main window has a sidebar at the right border providing important information and actions of the selected images. This same sidebar is also available in the Showfoto Image Editor (except the Filters tab). It can be displayed by respectively clicking on one of the eight tabs:

- Properties: File and image properties, key shooting parameters.
- Metadata: EXIF, Makernotes, IPTC and XMP data.
- Colors: Histograms and embedded ICC profiles.
- Maps: Marble widget shows GPS location.
- Captions: Comments, Date & Time setting, Labels, Rating, Tags, selected metadata.
- Versions: Image history.
- Filters: Filters to apply to main window selection.
- Tools: An optional contextual view dedicated to group by categories all main tools available.

Clicking successively onto the same tab will make the sidebar pop up or fold back into the border.

2.1.2 Properties

The properties sidebar shows the essential information about the selected image which are largely self-explanatory. It is grouped into the following sections:

- File Properties: these are file system related information
- Image Properties: shows the image and format properties like dimension, compression, color-depth, etc.
- Photograph Properties: shows a summary of the most important parameters when taking the photograph. These data are taken from the EXIF or XMP data fields if available.
Showfoto Properties: optional view to show a summary of the most important values set in Showfoto database.

2.1.3 Metadata

Metadata are data about the images or files, like technical data of camera setting during shooting, author info, copyrights, keywords, captions, and coordinates of location.

The metadata sidebar is composed of four sub tabs EXIF, Makernote, IPTC and XMP data. On the left, two buttons let you choose between full and simplified data display. In the middle you will find a disk icon to save the metadata to the disk. Next to it are a printer and copy icon - they do just that: print or copy the respective tab metadata to the clipboard.

A really nice feature is the live search box on the lower end of the metadata tabs. As you type in a keyword, the metadata on top of it will be successively filtered until you narrow down and what you are looking for. It is a quick way of accessing specific information.

Metadata, as shown in these four tabs, can be modified and enhanced in a number of ways elsewhere:

- with the camera interface
- the Metadata Editor
- the Geolocation tool
- copying database metadata to files
- copying file’s metadata to the database
2.1.3.1 EXIF Tags

2.1.3.1.1 What is EXIF

EXIF stands for Exchangeable image file format. It was designed specifically for digital cameras. It allows a large amount of information about the photograph to be stored. This information describes the camera which took the image along with the settings (including date and time) in use when the image was taken. An in-line thumbnail can be included.

EXIF format contains a set of marker sections named Image File Directories (IFD). The sections likely to be found in a normal EXIF file are as follows:

- **Image Information**: contains general information about the image.
- **Embedded Thumbnail**: contains information about the embedded thumbnail image.
- **Photograph Information**: contains extended information about the photograph.
- **Interoperability**: contains information to support interoperability between different EXIF implementations.

2.1.3.1.2 How to Use EXIF Viewer

You can review embedded EXIF information for the selected image from the first sidebar tab. The EXIF Viewer is purely informational: nothing you do with it will cause any change to the EXIF sections. If there are more entries than space available, just scroll down with the mouse wheel.

You can use two different levels to display EXIF marker sections:

- **Simple**: display only more important EXIF marker for photograph.
- **Full**: display all EXIF markers.

Some vendors add additional EXIF sections, such as Canon, Fujifilm, Nikon, Minolta, and Sigma. These sections contain vendor and model specific notes. These will be displayed on the **Maker-note** tab.
2.1.3.2 Makernote Tags

2.1.3.2.1 What is Makernote

The EXIF standard defines a Makernote tag, which allows camera manufacturers to place any custom format metadata in the file. This is used increasingly by camera manufacturers to store a myriad of camera settings not listed in the EXIF standard, such as shooting modes, post-processing settings, serial number, focusing modes, etc. but this tag format is proprietary and manufacturer specific.

2.1.3.2.2 How to Use Makernote Viewer

You can review embedded Makernote information for the selected image in this sidebar tab. The Makernote Viewer is purely informational: nothing you do with it will cause any change to the Makernote sections.

2.1.3.3 IPTC Tags

2.1.3.3.1 What is IPTC

The International Press Telecommunications Council, is a consortium of the world’s major news agencies and news industry vendors. It develops and maintains technical standards for improved news exchange that are used by virtually every major news organization in the world.

The IPTC was established in 1965 by a group of news organizations to safeguard the telecommunications interests of the world’s press. Since the late 1970s IPTC’s activities have primarily focused on developing and publishing industry standards for the interchange of news data.

In particular, the IPTC defined a set of metadata attributes that can be applied to images. These were defined originally in 1979, and revised significantly in 1991 to be the “Information Interchange Model” (IIM), but the concept really advanced in 1994 when Adobe defined a specification for actually embedding the metadata into digital image files - known as “IPTC headers”.

2.1.3.3.2 How to Use IPTC Viewer

You can review embedded IPTC information for the selected image in this sidebar tab. The IPTC Viewer is purely informational: nothing you do with it will cause any change to the IPTC sections.

2.1.3.4 XMP Tags

2.1.3.4.1 What is XMP

TODO

2.1.3.4.2 How to Use XMP Viewer

TODO

2.1.4 Colors

The colors sidebar has two sub tabs Color and ICC Profile. Here are more details about Color Management

2.1.4.1 Histogram Viewer

The histogram for an image shows the amount of each color that is present and their different amplitudes within the image. If your photograph has a color cast you might be able to see what is wrong by looking at the histogram.

The Histogram Viewer shows the statistical distribution of color values in the current image. It is purely informational: nothing you do with it will cause any change to the image. If you want to perform a histogram based color correction, use for example Color Balance, Levels Adjust or Curves Adjust in the Image Editor.
An image can be decomposed into Red, Green and Blue color channels. Alpha channel is a Layer in the image that supports transparency (like PNG or GIF images). Each channel supports a range of intensity levels from 0 to 255 (integer valued). Thus, a black pixel is encoded by 0 on all color channels; a white pixel by 255 on all color channels. A transparent pixel is encoded by 0 on the alpha channel; an opaque pixel by 255.

The Histogram Viewer allows you to view each channel separately:

- **Luminosity**: shows the distribution of brightness values.
- **Red, Green, Blue**: show the distribution of intensity levels for the Red, Green, or Blue channels respectively.
- **Alpha**: shows the distribution of opacity levels. If the layer is completely opaque or completely transparent, the histogram will consist of a single bar on the left or right edge.
- **Colors**: shows the Red, Green, and Blue histograms superposed, so that you can see all of the color distribution information in a single view.

With the Scale option you can determine whether the histogram will be displayed using a linear or logarithmic Y axis. For images taken with a digital camera, the Linear mode is usually the most useful. However, for images that contain substantial areas of constant color a Linear histogram will often be dominated by a single bar. In this case a Logarithmic histogram will be more useful.

You can restrict the analysis of the Statistics field shown at the bottom of the dialog to a limited range of values if you wish. You can set the range in one of two ways:

- Click and drag the pointer across the histogram display area, from the lowest level to the highest level of the range you want.
- Use the spin button entries below the histogram area. Left entry is bottom of range and right entry is top of range.

The statistics shown at the bottom of the Histogram Viewer describe the distribution of channel values, restricted to the selected range. These are:
The number of pixels in the image.
• The number whose values fall within the selected range.
• The mean.
• The standard deviation.
• The median of the selected histogram portion.
• The percentage whose values fall within the selected range.
• The color depth of the image.
• Alpha channel in the image.
• The source of the histogram, either Full Image or Image Region if you have selected an area of the image in the Editor.

2.1.4.2 How To Use an Histogram

Histograms are a graphical means to assess the accuracy of an image shown on the screen. The graph represents the 3 regions of the photograph brightness:

• (1) : the shadows-tone on the left.
• (2) : the middle-tone in the middle.
• (3) : the highlights-tone on the right.

Example 2.1 An Image Histogram in All Colors Mode

The distribution of the graph, where the spikes and bulges are clustered, indicates whether the image is too dark, too bright, or well-balanced.

With an under exposed photograph, the histogram will have a distribution of brightness that tends to be mostly on the left of the graph.
Example 2.2 An Under Exposed Photograph

With an over exposed photograph, the histogram will have the bulge showing the brightness distributed mostly towards the right of the graph.

Example 2.3 An Over Exposed Photograph

With a correctly exposed photograph, the histogram will have a distribution of brightness that will be most prominent near the center part of the graph.
Example 2.4 A Correctly Exposed Photograph

Important: not all photographs have to exhibit this bulge in the center part of their histogram. Much depends on the subject of the photograph. In some cases, it might be appropriate for the histogram to show a peak at one end or the other, or both.

The histogram is a reliable way of deciding whether or not a photograph is correctly exposed. Should the histogram show an over or under exposure, an Exposure Correction Tool should be used to fix the photograph.

2.1.5 Maps

There are four tools regarding geolocation in digiKam and two in Showfoto:

1. The Map mode of the Image Area which displays images with GPS data on a map depending on the selection on the Left Sidebar, e.g. the images in the album you selected in the Album View, the images with a certain tag assigned (selected in the Tag View), with a certain label and so on. This is only available in digiKam.

2. The Map View on the Left Sidebar of digiKam which is the search tool for finding images by their GPS data. This is also only available in digiKam.

3. The Geolocation Editor which is accessible via Item → Edit Geolocation... (Ctrl+Shift+G) (File → Edit Geolocation... in Showfoto) and allows to set and to edit GPS data.

4. The Map tab on the Right Sidebar we are talking about here which shows the location of the image on a map and is purely informative.

All four are based on the Marble widget.

This tab shows a map of orientation where you will find a marker or a thumbnail to indicate the GPS location of the selected image. The GPS coordinates and the time information are displayed below the widget. You can zoom in and out with the mouse wheel by either scrolling it or hold and drag it. Pan by holding down the left mouse button.
The Showfoto Handbook

For navigating on the map refer to Marble handbook, Chapter 2. The meaning of ‘GPS’ and
functions and buttons that apply to all three geolocation parts are described in the Geolocation
Editor chapter of this handbook. This applies to the context menu on the map and the line of
buttons under the map except the last one.

For information about the different map services you can use the drop-down field under the line
of buttons. Choose a service here and then click the See-more-information-on-the-Internet button
to the right.

The displayed positioning data are actually stored in the image’s EXIF tags. That allows the
location to be read by any other application that can understand EXIF GPS data.

2.1.6 Captions

2.1.6.1 Introduction

This sidebar tab serves to apply and edit image attributes like captions, rating, date and tags.
The attributes are stored in the associated database, in the IPTC and EXIF data fields and become
part of the image. All attributes are accessible in one sidebar view as shown in the screenshot
below. During image reading the order of priority is a) database b) IPTC and c) EXIF. So if there
is a discrepancy between any of the three, this priority will take effect and a synchronization will
take place. This sidebar has a first-previous-next-last arrow navigator field on top if shown in the
main application.
2.1.6.2 Comment View

The caption view can be used to type or paste in a caption of unlimited size (see note below). The text is UTF-8 compatible, meaning that all special characters are allowed. The captions are copied to EXIF and IPTC fields to be used by other applications.

**CAUTION**

IPTC data only supports ASCII characters and is limited to 2000 characters (old American norm). All texts will be truncated after 2000 chars, and special characters will be malformed. If you intend to use the IPTC caption field in other applications you should be compliant with these restrictions.

After commenting, either choose the Apply button or go straight to the next image, the captions will be saved.

Next to the Apply button there is the More button. From it you can either choose to read metadata from the selected file to the database, or the other way around, to write metadata to the files (the latter take place anyway if you chose a metadata setting so that all metadata is always saved to the images).

2.1.6.3 Date & Time

In the Date & Time section, which reflects the time of taking the photograph, you can change all values. From the date combo-box a calendar opens, and the time setting spin-box can also be written by directly typing the time. The dating is copied to the EXIF 'Date and Time' field. If you need to change a number of images for their creating time & date, there is a more comfortable method available in Batch Queue Manager. This latter option can be found under Image → Adjust time & date... Select the images to be changed in the main view and call the tool.
2.1.6.4 Rating

The Rating section displays a 0...5 star rating scheme that can be used in searches and sort orders. It can be applied by a single mouse click to the 5 stars in the sidebar or with a keyboard short-cut Ctrl-0...5. The rating from the sidebar is always applied to one image at a time. To rate a number of images, select them and pop-up the context menu (click with the right mouse button) to apply a common rating.

The rating is then transcribed into the IPTC ‘urgency’ data field. The transcoding follows the scheme in this table:

<table>
<thead>
<tr>
<th>Showfoto Rating</th>
<th>IPTC Urgency</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>8</td>
</tr>
<tr>
<td>*</td>
<td>7</td>
</tr>
<tr>
<td>**</td>
<td>6</td>
</tr>
<tr>
<td>***</td>
<td>5</td>
</tr>
<tr>
<td>****</td>
<td>4</td>
</tr>
<tr>
<td>*****</td>
<td>3</td>
</tr>
<tr>
<td>*****</td>
<td>2</td>
</tr>
<tr>
<td>*****</td>
<td>1</td>
</tr>
</tbody>
</table>

2.1.6.5 Tag Tree

The tag view shows an adaptive filter tag search box, the tag tree and a combo-box containing the tags previously applied in this Showfoto session.

The tag tree will be adapted dynamically as a function of the search word as you type into the box. So it is easy to quickly reduce the number of possibilities when searching for a tag. Of course, this feature is only useful if you have many tags.

The combo-box at the bottom is another ergonomic feature for easy tagging of an image series. As you apply different tags they will be memorized in this box for quick access.

Otherwise tags are simply applied by checking the respective boxes in the tree. All tags of an image are transcribed into the IPTC ‘keyword’ data field.

**NOTE**

In case you have selected a number of images in the main view and you check a tag in the tag tree, this one is only applied to the highlighted image, and not to the whole selection. If you want to tag selections, refer to the Filters section.

2.1.6.6 Information View

TODO

2.1.7 Versions view

The Versions tab shows the history and the saved versions of a photograph. With the three buttons in the top right corner you can choose between a simple list of the saved versions, a tree view and a combined list that shows the versions together with the actions performed with the selected photograph.
The tree view shows the parent and child versions of the selected image. Here the second and the fifth version derive directly from the original image, the third and forth version are children of the second version.

The combined list shows the versions together with the actions/filters applied to them. Here the second version was created by resizing the original, applying the unsharp mask, correcting the white balance and finally adding a frame with the border tool. The child versions are grouped in Derived Versions and Related Versions. Related Versions arise if you modify the original and save the changes with **Save As New Version**.

To learn how to control what is stored as a separate version and which versions are displayed in the Image Area see **Image Versioning Settings**.
2.1.8 Filters

The Filters tab is used to limit the set of images displayed in the Image Area. Normally one uses the Left Sidebar with its different views to confine the images displayed for example to the content of an album or to images with a certain label assigned to them. The Filters tab on the Right Sidebar offers a number of filters and if one of these are filled in, selected or checked only the cross-section of these two selections will be displayed in the Image Area.

To give an example, suppose you have a tag called ‘public’ which tags all images except your private ones. Then you can check this ‘public’ tag in the Right Sidebar to hide the private images (all those not having ‘public’ tag). Whatever view mode you chose from the Left Sidebar, only ‘public’ images will be displayed. Another typical example is the selection of a subset of tags in a hierarchical tree. Suppose you want to display ‘red’ and ‘green’ from a tag tree containing 7 different colors as sub-tags. Simply click on the ‘color’ tag of the main view and check ‘red’ and ‘green’ from the Right Sidebar.

You can also use a combination of the filters but here we have to look a little bit closer: The main filters and also the different types of labels in the Labels Filter (color, pick, rating) are connected with boolean AND which means that all selected filters have to fit for the images to be displayed. If you select ‘JPG’ in the MIME type filter and ‘red’ in the labels filter only those photographs from the selection on the Left Sidebar will be displayed that have JPG format AND are labeled ‘red’.

On the other hand the tags in the tag filter and the individual labels within one type of labels are connected with boolean OR as you might have noticed already in the public/private example above. That means if you check more than one tag in the Tags Filter all images with at least one of these tags applied will show up (as long as they are not ruled out by one of the other filters).

Another use of this tab of the Right Sidebar is drag-and-drop tagging. Lets say you chose with the help of the Left Sidebar a number of images to tag them and they are now displayed in the Image Area. If the tag already exists, simply drag it from the Right Sidebar onto one of the icons. A dialog will pop-up and ask if this tag should be applied to this item only, to all items or, if there is more than one icon selected (highlighted), to the selected items.

In the above example the main window shows the images from a calendar date, the tag filter is set to ‘Oldtimer’, which reduces the set to 3 images. In the Text Filter I typed ‘Funeral’ which leaves only one picture of the only funeral car oldtimer in my collections. Then a tag is dragged
from the Tag Filter over the icon and dropped. A pop-up dialog asks if the tag shall be applied to
this item only or to all (displayed) items.

Note that the Text Filter has a little drop-down menu to select which image information should
be included in the search and the rating group in the Labels Filter has one to choose whether you
want a certain rating or a range.

2.1.9 Tools view

The tools view from right sidebar hosts the list of actions available to process actions on selection.
The list is an icon-view sorted by categories of tools. This view give a quick preview of all actions
from main menu. For example, with the Image Editor, you can adjust the size of the current
image with the relevant crop tool.

2.1.9.1 Sidebar Tools of the Image Editor
Chapter 3

Using Showfoto

3.1 Photographic Editing - Workflow

3.1.1 Image Editing/Workflow Tools

3.1.1.1 A Standard Workflow Proposal

When performing a basic workflow, the primary areas for consideration are:

1. Exposure: White Balance
2. Color: White Balance
3. Black and white points: White Balance or Adjust Levels
4. Contrast: Adjust Curves
5. Saturation: White Balance or Vivid or Hue/Saturation/Lightness
6. Resizing (interpolation): Change Size
7. Sharpening
8. Digital Asset Management (applying tags, captions, rating, geolocation, save under new name)

We recommend this sequence of image editing steps to ensure optimum photographic quality for the end product. In particular, never do sharpening before the last step. And we recommend using a lossless format like PNG or TIFF for storing photographs. Otherwise you’ll lose a bit every time you save the results. If you can afford it, use 16 bit/channel for your best shots. If you want to change color space, in particular if you want to work in CIEL*a*b, 16 bit per channel are required to avoid truncation effects.

If you swap step 4 and 5, which is well possible if the initial contrast is already very good, you can do the first 4 adjustment in the same tool, the white balance

Many of the tools you may need for photographic editing are included with Showfoto. Their description follows here.
3.1.1.2 Introduction to common editing tools features

All Image Editor tools like Sharpen, Blur, Noise Reduction, Refocus, Unsharp Mask, etc. use a common dialog style that previews the effect before applying the filter to the current image. Below you see the ‘Apply Texture’ tool in action using this common dialog layout:

Example 3.1 The Apply Texture Tool in Action

- **(1)**: The seven buttons to the top left select the comparison style of the preview area. The modes are:
  - Original image.
  - Split vertically without duplication. The left area shows the original whereas the right side shows the filter applied to the continuation of the selected zoom.
  - Split horizontally without duplication. The top area shows the original whereas the lower area shows the filter applied to the continuation of the selected zoom.
  - Split vertically. The left area shows the original and the right one the filter effect for comparison.
  - Split horizontally. The top area shows the original and the lower one the filter effect for comparison.
  - Effect preview. This is a live effect preview without comparison.
  - ‘Mouse over’ style: preview when mouse is off the preview (in the settings area), otherwise shows original.

- **(2)**: There are two buttons that can be toggled to show over or underexposure. The colors can be customized in the general setup page.

- **(3)**: The preview selector frame. Click and drag with the mouse on the floating frame to move it on the image. The preview area on the left of dialog is updated accordingly.

- **(4)**: The filter or tool settings area.

- **(5)**: At the lower left corner: there is help and a reset to defaults button (all settings are remembered from the last use of the tool).

- **(6)**: There is a progress indicator for tool with involved calculations.
3.1.1.3 The Showfoto tool set

• Image Color
  – Encoding Depth
  – Color-Space Converter
  – Auto Correction
  – Brightness/Contrast/Gamma
  – Hue/Saturation/Lightness
  – Color Balance
  – Levels Adjust
  – White Balance/Exposure/Saturation
  – Curves Adjust
  – Channel Mixer
  – Black and White
  – Simulate Infrared Film
  – Color Negative

• Image Enhancement
  – Sharpening (sharpen, unsharp mask, refocus)
  – Blur Tool
  – Red Eyes Removal
  – Photograph Inpainting
  – Local Contrast
  – Noise Reduction
  – Hot Pixel Correction
  – Lens Distortion Correction
  – Photograph Restoration
  – Vignetting Correction Tool
  – Lens Auto-Correction Tool

• Image Transformation Tools
  – Crop Tool
  – Change Size
  – Liquid Resizement
  – Change Size
  – Free Rotation
  – Perspective Adjustment
  – Shearing Tool

• Image Decoration
  – Add Border
  – Insert Text
  – Apply Texture

• Special Effect Filters
  – Color Effects
  – Add Film Grain
  – Simulate Oil Painting
  – Simulate Charcoal Drawing
  – Emboss Photograph
  – Distortion FX
  – Blur FX
  – Add Rain Drops
3.1.2 Processing RAW image files, RAW work-flow

A typical RAW workflow with Showfoto may follow these steps:

- Setting up the RAW conversion and color management preferences:
  - get the ICC color profiles for the camera, display and printer
  - setup Showfoto correctly defining a color work space
- Camera whitepoint setting
- Demosaicing (includes interpolation, noise filtering and chromatic aberration correction)
- Conversion to a color space
- Gamma correction, tone mapping
- Color profile assignment
- Dynamic range expansion (optional)
- Continue with standard workflow

From there everything is simple, select a RAW image and open it in the editor. The color man-
agement widget will be displayed after the image has been processed in order to adjust color
rendering. Without color management all images are very dark, this is normal. You can exper-
iment the various profiles you have in order to select the best input profile according to your
image (some tends to be very neutral, even a bit dull, some gives more saturated results, etc.).

3.1.3 Color editing tools

3.1.3.1 Encoding Depth

Here you can change the encoding depth per color channel of the edited image. 8 bit encoding is
the common JPEG format, 16 bit encoding is better suited for high quality images, but this format
needs more storage space, calculation time and is currently available with PNG, PGF, TIFF, and
JPEG-2000 formats only.

3.1.3.2 Color Management

This tool permit to convert image from one color space to another one. Its use is the change and
assignment of color profiles to an image. For detailed instructions on the use of color profiles,
please refer to Color Management Settings chapter.

3.1.3.3 Introduction

The Auto Levels, Normalize, Equalize, Stretch Contrast, and Auto Exposure available from
Correct → Auto-Correction... menu entry menu will attempt to work out the best color levels
automatically. You will need to experiment with the effects of these functions to see what works
best with your photograph.

- Auto Levels: TODO.
• **Normalize**: this method scales brightness values across the selected image so that the darkest point becomes black, and the brightest point becomes as bright as possible without altering its hue. This is often a ‘magic fix’ for images that are dim or washed out.

**Example 3.2 Normalize Colors Correction Preview**

• **Equalize**: this method adjusts the brightness of colors across the selected image so that the histogram for the Value channel is as flat as possible, that is, so that each possible brightness value appears at about the same number of pixels as each other value. Sometimes Equalize works wonderfully at enhancing the contrasts of an image. Other times it gives garbage. It is a very powerful operation, which can either work miracles on an image or destroy it.
Example 3.3 Equalize Colors Correction Preview

• **Auto-levels**: this method maximizes the tonal range in the Red, Green, and Blue channels. It determines the image shadow and highlight limit values and adjust the Red, Green, and Blue channels to a full histogram range.

Example 3.4 Auto Levels Correction Preview

• **Stretch Contrast**: this method enhances the contrast and brightness of the RGB values of an image by stretching the lowest and highest values to their fullest range, adjusting everything
in between. This is noticeable only with washed-out images and can be a good fix-it tool for bad photographs.

Example 3.5 Stretch Contrast Correction

3.1.3.4 Black and White Conversion Filters

Black & White photography has always been fascinating in its abstraction capability. With the advent of digital photography, B&W has almost become a desktop activity, as color images can be easily converted on the computer into black and white, even providing a set of vintage film roll profiles. This filter is also able to simulate traditional infrared film material.

3.1.3.4.1 The Legacy Black and White Films Emulation

Showfoto comes with a couple of black & white filters that you can use on your photographs. Under the Color → Black & White... menu you will find classic black & white chemical toning used in analog photography. The controls come on four drop-down items: Film, Lens Filters, Tone and Lightness as shown on the screenshot below. Film, filters and color toning can be applied independently of each other (on top of each other). The filters actually influence the RGB channel mixing, whereas the toning purely adds a uniform monochromatic tint to the black & white photograph. In the lightness tab you will find a tonal adjustment tool (like curve adjust), a contrast tool and an over-exposure indicator to improve the b&w rendering.
Example 3.6 The Black & White Filter tool in Action

The table below shows in more detail the effect of all filters and tints.

<table>
<thead>
<tr>
<th>Preview</th>
<th>Photographic Film Emulation</th>
</tr>
</thead>
</table>
| ![Image](image1.jpg) | Specific settings to emulate a number of famous black & white photographic films are available:  
  Generic  
  Agfa 200X, Agfa Pan 25, Agfa Pan 100, Agfa Pan 400  
  Ilford Delta 100, Ilford Delta 400, Ilford Delta 400 Pro 3200, Ilford FP4 Plus, Ilford HP5 Plus, Ilford PanF Plus, Ilford XP2 Super, Ilford SPX 200 (Infrared), Ilford SPX 400 (Infrared), Ilford SPX 800 (Infrared)  
  Kodak Tmax 100, Kodak Tmax 400, Kodak TriX, Kodak HIE (Infrared) |

<table>
<thead>
<tr>
<th>Preview</th>
<th>Lens Filter Type</th>
</tr>
</thead>
</table>
| ![Image](image2.jpg) | Lens Filter Type  
  39 |
<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original color image</td>
<td>Color image taken in New Zealand landscapes.</td>
</tr>
<tr>
<td>No Lens Filter</td>
<td>Simulate black &amp; white neutral film exposure.</td>
</tr>
<tr>
<td>Green Filter</td>
<td>Simulates black &amp; white film exposure with a green lens filter. This comes good with all scenic images, especially suited for portraits taken against the sky (similar to 004 Cokin™ Green filter).</td>
</tr>
<tr>
<td>Orange Filter</td>
<td>Simulates black &amp; white film exposure with an orange lens filter. This will enhance landscapes, marine scenes and aerial photography (similar to 002 Cokin™ Orange filter).</td>
</tr>
</tbody>
</table>

---

The Showfoto Handbook
Red Filter: simulates black & white film exposure with red lens filter. Creates dramatic sky effects and can simulate moonlight scenes in daytime (similar to 003 Cokin(tm) Red filter).

Yellow Filter: simulates black & white film exposure with yellow lens filter. Most natural tonal correction, improves contrast. Ideal for landscapes (similar to 001 Cokin(tm) Yellow filter).

Sepia Filter: gives a warm highlight and mid-tone while adding a bit of coolness to the shadows - very similar to the process of bleaching a print and re-developing in a sepia toner (typical for your grandmothers photographs). Similar to 005 Cokin(tm) Sepia filter.

Brown Filter: similar to Sepia Tone filter, but less pronounced.
### Simulate Infrared Film

Simulating classical infrared film material (the effect is rendered in black and white) is an interesting alienation effect that is even stronger and more dramatic than pure black and white conversion. Contrast and an abstract touch are improved, which can underpin the expression of the photographer as an artist. It is like taking an image in black and white with a red filter on the camera lense. Areas which reflect little red light, e.g. the sky, will show as low density, dark areas. Areas which are excellent reflectors of red light, e.g. most green foliage, will be high density areas. And snow landscapes are really dramatic.

The algorithm is based on the method of the ‘Simulate Infrared Film’ tutorial of the GimpGuru.org web site available at [this url](#). The filter tries to reproduce the famous Ilford(tm) SFX infrared film series. This film has a sensitivity range of 200-800 ISO.

The left part of the dialog window lets you select the region to be shown in the preview section. Move the red rectangle with the mouse around to show the effect on different parts of the image.
The lower part provides the two controls, Film Grain and ISO sensitivity. Check the Add Film Grain box if you want to simulate the grainy texture of a high sensitivity film. The ISO-level slider modifies the amount of film grain added and the predominance of green color (chlorophyll in nature) in the conversion mixer. Green pastures will become white as snow! Try it out.

**NOTE**

Because the filter mixes color channels to reproduce infrared film (with emphasis on green channel), one cannot simulate infrared effect from black and white original photograph, since the color information is missing.

This is an example of the infrared film effect applied to a color image taken in New Zealand’s landscapes. The original image is (1) and the converted image is (2). The film sensitivity used to simulate the infrared film is ISO-400. Higher ISO values will create a kind of aura in the highlights.

3.1.3.5 Correcting Colors

Digital cameras often have problems with lighting conditions and it is not unusual to want to correct the color contrast and brightness of a photograph. You can experiment with altering the levels of different aspects of your photographs using the tools under the Color menu. You can see any adjustments you make reflected in the preview. When you are happy with the results, press Ok and they will take effect.
If your image is washed out (which can easily happen when you take images in bright light) try the Hue/Saturation/Lightness tool, which gives you four sliders to manipulate, for Hue, Saturation, Vibrance, and Lightness. Raising the saturation will probably make the image look better. In some cases, it is useful to adjust the lightness at the same time. ("Lightness" here is similar to "Brightness" in the Brightness/Contrast/Gamma tool, except that they are formed from different combinations of the red, green, and blue channels).

When you take images in low light conditions, you could get the opposite problem: too much saturation. In this case the Hue/Saturation tool is again a good one to use, only by reducing the saturation instead of increasing it. You can see any adjustments you make reflected in the preview image. When you are happy with the results, press Ok and they will take effect.
3.1.3.6 Introduction

The Adjust Curves tool is the most sophisticated tool available to adjust the images’ tonality. Start it from the Color → Curves Adjust... Image Editor menu. It allows you to click and drag control points on a curve to create a free function mapping input brightness levels to output brightness levels. The Adjust Curves tool can replicate any effect you can achieve with Brightness/Contrast/Gamma or the Adjust Levels tool, though it is more powerful than either one of them. But this tool can do more for you, it helps you to improve the tonal quality of your photographs to very finely stepped gray scales. And do not forget that the better the photographs are (good exposure, lossless format, 24 or 32 bit deep) the more you can improve them. Navigate to the “Achieving ultimate tonal quality” section of this instructive page: Tonal quality and dynamic range in digital cameras by Norman Koren. Use Adjust Curves tool to do just the same!

This tool provides visual curves to modify the intensity values of the active layer displayed as a histogram non-linearly. In Curve smooth mode, you change the curves shape by adding new points to the curve or by moving end point positions. Another way, is to draw all the curve manually in Curve free mode. In both cases the effect is immediately displayed in the image preview area to the left, where the preview can be configured by clicking on the top left icons.
3.1.3.6.1 Using Adjust Curves

To the left, half of the original and the target preview image is shown. The target preview is updated dynamically according to the widget settings. On the right side the following options are available:

- **Modify Channel**: with this combo box you can select the specific channel to be modified by the tool:
  - **Luminosity**: changes the intensity of all pixels.
  - **Red**: changes the Red saturation of all pixels.
  - **Green**: changes the Green saturation of all pixels.
  - **Blue**: changes the Blue saturation of all pixels.
  - **Alpha**: changes the transparency of all pixels.

- Next to this box are two icons to select linear or logarithmic histogram display. For images taken with a digital camera the linear mode is usually the most useful. However, for images containing substantial areas of constant color, a linear histogram will often be dominated by a single bar. In this case a logarithmic histogram will be more appropriate.

- **Main Curves Editing Area**: the horizontal bar (x-axis) represents input values (they are value levels from 0 to 255). The vertical bar (y-axis) is only a scale for output colors of the selected channel. The control curve is drawn on a grid and crosses the histogram diagonally. The pointer x/y position is permanently displayed above the grid. If you click on the curve, a control point is created. You can move it to bend the curve. If you click outside the curve, a control point is also created, and the curve includes it automatically. So each point of the curve represents an ‘x’ translated into a ‘y’ output level.

- **Curve Type for channel**: below the editing area are several icons that determine whether the curve can be edited using a Curve smooth mode curve or a Curve free mode. Smooth mode constrains the curve type to a smooth line with tension and provides a realistic rendering. Free mode lets you draw your curve free-hand with the mouse. With curve segments scattered all over the grid, result will be surprising but hardly repeatable. A reset-to-defaults button is also available.
• If, for example, you move a curve segment to the right, i.e. to highlights, you can see that these highlights are corresponding to darker output tones and that image pixels corresponding to this curve segment will go darker.

• With color channels, moving right will decrease saturation up to reaching complementary color. To delete all control points (apart from both end points), click on the Reset button. To delete only one point, move it onto another point. Just ply with the curves and watch the results. You even can solarize the image on part of its tonal range. This happens when the curve is inverted in some part.

• The original photo preview has a red marker on it. If you place this marker to a zone you want to modify, a corresponding line will be drawn on the curve grid indicating the original value. Create a point on that line and move it up or down to adjust it to your pleasing.

• Save As... and Load...: these buttons are used to do just that. Any curves that you have set can be saved to the filesystem and loaded later. The used file format is The Gimp Curves format.

• Reset: this button resets all curve values for all channels.

The curves tool has several features that facilitate the positioning of points on the control curves. Clicking the mouse button in the original image preview area produces a vertical dotted bar in the graph area of the curves tool. The bar position corresponds to the pixel value the mouse cursor is over in the image window. Clicking and dragging the mouse button interactively updates the position of the vertical bar. In this way, it is possible to see where different pixel values in the image are located on the control curve and helps to discover the locations of shadow, midtone, and highlight pixels.

Using this way and the three Tone Color Picker buttons will automatically create control points on the curve in all channels for shadow, middle, and highlight tones. Enable the color picker button that you want to use, and click on the original image preview area to produce control points on each of the Red, Green, Blue, and Luminosity control curves.

3.1.3.6.2 The Adjust Curves in action

Below you can see a black and white photograph corrected in Luminosity channel. Shadow and highlight tone picker tool have been use to determined the curves to apply from original. The original image is (1), the corrected image (2).
3.1.3.7 Introduction

Situated between the more sophisticated Adjust Curves tool and the simpler Brightness/Contrast/Gamma Image Editor tool is this Adjust Levels tool for improving exposure. Although the dialog for this tool looks very complicated, for the basic usage we have in mind here, the only part you need to deal with is the **Input Levels** area, concretely the 3 sliders that appear below the histogram.

This widget contains a visual graph of the intensity values of the active layer or selection (histogram). Below the graph are five sliders that can be clicked into and dragged to constrain and change the intensity level for the image. The left sliders position represents the dark areas and similarly, the right position represents the light areas.
3.1.3.7.1 Using the Adjust Levels tool

Actually the easiest way to learn how to use it is to experiment by moving the three sliders around, and watching how the image is affected.

On the right, both an original and a target preview image is available. The target preview is updated dynamically according to the slider positions. On the left, the following options are available:

- **Modify levels for Channel**: this combo box allows the selection of the specific channel that will be modified by the tool:
  - **Luminosity**: this option makes intensity changes against all pixels in the image.
  - **Red**: this option makes Red saturation changes against all pixels in the image.
  - **Green**: this option makes Green saturation changes against all pixels in the image.
  - **Blue**: this option makes Blue saturation changes against all pixels in the image.
  - **Alpha**: this option makes transparency changes against all pixels in the image.

- **Set Scale for channel**: this combo controls whether the histogram will be displayed using a linear or logarithmic amplitude. For images taken with a digital camera, the linear mode is usually the most useful. However, for images that contain substantial areas of constant color a linear histogram will often be dominated by a single bar. In this case a logarithmic histogram will often be more useful.

- **Input Levels**: the input levels allow manual adjustments to be selected for each of the ranges. The main area is a graphic representation of image dark, mid and light tones content. They are on abscissa from level 0 (black) to level 255 (white). Pixel number for a level is on ordinate axis. The curve surface represents all the pixels of the image for the selected channel (histogram). A well balanced image is an image with levels (tones) distributed all over the whole range. An image with a predominant blue color, for example, will produce a histogram shifted to the left in Green and Red channels, manifested by green and red color lacking on highlights. The level ranges can be modified in three ways:
  - Three sliders: the first on the top for dark tones, the second one for light tones, and the last one on the bottom for midtones (often called Gamma value).
– Three input boxes to enter values directly.
– Three Color Picker buttons using the original photo preview to automatically adjust inputs levels settings for shadow, midtone and highlights. There is also a fully automated adjustment button available next to the reset button.

• **Output Levels**: the output levels allow manual selection of a narrowed-down output level range. There are also two sliders located here that can be used to interactively change the output levels like **Input Levels**. This output level compression may, for example, be used to create a bleached image as a background for some other subject to put into the foreground.

• **Auto**: this button performs an automatic setting of the levels based on the pixel intensities of the image.

• **Save As**... and **Load**...: these buttons are used to do just that. Any Levels that you have set can be saved to the filesystem and loaded later. The used file format is The Gimp Levels format.

• **Reset All**: this button reset all **Input Levels** and **Output Levels** values for all channels.

The Adjust Levels tool has several features to facilitate the positioning input levels sliders. Clicking the mouse button in the original image preview area produces a vertical dotted bar in the graph area of the histogram. The bar position corresponds to the pixel value under the mouse cursor in the image window. Clicking and dragging the mouse button interactively updates the position of the vertical bar. In this way it is possible to see where different pixel values in the image are located on the input levels sliders and helps to discover the locations of shadow, midtone, and highlight pixels.

Using in this mode and the three **Color Picker** buttons will automatically adjust input levels settings in all channels for shadow, middle, and highlight tones. Enable the color picker button that you want use, and click on the original image preview area to set input levels on each of the Red, Green, Blue, and Luminosity histogram channels.

**Over Exposure Indicator** option checks all color channel to see if more than one channel in a pixel is over-exposed, and you will see the combined color resulting of channel level settings. This feature is available as an indicator in the target preview area and has no effect on final rendering.

### 3.1.3.7.2 The Adjust Levels tool in action

Below, you can see an **Input levels** adjustment example applied to a color image for the Red/Green/Blue channels. Intensity/Alpha channels and **Output Levels** are unchanged. The original image is (1), the corrected image (2).
3.1.3.8 Correcting Exposure

The simplest tool to use is the Brightness/Contrast/Gamma tool. It is also the least powerful, but in many cases it does everything you need. This tool is often useful for images that are overexposed or underexposed; it is not useful for correcting color casts. The tool gives you three sliders to adjust, for “Brightness”, “Contrast” and “Gamma”. You can see any adjustments you make reflected in the preview image. When you are happy with the results, press Ok and they will take effect.

Example 3.9 The Brightness Contrast Gamma Tool in Action
The Showfoto Handbook

Another important tool is called **Color → Levels Adjust**. This tool provides an integrated way of seeing the results of adjusting multiple levels and also enables you to save level settings for application to multiple photographs. This can be useful if your camera or scanner often makes the same mistakes and you want to apply the same corrections. See the dedicated Adjust Levels manual for more information.

A very powerful way of correcting exposure problems is to use the Adjust Curves tool available by **Color → Curves Adjust** menu entry.

### 3.1.3.9 Introduction

The Channel Mixer is another sophisticated tool to refine the images’ tonality. Start it from the **Color → Channel Mixer** Image Editor menu.

#### 3.1.3.9.1 Using the Channel Mixer

With the channel combo box you select and display the histogram per color. It gives a first hint of how to correct the channels by their relative distribution and amplitude. The left half of the dialog window always shows a preview of what you are doing. The original for comparison can be seen when selecting its own window tab.

The target photo preview has a red marker available. If you place this marker somewhere in the image, a corresponding vertical bar will be drawn in the histogram indicating the color level value in the current channel selected.

Now the controls are to the lower right: **Red**, **Green** and **Blue** slider controls enable you to mix the channels. If you check **Preserve Luminosity** the image will retain its overall luminosity despite you changing its color components. This feature is particularly useful when you also ticked the **Monochrome** box. Because the channel mixer is THE tool to make great black and white conversions of your photographs. Try to reduce the green channel for black and white portraits.
Sometimes, especially when doing monochrome mixing, reducing one color channel may increase visible noise, which actually originates in the chroma noise. Chroma noise means that the little noise specs do not appear at the same location in all the color channels, but the noise patterns looks different in every channel. If that is the case you can improve the monochrome conversion by reducing the chroma noise first.

**Save As...** and **Load...** buttons are used to do just that. Any mixer settings that you have set can be saved to the filesystem and loaded later. The used file format is The Gimp channel mixer format.

**Over Exposure Indicator** option adds up the colors if more than one channel in a pixel is overexposed, and you will see the combined color resulting of channel gain settings. This rule is applying to target preview area and haven’t effect to final rendering.

**Reset All** button resets all channel mixer settings to default values.

### 3.1.3.9.2 The channel mixer in action

Below, you can see a photograph color tone adjustments for the **Blue** channel. **Preserve luminosity** option is on. The original image is (1), the corrected image (2).

### 3.1.3.10 Introduction

White Balance setting is a common hurdle for digital still cameras. In the ‘good old time’ of film rolls, the white balance was done by the photolab. Nowadays the poor little camera has to guess what is white and what is black. Most of the time, what the camera chooses as the white point, is not of the correct shade or hue. Using this tool it is easy to correct this problem. It provides a variety of parameters that can be trimmed to obtain a better result.
The whitebalance correction is somewhat limited by the fact that we operate in 8bit per channel color space. So if you depart too much from the original, over exposure zones may appear. If you can adjust the whitebalance in raw conversion mode (which is done in 16 bit space), the margin for correction will be greater.

This tool is based on a white color balance algorithm copyrighted by Pawel T. Jochym. Launch it from the **Color → White Balance** Image Editor menu.

3.1.3.10.1 Using the Whitebalance Tool

The preview window can be resized. To the left, both an original and a target preview tab is shown. The target preview is updated dynamically according to the tool’s settings. If you want to see the original whitebalance, just click on that tab.

The target photo preview has a red marker available. The luminosity value of the pixel under the marker is shown as a vertical line in the histogram.

To the top right, the widget displays a histogram that is dynamically updated when changing the parameters. This histogram is very instructive as it shows that even in well exposed photos, most of the pixels have very small luminosity. With a button you can select to show either one of the 3 colors (or the sum of it which is called luminosity).

With **Exposure** you can digitally change the original photo exposure. Increasing the exposure is has the risk of making the pixel noise more visible and to blow out the highlights. Check the **Over exposure indicator** at the lower right to see if you run into saturation problems. The **Black Point** adjustment can be used to cut the histogram from the left. If your photograph looks foggy (histogram has empty space on the left, black side), you probably need to use this option. The **Exposure** and **Black Point** adjustments can be automatically estimated by pressing the **Auto Exposure Adjustments** button. This sets the black point quite accurately.

The contrast of your output depends on **Shadows**, **Saturation**, and **Gamma** parameters. The **Shadows** adjustment lets you enhance or diminish the shadow details in your photo.

Increasing the contrast of your photograph can have the side effect of reducing the apparent **Saturation** of the photo. Use a value larger than 1 to increase the saturation and a value of less than 1 to desaturate the photo. A value of 0 will give you a black and white photo. Don’t be
shy to bump up the saturation of your photos a little. The general rule is that for higher Contrast (lower Gamma) you need to apply more Saturation.

The next set of options is the mainstay of White Balance settings, which controls the ratio between the three color channels. Here you can set the color Temperature, making your image warmer or colder. Higher temperature will result in a warmer tint. Setting the ratio between the three color channels requires two adjustments. Since the temperature adjustment mostly controls the ratio between the red and the blue channels, it is natural that the second adjustment will control the intensity of the Green channel.

Instead of fiddling around with the above controls, you can simply use the Temperature Tone Color Picker button. Press on this button and click anywhere on the original preview image to get the output color of that area to calculate the white color balance temperature settings. This way, Temperature and Green values are automatically computed.

In addition you can set the White Balance using the preset list. These are the white color balance temperature presets available:

<table>
<thead>
<tr>
<th>Color Temperature</th>
<th>Description</th>
<th>Kelvin</th>
</tr>
</thead>
<tbody>
<tr>
<td>40W</td>
<td>40 Watt incandescent lamp.</td>
<td>2680</td>
</tr>
<tr>
<td>200W</td>
<td>200 Watt incandescent lamp, studio lights, photo floods.</td>
<td>3000</td>
</tr>
<tr>
<td>Sunrise</td>
<td>Sunrise or sunset light.</td>
<td>3200</td>
</tr>
<tr>
<td>Tungsten</td>
<td>Tungsten lamp or light at 1 hour from dusk or dawn.</td>
<td>3400</td>
</tr>
<tr>
<td>Neutral</td>
<td>Neutral color temperature.</td>
<td>4750</td>
</tr>
<tr>
<td>Xenon</td>
<td>Xenon lamp or light arc.</td>
<td>5000</td>
</tr>
<tr>
<td>Sun</td>
<td>Sunny daylight around noon.</td>
<td>5500</td>
</tr>
<tr>
<td>Flash</td>
<td>Electronic photo flash.</td>
<td>5600</td>
</tr>
<tr>
<td>Sky</td>
<td>Overcast sky light.</td>
<td>6500</td>
</tr>
</tbody>
</table>

Color Temperature is a simplified way to characterize the spectral properties of a light source. While in reality the color of light is determined by how much each point on the spectral curve contributes to its output, the result can still be summarized on a linear scale. This value is useful e.g. for determining the correct white balance in digital photography, and for specifying the right light source types in architectural lighting design. Note, however, that light sources of the same color (metamers) can vary widely in the quality of light emitted.

Low Color Temperature implies more yellow-red light while high color temperature implies more blue light. Daylight has a rather low color temperature near dawn, and a higher one during the day. Therefore it can be useful to install an electrical lighting system that can supply cooler light to supplement daylight when needed, and fill in with warmer light at night. This also correlates with human feelings towards the warm colors of light coming from candles or an open fireplace at night. Standard unit for color temperature is Kelvin (K).

Over Exposure Indicator option adds up the colors if more than one channel in a pixel is over-exposed, and you will see the combined color resulting of White Color Balance controls settings. This rule is applied to target preview area as an indication only and has no effect on the final rendering.

Save As... and Load... buttons are used to do just that. Any White Color Balance settings that you have set can be saved to the filesystem in a text file and loaded later.

Reset All button resets all filter settings to default values corresponding to Neutral White Balance color. (Attention, even the neutral setting might be different from your original photograph. If you save it, the white balance will be changed.)
3.1.3.11  Color Negative Tool

TODO

3.1.4  Image Enhancement

3.1.4.1  Introduction

*Barrel distortion* is associated with wide angle (or minimal zoom) lenses. It causes the images to appear slightly spherical (curved outward) like a barrel. You can notice this when you have straight features close to the image’s peripheral sides. *Pincushion distortion* is the opposite defect and is associated with Telephoto lenses (maximum zoom) or underwater images. The images appear pinched (bent inward) toward the center. The Pincushion is often less noticeable than barrel but are equally visible near the edges. These distortions can easily be eliminated without visible loss in quality with this tool.

**NOTE**  
This tool treats the geometrical distortions. Chromatic aberrations will not be corrected by this tool.

The following figures explain the main types of geometrical distortions:

- (1): pincushion distortion.
- (2): no distortion.
- (3): barrel distortion.

3.1.4.1.1  Using the lens distortion tool

**NOTE**  
A bit of explanation first. The geometrical corrections use 4th-order polynomial coefficients.

- The 1st-order coefficient changes the size of the image. The tool calls this **Zoom**.
- The 2nd-order coefficient treats the main geometrical distortion of lenses and can correct the convex or concave shape of the image.
- The 3rd-order coefficient has a similar rounding effect but levels off towards the edges. This correction is not employed in the tool.
- The 4th-order coefficient corrects the far edges inversely to the 2nd-order rounding. Combining it with the 2nd-order correction the geometrical distortions can be almost completely eliminated.
Four sliders let you set the distortion correction filter:

**Main**: this value controls the amount of 2nd-order distortion. Negative values correct barrel distortions, while positive values correct pincushion distortion.

**Edge**: this value controls the amount of 4th-order distortion. The Edge control has more effect at the edges of the image than at the center. For most lenses, the **Edge** parameter has the opposite sign of the **Main** parameter.

**Zoom**: this value rescales the overall image size (1st-order correction). Negative values zoom out of the image, while positive values zoom in.

**Brighten**: this control adjusts the brightness in image corners. Negative values decrease the brightness image corners, while positive values increase it.

To help you to choose the best filter settings, the widget dialog illustrates with a thumbnail preview the distortion correction applied to a crossed mesh pattern. The values you apply to your image will be saved and come up with the same values as default the next time you call the tool.

**NOTE**

The barrel-pincushion correction should be done before any crop or size changes (including perspective correction). In fact the Barrel-Pincushion corrections should be the very first step on the original image. If you crop the image and then use barrel correction the effect would be obviously wrong.

To help you finding the best correction the tool provides a vertical and horizontal guide. Move the mouse cursor in the image preview to display the dashed lines guide. Move the cursor to an important place in the image like the sea level or a building border and press the left mouse button for freeze the dashed lines position. Now, adjust the barrel/pincushion correction to align with the guide.

When using pincushion correction the resulting image will have a black border in the corner. You will need to cut this out with a crop tool available in **Transform → Crop** Image Editor menu or via the zoom slider of this dialog.

On most images using the barrel correction is enough, however with some shots such as front images, frames, paintings, the next logical step is to use perspective correction to make all the angles 90 degrees. Note that when you hold your camera by hand you almost always introduce some kind of slight perspective distortion.
3.1.4.1.2 The lens distortion tool in action

This is an example of a barrel correction applied to church in north Norway. The original image is (1), the corrected image (2).

The values used for this example are:

- Main = -40.
- Edge = 0.
- Zoom = -20.
- Brighten = 0.

3.1.4.2 Introduction

Most current digital cameras produce images with several brightly colored “bad pixels” when using slow shutter speeds. Night images can be ruined by these “bad pixels”. There are three different types of “bad pixels”:

- **Stuck pixels**: it’s a pixel that always reads high or is always on to maximum power on all exposures. This produces a bright pixel usually of red, blue or green color in the final image. A stuck pixel will occur regardless of shutter speed, aperture size or any other user settings. It will occur on a normal exposure and tends to be more obvious under bright condition.

- **Dead pixels**: it’s a pixel that reads zero or is always off on all exposures. This state produces a black pixel in the final image. Similar to stuck pixel, a dead pixel will occur regardless of shutter speed, aperture size or any other user settings.

- **Hot pixels**: it’s a pixel that reads high (bright) on longer exposures as white, red, or green color. The longer the exposure time, the more visible hot pixels will become. These pixels will not be visible in bright conditions.

Note that stuck or dead pixels will occur at the same location for all images. If the location of the stuck or dead pixel occurs at different locations, it may be a Hot Pixel.

Stuck, dead or hot pixels are a problem in particular when shooting in high quality raw mode since many cameras have built-in hot pixel suppression applied automatically when JPEG compression is used (which is mostly the case).

This tool can be used to fix the “Hot pixels” and “Stuck Pixels” on a photograph using a black frame subtraction method. There is no yet a manual editor to select bad pixels.
3.1.4.2.1 Create the Black Frames

The Black Frame subtraction method is the most accurate "Hot Pixels" and "Stuck Pixels" removal. First you have to create a "Black Frame" as a reference. This is easy to do. When you finish taking your long exposure shots, put a lens cap on the camera and take one "dark" image with the same exposure time as the images before. This image will be all dark, but with close examination you will see that it has the Hot and Stuck Pixels (colored dots). These are positioned at the same places as on your previous shots.

Load this file to the widget using the Black Frame button. The toll will process an automatic detection of Hot and Stuck Pixels. They will be highlighted in the control panel preview areas.

**Warning**
If you use an old digital camera, it is important to re-shoot the Black Frame next time you are taking a long exposure images to detect new Hot and Stuck Pixels on CCD defects.

3.1.4.2.2 Using the hotpixel tool

At first, as explained in the previous section, you need to load a Black Frame corresponding to the image to correct. An automatic parsing will be processed on the Black Frame to find bad pixels. Note that the widget will remember the previous Black Frame used on the last session and it will be re-opened automatically with the next session.

The image panel and the original preview help you to pan within the image. The preview window shows the filter output using the current settings. Bad Pixels are highlighted on all preview areas.

Select an area to see bad pixels on preview and the filter result using 'Separate View' options of image panel. Choose the best **Filter** method to interpolate pixels or pixel blocks. These are the available filters:

- **Average**: the pixels adjacent to the pixel block are averaged. The resulting color is assigned to all pixels in the block. For 1-dimensional interpolation, this is done separately for one pixel-wide, horizontal or vertical stripes.
• Linear: the pixels which have a distance of 1 from the pixel block are used to calculate a bi-linear surface (2-dim), or a group of linear curves (1-dim), which is then used to assign interpolated colors to the pixels in the block.

• Quadratic: this is the default filtering method. The pixels which have a distance of 2 or less from the pixel block are used to calculate a bi-quadratic surface (2-dim), or a group of quadratic curves (1-dim), which is then used to assign interpolated colors to the pixels in the block.

• Cubic: the pixels which have a distance of 3 or less from the pixel block are used to calculate a bi-cubic surface (2-dim), or a group of cubic curves (1-dim), which is then used to assign interpolated colors to the pixels in the block.

3.1.4.2.3 The hotpixels tool in action

Below, you can see the Hot Pixels Correction tool applied to a color photograph taken with a deficient digital camera at 200 ISO sensitivity with a long exposure shot. The original image magnified to 300% is (1), the corrected image (2).

3.1.4.3 Improve Photos exposure with Local Contrast Tool

There are multiple ways to render HDR image to improve photos containing under or overexposed areas. With camera devices, usual tools let you merge multiple shots with different exposures into one perfectly exposed photo. This work nicely but require some limitation, as for example the necessity to shot static subjects. But what if you have just in case of single image, or with dynamic subjects? You might want to give a try to the Local Contrast feature. It’s based on the LDR Tonemapping utility which is designed to improve the dynamic range of the photo by reducing its global contrast and increasing the local contrast. It does so by generating a desaturated and blurred version of the photo. It then combines the RGB channels of the original photo with the desaturated blurred image using either the Linear or Power function. Sounds complicated? Don’t worry, the Local Contrast tool is rather straightforward to use, so you don’t have to understand all its intricacies in order to achieve pleasing results.
Example 3.10 The Local Contrast in Action

Open the photo you want in the editor and choose Enhance → Local Contrast. The tool lets you apply up to four tonemapping operations called stages. Each stage offers two parameters for you to tweak: Power and Blur. The former allows you to specify the desaturation level, while the latter lets you adjust the affected areas on the photo. To preview the result, hit the Try button. Once you are satisfied with the result, press OK to apply the process to the photo.

While the Local Contrast tool may sound like an easy way to fix photos, you should use it with care: sometimes it can do more damage than good, producing unnaturally looking photos.

3.1.4.4 Introduction

This tool provides selectable image filters to remove specks or other artifacts caused by junk such as dust or hair on the lens. It also can be used to remove Sensor Noise from the camera that maybe caused by high ISO settings, as well as the so-called Moiré Patterns on scanned images from books or magazines.

If you want more information about what’s digital camera sensor noise, please take a look in this tutorial.
3.1.4.4.1 Using the Noisereduction Tool

The above screenshot shows a typical scene taken with an digital camera using a high sensitivity ISO setting. It shows grainy noise which can be reduced successfully with this tool.

The re-sizeable image panel with the original preview helps you to pan within the image. Move the red rectangle around to select the area that lets you judge on the optimal filter settings. The preview window shows the filter output using the current settings. It can be rearranged in four different combinations as depicted in the icons below the original preview. This screenshot shows the first arrangement where the same cutout is shown for comparison. On the bottom of preview area, you can see Zoom Factor settings to magnify an area of the image.

You can see below a full description of all parameters. In most cases only Details tab is needed and the other parameters available into Advanced tab can be left at their default setting.

- **Radius**: this control selects the gliding window size used for the filter. Larger values do not increase the amount of time needed to filter each pixel in the image but can cause blurring. This window moves across the image, and the color in it is smoothed to remove imperfections. In any case it must be about the same size as noise granularity or somewhat more. If it is set higher than necessary, then it can cause unwanted blur.

- **Threshold**: use the slider for coarse adjustment, and the spin control for fine adjustment. This controls edge detection sensitivity. This value should be set so that edges and details are clearly visible and noise is smoothed out. This value is not bound to any intensity value, it is bound to the second derivative of intensity values. Simply adjust it and watch the preview. Adjustment must be made carefully, because the gap between noisy, smooth, and blur is very small. Adjust it as carefully as you would adjust the focus of a camera.

- **Texture**: this control set the texture accuracy. This value can be used, to get more or less texture accuracy. When decreased, then noise and texture are blurred out, when increased then texture is amplified, but also noise will increase. It has almost no effect to image edges, opposed to filter Edge, which would blur edges, when increased. If Edge is adjusted in away so that edges are sharp, and there is still too much area noise, then Texture detail could be used to reduce noise without blurring edges. Another way would be to decrease Radius and to increase Edge.

- **Sharpness**: this control set the sharpness level. This value defines the pixel distance in which the filter looks ahead for luminance variations. When this value is increased, then spikenoise...
is erased. You can eventually readjust filter **Edge**, when you changed this setting. When this value is too high, then the adaptive filter cannot longer accurately track image details, and noise can reappear or blur can occur.

- **Edge**: this control set the edge accuracy for sharpness. This value improves the frequency response for the filter. When it is too strong then not all noise can be removed, or spike noise may appear. Set it near to maximum, if you want to remove weak noise or JPEG-artifacts, without loosing detail.

- **Erosion**: this control set the phase shift for edges. This value can be used to erodes singular spikes and it has a smooth effect to edges, and sharpens edges by erosion, so noise at edges is eroded. The effect is dependent from **Sharpness**, **Damping**, and **Edges**. Set it to minimum, if you want to remove weak noise or JPEG-artifacts. When this value is increased, then also increasing **Damping** is often useful. This setting can provides sharpening and antialiasing effect to edges when spike noise is corrected.

- **Luminance**: this control set the luminance tolerance of image. It’s recommended to use only **Color** or **Luminance** tolerance settings to make an image correction, not both at the same time. These settings don’t influence the main smoothing process controlled by **Details** settings.

- **Color**: this control set the color tolerance of image. It’s recommended to use only **Color** or **Luminance** tolerance settings to make an image correction, not both at the same time. These settings don’t influence the main smoothing process controlled by **Details** settings.

- **Gamma**: this control set the gamma tolerance of image. This value can be used to increase the tolerance values for darker areas (which commonly are more noisy). This results in more blur for shadow areas.

- **Damping**: this control set the phase jitter damping adjustment. This value defines how fast the adaptive filter-radius reacts to luminance variations. If increased, then edges appear smoother, if too high, then blur may occur. If at minimum then noise and phase jitter at edges can occur. It can suppress spike noise when increased and this is the preferred method to remove it.

- **Save As...** and **Load...**: these buttons are used to do just that. Any Noise Reduction parameters that you have set can be saved to the filesystem and loaded later.

- **Defaults**: this button resets all settings to default values.

### 3.1.4.4.2 Noisereduction in action

This is an example of how the noise reduction can change your life. The original image is (1) and the corrected image is (2). The noise reduction was applied using default settings.
3.1.4.5 Softening a Photograph

Sometimes an image is too crisp for your purposes. The solution is to blur it a bit: fortunately blurring an image is much easier than sharpening it. Select the Blur Tool with the Enhance → Blur menu entry and experiment with the level. The preview window on the right of the dialog shows the effect of the operation on your photograph.

Example 3.11 The Blur Tool in Action
3.1.4.6 Introduction

This fantastic restoration filter is a new development providing unprecedented possibilities in the public domain to remove lots of unwanted stuff from your images. It is well adapted to deal with degraded images suffering from Gaussian noise, film grain, scratches or compression artifacts and local degradations usually encountered in digital (original or digitized) images. The smoothing happens along the image curvatures, thus preserving the meaningful content much alike our human eye would want it.

The same algorithm can be used for colorization and texture replacement which is covered by another tool (inpainting). The restoration algorithm has been developed by the IMAGE team of GREC CNRS lab in Caen/France and is a part of the CImg project.

3.1.4.6.1 Using the Restoration tool

The tool comes with several presets as starting points and to simplify the restoration. The preset settings available are listed below:

- **None**: Using most common default filter settings not optimized for any particular purpose.
- **Reduce Uniform Noise**: Optimum settings for image noise due to sensors.
- **Reduce JPEG Artifacts**: JPEG’s compression is not perfect, in fact for some types of images it is far from it. As a lossy compression algorithm, there are some compression ”artifacts” - slight defaults showing in the decompressed image. This setting aims at correcting this problem.
- **Reduce Texturing**: Optimized to remove artifacts from scanning, digitizing or Moire patterns.

If you want to set filter parameters for finer adjustments, use **Smoothing Settings** and **Advanced Settings** tabs:
• **Detail Preservation** $p [0, 100]$: this controls the preservation of the curvatures (features). A low value forces an equal smoothing across the image, whereas bigger values preferably smooth the homogeneous regions and leaves the details sharper. A value of 0.9 should well preserve details so that no sharpening is required afterwards. Note that **Detail Preservation** must be always inferior to **Anisotropy**.

• **Anisotropy** $\alpha [0, 100]$: a low value smooths equally in all directions, whereas a value close to 1 smooths in one direction only. If you have film grain or CCD kind of noise a high value will result in wave-like pattern, whereas JPEG artifacts are suited for values close to 1.

• **Smoothing** $[0, 500]$: this sets the maximum overall smoothing factor (when $p$ defines the relative smoothing). Set it according to the noise level.

• **Regularity** $[0, 100]$: this parameter is concerned with the uniformity of the smoothing. Imagine the smoothing process as a combing of the image. Then the Regularity would correspond to the size of the comb. The bigger this value, the more even the overall smoothing will be. This is necessary when much noise is present since it is then difficult to estimate the local geometry. Also if you want to achieve a ‘van Gogh’ turbulence effect, setting it higher than 3 is recommended.

• **Filter Iterations**: number of times the blurring algorithm is applied. Usually 1 or 2 is sufficient.
• **Angular Step** $\alpha$ [5, 90]: angular integration of the anisotropy $\alpha$. If $\alpha$ is chosen small, $\alpha$ should also be chosen small. But beware, small angles result in long runs! Choose it as large as you can accept.

• **Integral Step** [0.1, 10]: spatial integration step width in terms of pixels. Should remain less than 1 (sub-pixel smoothing) and never be higher than 2.

• **Use Linear Interpolation**: The gain in quality if you select this option is only marginal and you lose a factor of 2 in speed. Our recommendation is to leave it off.

**Save As**... and **Load**... buttons are used to do just that. Any Photograph Restoration filter settings that you have set can be saved to the filesystem in a text file and loaded later.

**WARNING**
Photograph restoration is (comparatively) very fast in what it is doing, but it can take a long time to run and cause high CPU load. You may always abort computation by pressing **Abort** button during preview rendering.

### 3.1.4.6.2 The Restoration tool in action

Below, you can see a **Reduce Uniform Noise** Restoration type applied to a Black and White photograph taken with a Minolta(tm) 700Si camera using Ilford(tm) HP-5 film set at 3200 ISO sensitivity. You see the very prominent film grain on the faces. The original image is (1), the corrected image (2).
Below, you can see another Photograph Restoration example using **Reduce Texturing** Restoration type applied to an old color photograph acquire with a digital flat scanner. You see the very prominent artifacts resulting of scanner light on plastic photograph paper. The original image is (1), the corrected image (2).

### 3.1.4.7 Introduction

Wide angle lenses, especially those used in medium and large format photography, frequently do not uniformly illuminate the entire sensor plane. Instead, they “vignette” (shade) the edges and
corners of the image, substantially reducing the light reaching the sensor there. But telelenses may show vignetting too.

The traditional solution for this is to attach a "center filter" to the lens. This is a neutral density filter with maximum density at the optical axis of the lens, clear at the periphery, with density varying inversely to the vignetting of the lens. A center filter has many advantages: not only does it automatically correct for full-frame images but, since it's fixed to the front of the lens, it also compensates for the off-center vignetting which occurs when camera movements are employed for perspective or plane of focus adjustment.

But there are disadvantages as well. Many center filters require a 1.5 or 2 f-stop filter factor adjustment, which may in turn necessitate a shutter speed so slow (since wide angle lenses, even with center filters, are best used at apertures of f/16 or smaller) that hand-holding the camera is impossible and motion blur becomes a problem when photographing moving objects.

With the wide exposure range of present-day film and the color (or grey-scale) depth of digital camera or film scanners, it is possible to simulate the effect of a center filter by applying an equivalent transform to a raw image taken without the filter. This antivignetting tool applies a center filter transformation to an image employing an algorithm copyrighted by John Walker.

3.1.4.7.1 Using the vignetting correction tool

Five sliders give you control over the vignetting correction filter, and three more over the target image exposure:

- **Amount**: this option controls the degree of luminosity attenuation by the filter at its point of maximum amount. The default amount is 2.0, which corresponds to an optical filter with a 1 f-stop filter factor (or, by no coincidence, a factor of 2 in luminosity). Increase the amount to compensate for a greater degree of vignetting; reduce it for less.

- **Feather**: this option determines the rate at which the filter intensity falls off from the point of maximum amount toward the edges, expressed as a power factor. The default of 1 yields a linear reduction in filter amount with distance from the center. Power factors greater than 1.0 cause a faster fall-off (for example, a power of 2 causes the amount to decrease as the square of the distance from the center) and causes the effect of the filter to be concentrated near the center.
Powers less than 1 spread out the amount of the filter toward the edges; a power of 0.5 causes the amount to fall as the square root of the distance from the center.

**Radius:** this option specifies the radius, as a multiple of the half diagonal measure of the image, at which the amount of the filter falls off to zero (or, in other words, becomes transparent). The default value of 1.0 specifies a filter which is transparent at its corners. A radius specification greater than 1 extends the effect of the center filter beyond the edges of the image, while a radius less than one limits the filter’s action to a region smaller than the image. When compensating for vignetting by lenses used with large format and some medium format cameras, the default radius factor of 1 is rarely correct! These lenses often “cover” an image circle substantially larger than the film to permit camera movements to control perspective and focus, and consequently have a vignetting pattern which extends well beyond the edges of the film, requiring a radius setting greater than 1 to simulate a center filter covering the entire image circle.

The only way to be sure which settings of **Amount**, **Feather**, and **Radius** best compensate for the actual optical characteristics of a given lens is to expose a uniformly illuminated scene (for example, a grey card lit by diffuse light) and perform densitometry on the resulting image (for example with Adjust Level tool histogram position bar). Failing that, or specifications by the lens manufacturer giving the precise degree of vignetting at one or more working apertures, you may have to experiment with different settings to find those which work best for each of your lenses. For help you in this task, the widget dialog provide a thumbnail mask rendering applied on the image. Fortunately, the response of the human eye is logarithmic, not linear like most digital imaging sensors, so you needn’t precisely compensate for the actual vignetting to create images which viewers will perceive as uniformly illuminated.

**X offset** and **Y offset** settings: these options moves respectively the center of the filter horizontally or vertically up to the border of the image by the specified percentage. A negative value for the X offset will shift the filter to the left while a positive value will shift it to the right. A negative value for the Y offset will move the filter up, and finally a positive value will move it down.

**Brightness**, **Contrast**, and **Gamma** settings: processing an image with this antivignetting tool reduces the luminosity of pixels. You need to re-adjust the target image exposure with these options. These sliders give only positive values because you need only to increase this setting.

**Add Vignetting:** many photographs looks flat because of a distracting background or another composition matter. While most of time you will want to remove vignetting it is a fact that a selective vignetting could improve the readability of a photograph and draw the eyes to the intended subject. As an artist you may choose this option, ticking it will invert the filter thus darkening the corners of a photograph.

---

**NOTE**

Showfoto If you want a finer exposure re-adjustment of the target image, leave the Brightness/Contrast/Gamma values at zero and use the Adjust Curve tool from Image Editor available under **Color → Adjust Curve** menu entry.

---

**3.1.4.7.2 The vignetting correction tool in action**

This is an example of an anti vignetting correction applied to an image. The original image (1) shows vignetting in the corners, the corrected image (2) much less. A brightness and contrast correction is also applied to the target image by this tool.

The values used for this example are:

- Density = 2.6.
- Power = 0.9.
- Radius = 1.1.
- Brightness = 20.
The inpainting algorithm has been developed by the IMAGE team of GREC CNRS lab in Caen/France and is a part of the CImg project.

3.1.4.8 Introduction

The inpainting algorithm has been developed by the IMAGE team of GREC CNRS lab in Caen/France and is a part of the CImg project.
3.1.4.8.1 Using the Inpainting tool

The tool comes with several presets as starting points and to simplify the restoration. The preset settings available are listed below:

- **None**: Using most common default filter settings not optimized for any particular purpose.
- **Remove Small Area**:.
- **Remove Medium Area**:.
- **Remove Large Area**:.

If you want to set filter parameters for finer adjustments, use **Smoothing Settings** and **Advanced Settings** tabs:

- **Detail Preservation** \( p [0, 100] \): this controls the preservation of the curvatures (features). A low value forces an equal smoothing across the image, whereas bigger values preferably smooth the homogeneous regions and leaves the details sharper. A value of 0.9 should well preserve details so that no sharpening is required afterwards. Note that **Detail Preservation** must be always inferior to **Anisotropy**.
• **Anisotropy** alpha [0, 100]: a low value smooths equally in all directions, whereas a value close to 1 smooths in one direction only. If you have film grain or CCD kind of noise a high value will result in wave-like pattern, whereas JPEG artifacts are suited for values close to 1.

• **Smoothing** [0, 500]: this sets the maximum overall smoothing factor (when p defines the relative smoothing). Set it according to the noise level.

• **Regularity** [0, 100]: this parameter is concerned with the bigger structures. The bigger this value, the more even the overall smoothing will be. This is necessary when much noise is present since it is then difficult to estimate the geometry. Also if you want to achieve a ‘van Gogh’ turbulence effect, setting it higher than 3 is recommended.

• **Filter Iterations**: number of times the blurring algorithm is applied. Usually 1 or 2 is sufficient.

• **Angular Step** da [5, 90]: angular integration of the anisotropy alpha. If alpha is chosen small, da should also be chosen small. But beware, small angles result in long runs! Choose it as large as you can accept.

• **Integral Step** [0.1, 10]: spatial integration step width in terms of pixels. Should remain less than 1 (sub-pixel smoothing) and never be higher than 2.

• **Use Linear Interpolation**: The gain in quality if you select this option is only marginal and you lose a factor of 2 in speed. Our recommendation is to leave it off.

Save As... and Load... buttons are used to do just that. Any Photograph Inpainting filter settings that you have set can be saved to the filesystem in a text file and loaded later.

**WARNING**

Photograph Inpainting is (comparatively) very fast in what it is doing, but it can take a long time to run and cause high CPU load. You may always abort computation by pressing Cancel button during rendering.

3.1.4.8.2 The Inpainting tool in action

Below, you can see a **Remove Small Area** Inpainting type applied to a color photograph taken at Guatemala city with an analog camera. Look like there is a strange black artifacts on the face front, resulting of a bad film stockage during the travel. The original image is (1), the corrected image (2).
3.1.4.9 Remove Red Eyes in a Photograph

Red eyes are caused when the camera flashlight is used to take photographs of people. The red is the reflection from the back of the eye which can be seen because the pupil cannot react quickly enough to the flash. By the way, with a separate flash light the red eye effect is less likely because of the different viewing angle of flash and lens. You can correct some of the worst effect of Red Eye by selecting the area of the eye on the photograph, in the same way as described for cropping above. Then select **Enhance → Red Eye Reduction**.

How it works

- Set the preview mode to your liking
- The **Sensitivity** setting adjusts the amount of red eyes removal (aggressive or not)
- The **Smooth** slider sets the blurring of the area that has been darkened to render the pupil more natural
- The **Color Tint** sets a custom colorization for the pupil. If you want blue eyes instead of dark ones, here you can do it
- The **Tint Level** adjusts the luminosity of set pupil color
3.1.4.10 Introduction

Out-of-focus photographs, as well as most digitized images, need correction of sharpness. This is due to the digitizing process that must chop up a color continuum in points with slightly different colors: elements thinner than sampling frequency will be averaged into an uniform color. Thus, sharp borders are rendered a little blurred. The same phenomenon appears when printing color dots on paper. SLR cameras need even more sharpening on a regular basis than consumer cameras.

Whereas JPEG images have some camera-internal sharpening applied, RAW format images always need sharpening in their workflow.

Some scanners apply a sharpen filter while scanning. It’s worth to disable it so that you keep control over your image.

3.1.4.10.1 Adjusting Sharpness

3.1.4.10.2 Unblurring a Photograph

If the camera focus is not set perfectly or if the camera is moving when the image is taken the result is a blurred photograph. If there is a lot of blurring, you probably will not be able to do much about it with any technique. If there is only a moderate amount, you should be able to improve the image. Many good SLR cameras apply less image processing to the images than simpler cameras (which tend to artificially increase the contrast to make the images look crisp). This kind of slight blur can be easily improved with tools.

In some situations, you may be able to get useful results by sharpening an photograph using the Sharpen tool by the Enhance → Sharpen menu entry.
You should be careful with this though, or the results will not look very natural: sharpening increases the apparent sharpness of edges in the photograph, but also amplifies noise. Generally, the most useful technique for sharpening a fuzzy photograph is the Refocus tool. You can access it with the Enhance → Refocus menu entry. Look at Refocus for more information and a comparison of all the sharpening techniques.

3.1.4.10.3 Reducing Graininess In a Photograph

When you take a photograph in low-light conditions or with a very fast exposure time, the camera does not get enough data to make good estimates of the true color at each pixel, and consequently the resulting photograph looks grainy. You can “smooth out” the graininess by blurring the image, but then you will also lose sharpness. Probably the best approach - if the graininess is not too bad - is to use the filter Noise Reduction tool, and you can access it by the Enhance → Noise Reduction menu entry.

3.1.4.10.4 Softening a Photograph

Sometimes you have the opposite problem: an image is too crisp. The solution is to blur it a bit: fortunately blurring an image is much easier than sharpening it. Select the Blur Tool with the Enhance → Blur menu entry and experiment with the level. The preview window on the right of the dialog shows the effect of the operation on your photograph.

3.1.4.10.5 The Unsharp Masking Filter

NOTE
The Unsharp Mask filter is an excellent tool to remove haze from your photographs, see this url for a demonstration.
The image panel and the original preview help you to pan within the image. The preview window shows the filter output using the current settings.

There are two important parameters, \textbf{Radius} and \textbf{Amount}. The default values often work pretty well, so you should try them first. Increasing either the \textbf{Radius} or the \textbf{Amount} increases the strength of the effect. Don’t get carried away, though: if you make the unsharp mask too strong, it will amplify noise in the image and create the impressions of ridges next to sharp edges.

The \textbf{Radius} allows you to set how many pixels on either side of an edge that will be affected by sharpening. High resolution images allow higher radius. You’d better always sharpen an image at its final resolution.

The \textbf{Amount} control is the percentage of the difference between the original and the blur image that is added back into the original. It allows you to set strength of sharpening.

The \textbf{Threshold} control is a fraction of the maximum RGB value, needed to apply the difference amount. It allows you to set the minimum difference in pixel values that indicates an edge where sharpening should be applied. That way, you can protect areas of smooth tonal transition from sharpening, and avoid creation of blemishes in face, sky or water surface.

3.1.4.10.6 The Unsharp Mask in action

This is an example of how the Unsharp Mask can change your life. The original image is (1) and the corrected image is (2). The unsharp mask was applied with \textbf{Radius} = 6.0, \textbf{Amount} = 0.5, \textbf{Threshold} = 0.0.
3.1.4.10.7 Refocus a Photograph

Showfoto The Refocus is a tool to refocus an image by enhancing the sharpness. It uses the Deconvolution Filter algorithm copyrighted by Ernst Lippe.

This tool attempts to “refocus” an image by undoing the defocussing. This is better than just trying to sharpen a photograph. It is employing a technique called FIR Wiener Filtering. The traditional technique for sharpening images is to use unsharp masking. Refocus generally produces better results than Unsharp masking. Start it from the Enhance → Sharpen → Refocus Image Editor menu.

The Refocus technique works differently from Unsharp Mask and is also unlike the Sharpen Filter which both increase the contrast of the edges of an image. Refocus rather reverses the process by which the image got blurred by the circular aperture of the camera. This method gives you as much of the original “in focus” image as possible. Refocus uses a very powerful deconvolution algorithm that will reclaim the data that has been mixed up. In mathematical terms, blurring is usually the result of a convolution, a deconvolution will reverse the process, this is exactly what Refocus is doing. Furthermore, the FIR filter technique allows to remove much of the noise and granularity that often gets accentuated in the sharpening process of all sharpening filters.
3.1.4.10.8 Using the Refocus Tool

The image panel and the original preview help you to pan within the image. The preview window shows the filter output using the current settings.

In most cases (blurring by camera) a circular convolution caused the image degradation, but there are two convolutions available:

- The circular convolution: this one spreads each source point uniformly across a small disk with a fixed radius. Technically this describes the effects of using a (ideal) lens that is not correctly focused.
- The Gaussian convolution: this one is mathematically similar to the normal distribution, with its bell-shaped curve. Originates rather from unnatural blurring (software blurring). From a theoretical point of view the mathematical justification for using the Gaussian convolution is that when you apply a large number of independent random convolutions the results will always approach a Gaussian convolution.

The refocus tool supports both the Circular and the Gaussian convolution plus mixtures of both.

In practice, in most cases the Circular convolution works much better than the Gaussian convolution. The Gaussian convolution has a very long tail, so mathematically the result of the convolution also depends on source pixels at a large distance from the original source pixel. The FIR Wiener inverse of a Gaussian convolution in most cases is heavily influenced by source pixels at a large distances, and in most cases this produces undesirable results.

To set correctly the deconvolution filter, the plug-in has the following parameters:

- **Circular Sharpness**: This is the radius of the Circular convolution filter. It is the most important parameter for using the plug-in. With most images the default value of 1 should give good results. Select a higher value when your image is very blurred, but beware of producing halos.
- **Correlation**: Increasing the Correlation may help reducing artifacts. The correlation can range from 0-1. Useful values are 0.5 and values close to 1, e.g., 0.95 and 0.99. Using a high value for the correlation will reduce the sharpening effect of the plug-in.
• **Noise filter**: Increasing the Noise filter parameter helps reducing artifacts. The Noise can range from 0-1 but values higher than 0.1 are rarely helpful. When the Noise value is too low, e.g. 0 the image quality will be horrible. A useful value is 0.03. Using a high value for the Noise will even blur the image further.

• **Gaussian Sharpness**: This is the radius for the Gaussian convolution filter. Use this parameter when your blurring is Gaussian (mostly due to previous blur filtering). In most cases you should leave this parameter to 0, because it causes nasty artifacts. When you use non-zero values you will probably have to increase the **Correlation** and/or **Noise filter** parameters, too.

• **Matrix size**: This parameter determines the size of the transformation matrix. Increasing the Matrix Size may give better results, especially when you have chosen large values for **Circular Sharpness** or **Gaussian Sharpness**. Note that the plug-in will become very slow when you select large values for this parameter. In most cases you should select a value in the range 3-10.

• **Save As...** and **Load...**: these buttons are used to do just that. Any Refocus parameters that you have set can be saved to the filesystem and loaded later.

• **Defaults**: this button resets all settings to default values.

Below, you can see few hints to help you work with the refocus plug-in:

• Preferably perform all cropping, color and intensity curve corrections on the image before using this plug-in.

• Otherwise use this plug-in before performing any other operations on the image. The reason is that many operations on the image will leave boundaries that are not immediately visible but that will leave nasty artifacts.

• When you are scanning images and compress them, e.g. to JPEG, you should use the plug-in on the uncompressed image.

### 3.1.4.10.9 Refocus comparison with other techniques

Comparison to two other techniques frequently used to enhance images are:

• **Sharpen Filter**

• **Unsharp Mask**

Sharpening applies a small convolution matrix that increases the difference between a source pixel and its immediate neighbors. FIR Wiener filtering is a more general technique because it allows a much larger neighborhood and better parameterizations. Sharpening only works when your images are very slightly blurred. Furthermore, for high values of the sharpening parameter the results frequently looks “noisy”. With FIR Wiener filtering this noise can be greatly reduced by selecting higher values for the **Correlation** and **Noise filter** parameters.

Unsharp masking is another very popular image enhancement technique. From a mathematical point of view its justification is a bit obscure but many people are very fond of it. The first step is to create a blurred copy of the source image. Then the difference between the source image and the blurred image is subtracted from the source image, hence the name unsharp masking. If fact, unsharp masking is more of a contrast enhancement on the important image feature than a sharpening. It does not undo the aperture pattern interference of the camera diaphragm as refocus does.

In general, unsharp masking produces better results than sharpening. This is probably caused by the fact that unsharp masking uses a larger neighborhood than sharpening.

From a theoretical point of view unsharp masking must always introduce artifacts. Even under optimal circumstances it can never completely undo the effect of blurring. For Wiener filtering
it is possible to prove that it is the optimal linear filter. In practice, in all cases the results of the FIR Wiener filter were at least as good as those of unsharp masking. The FIR Wiener filter is frequently better in restoring small details.

Below, you can see a comparison of different filter apply on a small unfocused image:

<table>
<thead>
<tr>
<th>Preview</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Original blurred color image to fix. This image have been taken with an analog still camera. The unfocusing result of an insufficient light for the auto-focus lens." /></td>
<td>Original blurred color image to fix. This image have been taken with an analog still camera. The unfocusing result of an insufficient light for the auto-focus lens.</td>
</tr>
<tr>
<td><img src="image2.jpg" alt="Fixed image using simple sharpening filter. Sharpness setting is 80." /></td>
<td>Fixed image using simple sharpening filter. Sharpness setting is 80.</td>
</tr>
<tr>
<td><img src="image3.jpg" alt="Fixed image using unsharp mask filter. Settings are Radius=50, Amount = 5, and Threshold=0." /></td>
<td>Fixed image using unsharp mask filter. Settings are Radius=50, Amount = 5, and Threshold=0.</td>
</tr>
</tbody>
</table>
3.1.4.11  Lens Auto Correction Tool

TODO

3.1.5  Image transformation tools

3.1.5.1  Cropping a Photograph

3.1.5.1.1  Manual Crop

Cropping a photograph is not only a common operation, but an often underestimated photographer’s tool to compose an image. The Image Editor makes it very easy. To crop a photograph simply drag a rectangle over the image by holding down the left mouse button and moving the mouse. You will see a wire frame rectangle appear as you move the mouse.

**NOTE**
For more information about correction of sharpness methods used in digital imagery, you can find a technical comparison at this url.
Example 3.14 The Current Image Selection in Image Editor

When you release the button the area of the photograph that will be removed by a crop operation is greyed out. This allows you to get a good view of how your photograph will look once you have cropped it. You can change the size of the cropped area by dragging the corners of the rectangle, and you can create a new crop area simply by dragging out another rectangle.

Once you are happy with the crop, click on the button on the toolbar and the photograph will be cropped (Ctrl-X). Use the File → Save or File → Save As... entries in the File menu to save the newly cropped photograph.

3.1.5.1.2 Auto Crop

The Auto Crop tool removes the borders from an image. It searches the largest possible border area that is all the same color, and then crops this area from the image, as if you had used the Crop tool.

This tool can be used for example to crop a stitched panorama, assembly with many images, which generate black borders around.

Example 3.15 Stitched Panorama Processed With Auto Crop

3.1.5.1.3 Proportional Crop

The Aspect Ratio Crop tool goes further. While you are editing digital images, it is often necessary to create a compatible format with, for example, your photo album or paper formats. If you print an image from your digital camera and then try to put it in your photo album, you may notice that the camera has a different width or height ratio than a normal photographic film format so you need to crop your digital images in a predefined ratio (for example 5:7 or 2:3 which is a standard photo ratio).
Example 3.16 The Aspect Ratio Crop Tool Dialog

In the preview area you can resize the cropping rectangle by moving the corners with the mouse. It will keep the ratio value set in the bottom of dialog.

In the Aspect Ratio Crop tool settings, you specify the Orientation as Portrait or Landscape. Portrait will always have the larger size assigned to the Height and Landscape to the Width.

Aspect Ratio Crop tool uses a relative ratio. That means it is the same if you use centimeters or inches and it doesn’t specify the physical size. For example, you can see below a correspondence list of traditional photographic paper sizes and aspect ratio crop.

<table>
<thead>
<tr>
<th>Standard Photograph Paper Size</th>
<th>Aspect Ratio Crop</th>
</tr>
</thead>
<tbody>
<tr>
<td>10x15cm 20x30cm 30x45cm 3.5x5” 4x6” 8x12” 12x18” 16x24” 20x30”</td>
<td>2:3</td>
</tr>
<tr>
<td>6x8cm 15x20cm 18x24cm 30x40cm 3.75x5” 4.5x6” 6x8” 7.5x10” 9x12”</td>
<td>3:4</td>
</tr>
<tr>
<td>20x25cm 40x50cm 8x10” 16x20”</td>
<td>4:5</td>
</tr>
<tr>
<td>15x21cm 30x42cm 5x7”</td>
<td>5:7</td>
</tr>
<tr>
<td>21x30cm 42x60cm</td>
<td>7:10</td>
</tr>
</tbody>
</table>

At the far right of the dialog two buttons are available to move the crop selection automatically to the horizontal or vertical center of the image.

At the very bottom line of the dialog, the Max. Ratio button lets you set the crop area size to the maximum size according to the current aspect ratio settings and orientation.

NOTE
The Aspect Ratio Crop tool remembers the settings depending on image orientation (horizontal or vertical). When you use the crop tool next time, these settings will be used as default values depending on the image orientation. The changed image dimensions are stored into the EXIF tables so that the EXIF data reflects the cropped image and not the original one.
3.1.5.1.4  Composition Guide

When first looking at an image, the eye of the viewer rarely settles at the center of the image, but moves instead from the top left to the right, and then from the lower left to the right again. This pattern is unconscious but has been well documented. It is probably associated with the western reading pattern. From the photographer’s point of view, the goal then becomes to guide the gaze of the viewer to the subject, being aware of the way many people perceive an image.

The Composition Guide settings provides guiding elements to better compose your images. These guides are:

• **Rule of Thirds**: a grid that divides the image into thirds in every direction (that makes for 9 parts). These proportions are close to the golden rule and are derived from the field of view of the human eye. They are often used with slight variations throughout a large number of commonly used objects. Within that frame there are precise areas where the important parts of the image should be placed. The same principle is used to determine the position of the horizon and the proportion of ground to sky.

Many photographers and artists are aware of the Rule of Thirds, where an image is divided into three sections vertically and horizontally and the points of intersection represent places to position important visual elements. Moving a horizon in a landscape to the position of one third is often more effective than placing it in the middle, but it could also be placed near the bottom one quarter or sixth. There is nothing obligatory about applying the Rule of Thirds. In placing visual elements for effective composition, one must assess many factors including color, dominance, size and balance together with proportion. Often a certain amount of image balance or tension can make a composition more effective.

---

**Example 3.17 Image Composition Example Using Rules of Third**

---

• **Harmonious Triangles**: Harmonious divisions rely on the principle of similarity. Like the Rule of Thirds guide, Harmonious Triangles are another division of the image using a rectangle into equiangular harmonious triangles aligned with the diagonal.
The Showfoto Handbook

Example 3.18 Photograph Composition Example Using Harmonious Triangles

Golden Mean: The Golden Mean is a ratio underlying numerous growth patterns throughout nature (from the spiral of a Nautilus shell to the petals of a sunflower), it has an uncanny way of showing up in all kinds of things we deem beautiful.

The Golden Ratio is the irrational number 1.618033988..., and it is usage dates back to the ancient Egyptians and Greeks who used it in the construction of their temples and pyramids. Artists and architects throughout time have used the Golden Ratio when composing their paintings, buildings, and even photographs, in order to give their creations a sense of natural order and beauty.

The ratio is inherent in the Fibonacci series: 1, 1, 2, 3, 5, 8, 13, 21, 34 etc., where each succeeding number after 1 is equal to the sum of the two preceding numbers. The ratio formed 1:1.618 is the Golden Mean. A composition following this rule is considered visually harmonious.

The Golden Mean provides more fluid guidelines when used to compose an image. These guides are listed below:

- The Golden Spiral guide will increase your odds of getting captivating results in your photographs. As opposed to Rule of Thirds, the Golden Spiral forms a fluid line for the eye to trace through the image. This style of composition will invite the viewer’s gaze into the image along the line of the spiral, creating a more symmetrical visual flow, and an overall compelling viewing experience.
One more rule is a **Golden Spiral Sections** (or Golden Rectangles). These rectangles are used to build the Golden Spiral. There should be something leading the eye to the center of the composition. It could be a line or several subjects. This “something” could just be there without leading the eyes, but it would make its job.

**Example 3.20** Image Composition example using Golden Spiral Sections

---

The **Golden Triangles** is a derivative of the Golden Spiral discussed above. Its vertices are
the midpoints of the sides of the Golden Rectangle. Note that unlike Harmonious Triangles, 
Golden Triangles aren’t equiangular triangles. Placing diagonals along these lines can make 
an otherwise static subject appear more dynamic.
When you use Golden Triangles to break up your frame, you’re creating an effect profes-
sional photographic experts call Dynamic Symmetry. Try to keep your focal subject on one of 
the intersecting points, and place other visual information into the triangles you’ve already 
divided out. The result will be a very attractive composition you may not have otherwise 
attained.

Example 3.21 Photograph Composition Example Using Golden Triangle

Like the Rule of Thirds the Golden Sections affects the ratio of an image size as well as 
the placement of the main subjects on the photo. This ratio is close to the 35mm ratio, so 
you don’t need to change the size of the photo in most cases. But you need to consider 
the composition: the main subject should lie on one of the four lines or four intersections 
(subject’s eye for example). Truthfully speaking, these rules are not the same. Rule of Thirds 
is a simplified version of the Golden Mean.
The Showfoto Handbook

Example 3.22 Image Composition example using Golden Sections

The **Flip Horizontal** and **Flip Vertical** options can be used to apply flip transformation to the harmonious divisions.

The **Color** button lets you set the guidelines color. If you have a high color contrast image, the guidelines may become invisible. By the way, you can adapt the color guide to the current image.

### 3.1.5.2 Introduction

When taking an image it is all too easy to hold the camera not quite perfectly vertical or horizontal, resulting in an image where things are tilted at an angle. The way to fix this with the Showfoto Image Editor is to use the Free Rotation tool. Select **Transform → Free Rotation** and adjust to the target angle.

#### 3.1.5.2.1 Free Rotation Tool

Rotate your image by using the **Angle** slider (value in degrees). Press to **Reset Values** for reset the slider to zero. A rotating effect preview is available on the right side of the dialog. The new target image dimensions in pixels are shown.

For better orientation, the Free Rotation tool provides a vertical and horizontal guide. Move the mouse cursor under image preview to display the dashed line guide. Move the cursor to an supposedly vertical or horizontal feature in the image like the sea or a building border and press the left mouse button for freeze the dashed lines position. Now, adjust the angle accordingly with the guide.
After rotating the image, you often find that things are better but not quite perfect. One solution is to rotate a bit more, but there is a disadvantage to that approach. Each time you rotate an image, because the rotated pixels don’t line up precisely with the original pixels, the image inevitably gets blurred a little bit. For a single rotation, the amount of blurring is quite small, but two rotations cause twice as much blurring as one, and there is no reason to blur things more than you have to. Sure, the guide tool available in the Free Rotation preview can help you to apply correctly at the first time an angle adjustment to an image.

3.1.5.2.2 Free Rotation action

The Free Rotation dialog tool in action is available below.

After you have rotated an image, there will be unpleasant triangular “holes” at the corners. One way to fix them is to crop the image with Transform → Crop Image Editor menu.

A more elegant way to crop the rotated image is to use the Auto-crop function. Choose anyone of the following options from the combo-box to your preference:

- **Widest area** This option crops the rotated image to the widest possible (width) rectangular section.
- **Largest area** This option crops the rotated image to the biggest surface.

Hold the mouse over the combo-box and scroll with the wheel between the two possibilities.

The **Anti-aliasing** checkbox will smooth the image a bit after rotation. Please read the warning above.

3.1.5.3 Introduction

With this tool you can work on the perspective in a photograph. This is very useful when working with photographs that contain keystone distortion. Keystone distortion occurs when an object
The Showfoto Handbook

is photographed from an angle rather than from a straight-on view. For example, if you take an image of a tall building from ground level, the edges of the building appear to meet each other at the far end. On the other hand you can use this tool to introduce a new perspective that is not a face-on view but to give the image a creative spin.

3.1.5.3.1 Using the Perspective Adjustment

All perspective transformations are performed around a fixed point called the reference point. This point is at the center of the item you are transforming and is displayed by a red circle.

To change the perspective, use the square areas at the image corners for dragging. The perspective preview is rendered automatically. On the right of the dialog you’ll find a set of information which help you to control the perspective change:

- **New Width**: show the new image width in pixels including the empty area around the image resulting from the geometrical transformation.

- **New Height**: show the new image height in pixels including the empty area around the image resulting from the geometrical transformation.

- **Top Left Angle**: show the current angle in degrees at the top left corner of the perspective area.

- **Top Right Angle**: show the current angle in degrees at the top right corner of the perspective area.

- **Bottom Left Angle**: show the current angle in degrees at the bottom left corner of the perspective area.

- **Bottom Right Angle**: show the current angle in degrees at the bottom right corner of the perspective area.

**Warning**

After applying the perspective adjustment, the image inevitably gets blurred a little bit. For a single adjustment, the amount of blurring is quite small, but two adjustments cause twice as much blurring as one, and there is no reason to blur things more than you have to.

After you have adjusted the perspective of an image there will be unpleasant triangular “holes” at the corners. One way to fix them is to crop the image with Transform → Crop Image Editor menu.

3.1.5.3.2 The Perspective Adjustment in action

The Perspective Adjustment dialog in action is shown below.
3.1.5.4 Introduction

Rescaling an image to make it smaller is easy. The big question is: how can you blow up an image and keep the details sharp? How can one zoom in when the resolution boundary has been reached? How can one reinvent or guess the missing information to fill in the necessarily coarse image after upsizing? Well, the CImg algorithm we use here does an excellent job, try it out and see for yourself!

3.1.5.4.1 Resizing a Photograph

If the photograph has the wrong size, you can scale it to the size you would like by using Transform Resize tool. Select Transform → Resize and adjust the target values. The Resize tool dialog is available below.

Example 3.23 The Resize Tool Dialog

This image resizing tool uses a standard linear interpolation method to approximate pixels. If you want to up-size a small image with a better quality, try the Blowup tool.
3.1.5.4.2 Increasing image size (Restoration)

Many image editing programs use some kind of interpolation e.g. spline interpolation to scale-up an image. Showfoto uses a more sophisticated approach. The algorithm underlying Restoration has been developed by the IMAGE team of GREC CNRS lab in Caen/France and is a part of the CImg project.

You have to tell the tool about the resizing you want to do. These settings are available in New Size tab and are listed below:

- **Maintain Aspect Ratio**: if this option is enabled, setting the new image size will preserve the aspect ratio of the original image.
- **Width**: the new image width to use for blowing up.
- **Height**: the new image height to use for blowing up.

If you want to set filter parameters for finer adjustments, use Smoothing Settings and Advanced Settings tabs:

Photograph Blowup Smoothing Settings

- **Detail Preservation** $p \in [0, 100]$: this controls the preservation of the curvatures (features). A low value forces an equal smoothing across the image, whereas bigger values preferably smooth the homogeneous regions and leaves the details sharper. A value of 0.9 should well preserve details so that no sharpening is required afterwards. Note that Detail Preservation must be always inferior to Anisotropy.
- **Anisotropy** $\alpha \in [0, 100]$: a low value smooths equally in all directions, whereas a value close to 1 smooths in one direction only. If you have film grain or CCD kind of noise a high value will result in wave-like pattern, whereas JPEG artifacts are suited for values close to 1.
- **Smoothing** $[0, 500]$: this sets the maximum overall smoothing factor (when $p$ defines the relative smoothing). Set it according to the noise level.
- **Regularity** $[0, 100]$: this parameter is concerned with the bigger structures. The bigger this value, the more even the overall smoothing will be. This is necessary when much noise is present since it is then difficult to estimate the geometry. Also if you want to achieve a ‘van Gogh’ turbulence effect, setting it higher than 3 is recommended.
- **Filter Iterations**: number of times the blurring algorithm is applied. Usually 1 or 2 is sufficient.

Photograph Blowup Advanced Settings

- **Angular Step** $\text{da} \in [5, 90]$: angular integration of the anisotropy alpha. If alpha is chosen small, da should also be chosen small. But beware, small angles result in long runs! Choose it as large as you can accept.
• **Integral Step** [0.1, 10]: spatial integration step width in terms of pixels. Should remain less than 1 (sub-pixel smoothing) and never be higher than 2.
• **Use Linear Interpolation**: The gain in quality if you select this option is only marginal and you lose a factor of 2 in speed. Our recommendation is to leave it off.

**Save As**... and **Load**... buttons are used to do just that. Any Blowup Photograph filter settings that you have set can be saved to the filesystem in a text file and loaded later.

![WARNING]
Blowup Photograph is very fast in what it is doing, but it can take a long time to run and cause high CPU load. You may always abort computation by pressing **Cancel** button during rendering.

3.1.5.4.3 The blow-up tool in action

You can see below an Blowup Photograph example applied to a small color image area resized to x2. The original is (1), the Blowup result (3). The (2) preview is the result given to standard linear resizing method to compare.

![Image](image)

3.1.5.5 The Liquid Rescale Tool

TODO

3.1.5.6 Rotating or Flipping a Photograph

If the photograph shows a wrong orientation you can **Flip** or **Rotate** it to the orientation you would like by using Transform Flip/Rotate tools available in **Transform → Rotate** and **Transform → Flip** menus.
With flipping options, you can flip or turn over the image horizontally or vertically like a card deck. With the rotating options, you can rotate the image in 90 degrees steps clockwise. It can be used to change the display mode to Portrait or Landscape. Be aware that this rotation is not lossless when using JPEG format. You also can rotate more accurately to a finer degree by using the Free Rotation tool. You can access it by the Transform → Free Rotation menu entry. See the dedicated Free Rotation manual for more information.

### 3.1.5.7 Introduction

The Shear tool is used to shift one part of an image to one direction and the other part to the opposite direction. For instance, a horizontal shearing will shift the upper part to the right and the lower part to the left. This is not a rotation: the image is distorted. In other words, it will turn a rectangle into a parallelogram. This tool is available from Transform → Shear menu.

### 3.1.5.7.1 Using the Shear tool

Shear your image by using the Horizontal Angle and Vertical Angle sliders (values in degrees). You can shear along either Horizontally and vertically at the same time. Click on the Reset Values reset. A shearing effect preview is shown on the center of dialog window. The new target image dimensions in pixels are displayed at the right side of dialog.

To assist you in aligning, the tool provides a vertical and horizontal guide. Move the mouse cursor under image preview for display the dashed lines guide. Move the cursor to an important place in the image like the sea or a building border and press the left mouse button for freeze the dashed lines position. Now, adjust the shear correction according with the guide.

**WARNING**

After applying a shearing adjustment, the image inevitably gets blurred a little bit. For a single shearing, the amount of blurring is quite small, but two shears cause twice as much blurring as one, and there is no reason to blur things more than you have to.

After you have sheared an image, there will be unpleasant triangular “holes” at the corners. One way to fix them is to crop the image with Transform → Crop Image Editor menu.

### 3.1.5.7.2 The Shear tool in action

The Shear Tool dialog in action is available below.
3.1.6 Adding decorative elements

3.1.6.1 Introduction

By adding texture to your image, whether color or black and white, you can make it look like an oil painting on canvas, an Old Masters etching, a Pop Art portrait composed of enlarged half-tone dots, or even a mural on a brick wall. The Decorate → Apply Texture Image Editor menu can be used for that.
3.1.6.1.1 Using the Texture Tool

Two options give you control over the texture applying on image:

**Type**: this option specifies the decorative texture style to apply under the image.

**Relief**: dragging this option to the right increases the appearance of depth or three-dimensionality of the texture on image.

3.1.6.1.2 The Texture tool in action

A **Paper** texture effect apply to a photograph is available below. The original image is (1), the target image is (2). **Relief** factor used is 200.
3.1.6.2 Introduction

Keeping the viewer’s interest within the confines of the edges of a photograph is not a simple task. One of the simplest ways to hold the attention on an image is to incorporate a decorative frame around an image. It acts as a kind of psychological barrier to the straying eye. The Image → Add Border Image Editor menu can be used for that.

3.1.6.2.1 Using the Add-border tool

Four options give you control over the decorative frame rendering:

**Type:** this option specifies the decorative frame style to apply around the image. Solid style just surrounds the image with a colored line, Niepce style surrounds the image with a fine line and a large border (ideal for black and white images), Beveled style adds a neat dimension to your image (ideal to create a button effect), and Decorative style adds an ornamental border using patterns.

**Width:** this option specifies the border width in percents of image size. The border is added around the image. The width range is limited between 1% and 50%.

**First:** this option specifies the first color to use with the current border type.

**Second:** this option specifies the second color to use with the current border type.

Click on the OK button to apply the border around the current image.

---

**NOTE**

The border decorated target image will be bigger than the original, but it will retain the same aspect ratio. This is important for printing images, especially if you have used the Aspect Ratio Crop tool before.
3.1.6.2.2 The Add-border tool in action

The Add Border dialog tool in action is available below.

![Add Border Dialog](image)

3.1.6.3 Introduction

This is a handy tool as it lets you add formatted text easily to an image wherever you want, at several places when needed.

3.1.6.3.1 Using the Insert Text tool

This tool seems very intuitive to use. Type in your text and place it with the mouse. Use the block settings as you please. Choose the orientation, color from a color space, and fonts with all their properties. You will have to scale the font size to the image size, the larger the image, the larger the font has to be! Finally choose to add a border around the text and/or a semitransparent background. Voilà, it’s finished!

Any text setting you have chosen can always be changed as long as you don’t click the OK button. In saved and reloaded images the text has become part of the image, it cannot be changed anymore.

3.1.6.3.2 The Insert Text tool in action

The Insert Text dialog tool in action is shown below.
3.1.7 Special Effects (Filters)

3.1.7.1 Introduction

With this filter set, you can transform an ordinary photograph into a work of art suitable for framing using blurring operations. It uses algorithms copyrighted by Pieter Voloshyn.

3.1.7.1.1 Using the Blurfx

These are the blurring effects available:

<table>
<thead>
<tr>
<th>Type</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom Blur</strong></td>
<td><img src="image" alt="Zoom Blur Preview" /></td>
</tr>
</tbody>
</table>

**Zoom Blur**: blurs the image along radial lines starting from a specified center point. This simulates the blur of a zooming camera, thereby giving the photograph a dynamic expression as often seen in sport photography.
**Radial Blur**: blurs the image by rotating the pixels around the specified center point. This simulates the blur of a rotating camera.

**Far Blur**: blurs the image to simulate the effect of an unfocused camera lens. The subject seems to recede into the background.

**Motion Blur**: blurs the image by swishing the pixels horizontally. This simulates the blur of a linearly moving camera, i.e. like a shot taken from a car or train.
Focus Blur: blurs the image corners to reproduce the astigmatism distortion of a lens.

Softener Blur: blurs the image softly in the darker tones and strongly in the high lights. This gives photographs a dreamy and glossy soft focus effect (Hamilton effect). It’s ideal for creating romantic portraits, glamour photography, or adding a warm and subtle glow.

Shake Blur: blurs the image by randomly moving the pixels simulating the blur of an arbitrarily moving camera.
### Smart Blur

*Smart Blur:* finds the edges of color in photograph and blurs them without muddying the rest of the image.

![Smart Blur Example](image1)

### Frost Glass

*Frost Glass:* blurs the image by simulating randomly dispersing light filtering through hoarse frosted glass.

![Frost Glass Example](image2)

### Mosaic

*Mosaic:* blurs the image by dividing the photograph into rectangular cells and then recreates it by filling those cells with average pixel value.

![Mosaic Example](image3)

----

**Warning**

Some effects can take a long time to run and cause high CPU load. You can always abort an effect by pressing the **Abort** button during preview rendering.

### 3.1.7.1.2 The Blurfx in action

An example of the Blur FX dialog in action is shown below.
3.1.7.2 Introduction

The Showfoto Charcoal filter uses the gradients of color and luminosity to produce a grey scale charcoal sketch. The lines defining the outline of the image are pronounced. Images with slowly changing gradients are not ideal for this effect. It is helpful to imagine what scene you would pick to do as a hand sketch yourself, in order to choose the image to start with.

3.1.7.2.1 Using the Charcoal filter

There are two sliders to control the effect on a scale of 1-100. The upper slider selects the pencil size, whereas the second slider adjusts the contrast (smoothness).

3.1.7.2.2 The Charcoal filter in action

This is an example of the charcoal filter. The original image is (1) and the transformed image is (2). Default values of 30 and 10 where applied. The result can be improved by adjusting the luminosity levels.
3.1.7.3 Introduction

In the age of chemical image processing, solarizing (also known as Sabatier) was an effect created by exposing a partially developed print to a brief flash of light, then completing the development. The colored, darker areas shield the additional light from the sensitive photo layers, which has the net effect of making the lighter areas darker and colors being inverted during the second exposure. The result resembles a partially negative image. The tool allows to adjust the interesting effect smoothly.

3.1.7.3.1 The Solarization Effect

The Intensity control helps to preview the solarization by simply increasing it. At about 50% intensity the image shows what was once chemically possible. If you further increase the effect it will finally become a negative image, a stage of inversion not achievable on photographic paper.

This is an example of solarization effect. The original image is (1) and the corrected image is (2). The Intensity level applied is 30%.
3.1.7.3.2 The Vivid Effect (Velvia filter)

The vivid filter simulates what is known as “Velvia” effect. It is different from saturation in that it has a more pronounced contrast effect that bring colors brilliantly alive and glowing. Try it, it renders beautiful for many subjects!

Velvia is a brand of daylight-balanced color reversal film produced by the Japanese company Fujifilm. The name is a contraction of “Velvet Media”, a reference to its smooth image structure. Velvia has very saturated colors under daylight, high contrast. These characteristics make it the slide film of choice for most nature photographers. Velvia’s highly saturated colors are, however, considered overdone by some photographers, especially those who don’t primarily shoot landscapes.

Example 3.24 Original versus Vivid filter
3.1.7.3.3 The Neon Effect

The neon filter simulates neon light along the contrast edges. The level parameter controls the lightness of the result, whereas the interaction slider determines the thickness of the neon light. With big images, the filter might eat the CPU time for a moment.

**Example 3.25** The neon filter

![Image of neon filter effect]

3.1.7.3.4 The Edge Effect

TODO

3.1.7.3.5 The Lut3D Effect

TODO

3.1.7.4 Introduction

With this filter set, you can transform an ordinary photograph into a work of art suitable for framing using distorting operations. It uses algorithms copyrighted by Pieter Voloshyn.

3.1.7.4.1 Using the filter

These are the distorting effects available:

<table>
<thead>
<tr>
<th>Type</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td>107</td>
<td></td>
</tr>
<tr>
<td><strong>Fish Eyes:</strong> warps the photograph around a 3D spherical shape to reproduce the common photograph ‘Fish Eyes’ effect.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Twirl:</strong> spins the photograph to produce a Twirl pattern.</td>
<td></td>
</tr>
<tr>
<td><strong>Cylinder Horizontal:</strong> warps the photograph around a horizontal cylinder.</td>
<td></td>
</tr>
<tr>
<td><strong>Cylinder Vertical:</strong> warps the photograph around a vertical cylinder.</td>
<td></td>
</tr>
<tr>
<td><strong>Cylinder H/V</strong>: warps the photograph around a 2 cylinders, vertical and horizontal.</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Cylinder H/V" /></td>
<td></td>
</tr>
<tr>
<td><strong>Caricature</strong>: distorts photograph with ‘Fish Eyes’ effect inverted.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Caricature" /></td>
<td></td>
</tr>
<tr>
<td><strong>Multiple Corners</strong>: splits the photograph like a multiple corners pattern.</td>
<td></td>
</tr>
<tr>
<td><img src="image3.png" alt="Multiple Corners" /></td>
<td></td>
</tr>
<tr>
<td><strong>Waves Horizontal</strong>: distorts the photograph with horizontal waves.</td>
<td></td>
</tr>
<tr>
<td><img src="image4.png" alt="Waves Horizontal" /></td>
<td></td>
</tr>
<tr>
<td>Waves Vertical: distorts the photograph with vertical waves.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>
| ![Waves Vertical](image1)

<table>
<thead>
<tr>
<th>Block Waves 1: divides the image into cells and makes it look as if it is being viewed through glass blocks.</th>
</tr>
</thead>
</table>
| ![Block Waves 1](image2)

<table>
<thead>
<tr>
<th>Block Waves 2: like Block Waves 1 but with another version of glass blocks distortion.</th>
</tr>
</thead>
</table>
| ![Block Waves 2](image3)

<table>
<thead>
<tr>
<th>Circular Waves 1: distorts the photograph with circular waves.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="Circular Waves 1" /></td>
</tr>
<tr>
<td>Effect</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td><strong>Circular Waves 2</strong></td>
</tr>
<tr>
<td><strong>Polar Coordinates</strong></td>
</tr>
<tr>
<td><strong>Unpolar Coordinates</strong></td>
</tr>
<tr>
<td><strong>Tiles</strong></td>
</tr>
</tbody>
</table>
WARNING
Some effects can take a long time to run and cause high CPU load. You can always abort an effect by pressing \texttt{Abort} button during preview rendering.

3.1.7.4.2 The Distortion filter in action

The Distortion FX dialog tool in action is available below.

3.1.7.5 Introduction

The Showfoto \textit{Emboss} filter is a quick tool to render your images in a 3-D effect. It works particularly well on images with simple structure where color is not the most important content. The filter uses the difference between colors and luminosity to convert it into a grey, moon-like landscape lit from 10 o’clock.

3.1.7.5.1 Using the Emboss filter

The \texttt{Depth} control allows to define the contrast of the filtering. A value of 30 (10\%) is the standard.

3.1.7.5.2 The Emboss filter in action

This is an example of the emboss filter. The original image is (1) and the transformed image is (2). The \texttt{Depth} applied is 10\%.
3.1.7.6 Introduction

The Showfoto Filmgrain filter is an easy tool to produce film grain on your images as known from classical high speed film material as, for example, the famous B/W KodaK Tri-X. In order to increase film sensitivity, manufacturers employed larger silver grains in the photo emulsion.

The film grain effect gives your shot a particular mood or seems to transport it in time. The treated image acquires a timeless atmosphere, detached from everyday life. If you want that gritty, art-house, street-photography grainy film look, especially in monochromatic photos, use this filter.

3.1.7.6.1 Using the Filmgrain filter

There is a slider calibrated in ISO-sensitivity to control the grain intensity and granularity. The default is set to ISO-2400, although higher values are often required. If you still want more grain, apply the filter several times.

3.1.7.6.2 The filter in action

This is an example of the film grain effect applied on a black and white image. The original image is (1) and the corrected image is (2). The film sensitivity used for simulate the film graininess is ISO-1600.
3.1.7.7 Introduction

The Showfoto Oil Paint filter gives your digital images a nice oilpainting-like look. Images of nature and still lifes are well suited for this effect.

3.1.7.7.1 Using the Oil Paint filter

There are two sliders to control the effect. The upper slider selects the Brush Size between 1 and 5. Bigger brushes are better suited for large images. Smooth controls the smoothness or, seen from the other end, the jaggedness.

3.1.7.7.2 The Oil Paint filter in action

This is an example of the oil paint filter effect. The original image is (1) and the transformed image is (2). Brush Size for this 640 pixel size image is 1, Smooth is 17.
3.1.7.8 Introduction

The Raindrops is a nice little tool to put raindrops onto your images. Naturally, it renders your image in a kind of wet look. It uses an algorithm copyrighted by Pieter Voloshyn.

3.1.7.8.1 Using the Raindrops filter

Three sliders give you control over the effect filter:

- **Drop size** obviously allows to change the size of the drops. As the drop size doesn’t automatically scale with the image size it is often necessary to reduce the size for small images.
- **Number** changes the number and density of drops.
- **Fish eye** changes the optical effect of the drops across the image.
NOTE
You can keep a zone clear of raindrops with the Showfoto Image Editor Select tool. Selecting the area to avoid (for example a face) before launching the Raindrops filter will keep it free from rain drops.

3.1.7.8.2 The Raindrops filter in action

This is an example of the raindrops filter. The original image (1) shows a quiet sunset, the transformed image (2) indicates a sunset after a thunderstorm. Default values have been used for this example.

3.2 RAW File Treatment and Color Management

3.2.1 Introduction

The point of a color-managed workflow is to ensure that the colors coming from your camera or scanner have a predictable relationship with the colors you actually photographed or scanned, that the colors displayed on your monitor match the colors coming from your camera or scanner, and that the colors you print or display on the web match the colors you produced in your digital darkroom.
3.2.1.1 Which buttons do I push?

When it comes to color management, everyone wants to know, “which buttons do I push to get the results I want”. Unfortunately, color management of necessity involves making informed choices at every step along the image-processing workflow. The purpose of this tutorial is to provide sufficient background information on color management, along with links to more in-depth information, to enable you to begin to make your own informed decisions, based on your own desired results.

3.2.1.2 Is there anyone who doesn’t need to worry about color management?

If your imaging workflow meets all six criteria listed below, then you don’t need to worry about color management.

1. You are working at a monitor properly calibrated to the sRGB color space (more about that below).
2. Your imaging workflow starts with an in-camera-produced jpeg already in the sRGB color space.
3. You work exclusively in the sRGB color space for editing.
4. Your printer wants images in the sRGB color space.
5. Your scanner produces images in the sRGB color space.
6. Your only other image output is via email or the web, where sRGB is the de facto standard.

3.2.2 More definitions about Color Management

You’ve reached the end of this tutorial on color management. We’ve “color-managed” our way all the way from the camera and the monitor, to the working space, to the printer. I’ve learned a lot and I hope you have, too. What follow is some additional comments and definitions:
Assign a profile means change the meaning of the RGB numbers in an image by embedding a new profile without changing the actual RGB numbers associated with each pixel in the image. “Convert” to a profile means embed a new profile, but also change the RGB numbers at the same time so that the meaning of the RGB values - that is, the real-world visible color represented by the trio of RGB numbers associated with each pixel in an image - remains the same before and after the conversion from one space to another.

On the other hand, every time you assign a new working space profile rather than convert to a new working space (except when initially assigning a camera profile to the image file you get from your raw processing software), the appearance of the image should more or less drastically change (usually for the worse, unless the wrong profile had previously been inadvertently embedded in the image).

In theory, you should be able to do multiple conversions of an image from one working space to another, and if you are using a color-managed image editor, even though all the RGB numbers in the image will change with each conversion, the image displayed on your screen should look the same. In actual fact, because of rounding errors upon each conversion, not to mention gamut-clipping when going from a larger to a smaller working space, every time you convert from one space to another the image degrades a bit.

Device-dependent and device-independent profiles: The camera profile, a scanner profile, your monitor’s profile, and your printer’s color profile are all device-dependent profiles - these profiles only work with the specific device for which they were produced by means of profiling. Working space profiles and the PCS’s are “device-independent”. Once an image file has been translated by LCMS via a PCS to a device-independent working space, in a sense it no longer matters what device originally produced the image. But as soon as you want to display or print the image, then the device (monitor, printer) used matters a great deal and requires a device-dependent profile.

An interpolated raw file isn’t a raw file. For some reason this simple point causes a lot of confusion. But after a raw file has been interpolated by raw processing software and then output as a tiff or jpeg, the original raw file is still a raw file, of course, but the interpolated file is just an image file. It isn’t a raw file.

Linear has two related and easily confused definitions. “Linear” can mean that the image tonality reflects the tonality in the original scene as photographed instead of being altered by the application of an S-curve or other means of changing local and global tonality. It can also mean that the gamma transfer curve of the color space is linear. An image can be “linear” in either, both, or neither of these two senses. A raw image as developed by dcraw is linear in both senses. The same image as developed by Canon’s DPP won’t be linear in either sense.

HDR and LDR do not refer to the bit-depth of the image. “High dynamic range” and “low dynamic range” refer to the total dynamic range encompassed by an image. A regular low dynamic range image, say encompassing a mere 5 “stops” (the average digital camera these days can easily accommodate 8 or 9 stops), can be saved as an 8-, 16-, 32-, or even 64-bit image, depending on your software, but the dynamic range of the image isn’t thereby increased. Only the number of discrete steps from the brightest to the darkest tone in the image has changed. Conversely, a 22-stop scene (way beyond the capacity of a consumer-oriented digital camera without using multiple exposures) can be saved as an 8- or 16-bit image, but the resulting image will exhibit extreme banding (that is, it will display extreme banding in any given tonal range that can actually be displayed on a typical monitor at one time) because of the relatively few available discrete tonal steps from the lightest to the darkest tone in the image.

In-camera produced jpegs don’t need a camera profile. All jpegs (or tiffs, if you have an older Minolta Dimage camera) coming straight out of a camera (even if produced by point-and-shoots cameras that don’t allow you to save a raw file) start life inside the camera as a raw file produced by the camera’s A to D converter. If you save your images as jpegs, then the processor inside the camera interpolates the raw file, assigns a camera profile, translates the resulting RGB numbers to a working space (usually sRGB but sometimes you can choose AdobeRGB, depending on the camera), does the jpeg compression, and stores the jpeg file on your camera card. So jpegs (or tiffs) from your camera don’t need to be assigned a camera profile which is then translated to a working space via a PCS. Jpegs from a camera are already in a working space.
Useful mathematical information if you are dealing with dcraw’s linear gamma output: Mathematically speaking, when doing a gamma transform you normalize (that is, divide by 256 if you are working with 8-bit values) the RGB numbers and raise the resulting numbers to an appropriate power depending on the respective gammas of the starting and ending color space, then renormalize the results to a new set of RGB numbers. It’s not hard, and very instructive, to do this with a calculator for a few sets of RGB numbers spaced from (0,0,0) to (255,255,255) to see how RGB numbers change from one gamma encoding to another. LCMS does this for you when you ask LCMS to convert from one color space to another. However, if ALL you are doing is converting from one color space to the same color space except for a different gamma, use imagemagick instead of LCMS and just manipulate the RGB numbers directly, then assign the new working space to the image - the results will be more accurate than going through a color space transform. 

Copyrighted and copyleft working spaces: I will take it as given that all the ordinarily encountered working spaces, such as:

1. The several variants of sRGB (see color.org).
2. BruceRGB or BestRGB.
3. The various ECI (European color initiative) working space profiles.
4. AdobeRGB, Adobe WideGamutRGB, and Kodak/Adobe ProPhotoRGB (Kodak and Adobe ProPhoto are the same, just branded differently) and their non-branded, non-copyrighted counterparts (Oyranos includes a non-branded version of AdobeRGB).

And quite a few other working spaces that could be added to this list, are all more or less suitable as working spaces. Which working space you should use depends only and solely on you, on your requirements as the editor of your digital images with your eventual output intentions (web, fine art print, etc.). However, as a critical aside, if you are using Adobe or other copyrighted working space profiles, these profiles contain copyright information that shows up in your image exif information. Lately I’ve been perusing the openicc mailing lists. Apparently LCMS can be used to produce nonbranded, copyleft working space profiles that are just the same as - actually indistinguishable from - the branded, copyrighted working space profiles. It would be a wonderful addition to Showfoto if a set of “copyleft” working space profiles, including nonbranded, relabelled versions of ProPhotoRGB, AdobeRGB, and Adobe WidegamutRGB (perhaps in two flavors each: linear gamma and the usual gamma), could be bundled as part of the Showfoto package.

3.2.3 The Color Space Connections

So the question for each RGB trio of values in the (let us assume) 16-bit tiff produced by dcraw becomes, “What does a particular trio of RGB values for the pixels making up images produced by this particular (make and model) camera really mean in terms of some absolute standard referencing some ideal observer”. This absolute standard referencing an ideal observer is more commonly called a Profile Connection Space. A camera profile is needed to accurately characterize or describe the response of a given camera’s pixels to light entering that camera, so that the RGB values in the output file produced by the raw converter can be translated first into an absolute Profile Connection Space (PCS) and then from the PCS to your chosen working space. As a very important aside, for most of the open source world (including digikam), the software used to translate from the camera profile to the PCS and from the PCS to your chosen working space and eventually to your chosen output space (for printing or perhaps monitor display) is based on lcms (the little color management engine). For what it’s worth, my own testing has shown that lcms does more accurate conversions than Adobe’s proprietary color conversion engine. Further, for almost all raw conversion programs, including commercial closed source software such as Adobe Photoshop, the raw conversion is typically based on decoding of the proprietary raw file done by dcraw. David Coffin, author of dcraw, is the hero of raw conversion - without him we’d all be stuck using the usually windows/mac only proprietary software that comes with our digital cameras. The dcraw’s interpolation algorithms (not to be confused with the
The Showfoto Handbook

The aforementioned decoding of the proprietary raw file), which are part of Showfoto if properly used, produce results equal or superior to commercial, closed source software. We in the world of Linux® and open source software are not second-class citizens when it comes to digital imaging. Far from.

There are two commonly used Profile Connection Spaces - CIELAB and CIEXYZ (see Color management, section on color translation, then look up CIELAB and CIEXYZ on wikipedia). Lcms uses the camera profile to translate the RGB values from the interpolated raw file, that is, the tiff produced by dcraw, into the appropriate Profile Connection Space (usually CIEXYZ - why CIEXYZ? I haven’t taken the time to learn). A profile connection space is not itself a working space. Rather a PCS is an absolute reference space used only for translating from one color space to another - think of a PCS as a Universal Translator for all the color profiles that an image might encounter in the course of its journey from camera raw file to final output:

1. Lcms uses the camera profile, also called an input profile, to translate the interpolated dcraw-produced RGB numbers, which only have meaning relative to your (make and model of) camera, to a second set of RGB numbers that only have meaning in the Profile Connection Space.

2. Lcms translates the Profile Connection Space RGB numbers to the corresponding numbers in your chosen working space so you can edit your image. And again, these working space numbers ONLY have meaning relative to a given working space. The same red, visually speaking, is represented by different trios of RGB numbers in different working spaces; and if you assign the wrong profile the image will look wrong, slightly wrong or very wrong depending on the differences between the two profiles.

3. While you are editing your image in your chosen working space, then lcms should translate all the working space RGB numbers back to the PCS, and then over to the correct RGB numbers that enable your monitor (your display device) to give you the most accurate possible display representation of your image as it is being edited. This translation for display is done on the fly and you should never even notice it happening, unless it doesn’t happen correctly - then the displayed image will look wrong, perhaps a little wrong, perhaps really, really, really wrong.

4. When you are satisfied that your edited image is ready to share with the world, lcms translates the working space RGB numbers back into the PCS space and out again to a printer color space using a printer profile characterizing your printer/paper combination (if you plan on printing the image) or to sRGB (if you plan on displaying the image on the web or emailing it to friends or perhaps creating a slide-show to play on monitors other than your own).

To back up a little bit and look at the first color profile an image encounters, that is, the camera profile (see (1) immediately above) - dcraw can in fact apply your camera profile for you (dcraw uses lcms internally). But (i)the generating of the tiff composed of the interpolated RGB values derived from the camera raw file, and (ii)the application of the camera profile to the interpolated file, are two very distinct and totally separable (separable in theory and practice for dcraw; in theory only for most raw converters) steps. The dcraw command line output options “-o 0 [Raw color (unique to each camera)] -4 [16-bit linear] -T [tiff]” tell dcraw to output the RGB numbers from the raw interpolation into a tiff without applying a camera input profile (the words in brackets explain the options but should not be entered at the command line). Then, if you truly enjoy working from the command line, you can use the lcms utility tifficc to apply your camera profile yourself. The advantage of doing so is that you can tell lcms to use high quality conversion (dcraw seems to use the lcms default medium). The disadvantage, of course, is that applying your camera profile from the command line adds one extra step to your raw workflow.

3.2.3.1 Where to find camera profiles

So where do we get these elusive and oh-so-necessary camera-specific profiles that we need to translate our interpolated raw files to a working color space? The UFRAW website section on
color management has a bit of information on where to find ready-made camera profiles. It’s an unfortunate fact of digital imaging that the camera profiles supplied by Canon, Nikon, and the like don’t work as well with raw converters other than each camera manufacturer’s own proprietary raw converter. Which is why Bibble and Phase One (and Adobe, but ACR hides the Adobe-made profiles inside the program code), for example, have to make their own profiles for all the cameras that they support - keep this proprietary propensity of your camera manufacturer in mind next time you buy a digital camera.

But back to finding a camera profile for your camera - the real answer (assuming you don’t find a ready-made profile that makes you happy) is to make your own camera profile or have one made for you. There are quite a few commercial services who provide profiling services (for a fee, of course). Or you can use LPRof or Argyll to profile your camera yourself. I haven’t yet walked down that road so I cannot speak about how easy or difficult the process of profiling a camera might be. But I would imagine, knowing how very meticulous the people behind Argyll, LPRof, and lcms are about color management, that making your own camera profile is very do-able and very likely the results will be better than any proprietary profile. After all, Canon (and also Bibble and Phase One for that matter) didn’t profile MY camera - they just profiled a camera like mine.

Working Spaces:

So now your raw file has been interpolated by dcraw and you’ve obtained a camera profile and used lcms tifficc to apply your camera profile to the tiff produced by dcraw (or you’ve asked dcraw to apply it for you). What does all this mean? The real answer involves a lot of math and color science that goes way over my head and likely yours. The short, practical answer is that neither the camera profile space nor the Profile Connection Space is an appropriate space for image editing. Your next step is to choose a working space for image editing. And then you (or rather the lcms color management engine that your open source digital imaging software uses) actually perform a double translation. First lcms uses the camera profile to translate the RGB values of each pixel in the dcraw-output-image-without-camera-profile-applied into the aforementioned Profile Connection Space. Then it translates the RGB values of each pixel from the PCS to your chosen working space.

Confusions and confusing terminology:

Before talking more about working spaces, some confusions and confusing terminology needs to be cleared up:

First, sRGB is both a working color space and an output color space for images intended for the web and for monitor display (if you have a spiffy new monitor with a gamut larger than the gamut covered by sRGB, obviously you might want to reconsider what output profile to use to best take advantage of your wonderful and hopefully calibrated and profiled monitor, but please convert your image to sRGB before sending it on to your friends!). sRGB is also the color space that a lot of home and mass-production commercial printers expect image files to be in when sent to the printer. It is also the color space that most programs assume if an image does not have an embedded color profile telling the program what color space should be used to interpret (translate) the RGB numbers. So if you choose to not use color-management, your color-management choices are simple - set everything to sRGB.

Second, all jpegs (or tiffs, if you have an older Minolta Dimage camera) coming straight out of a camera (even if produced by point-and-shoots cameras that don’t allow you to save a raw file) start life inside the camera as a raw file produced by the camera’s A to D converter. The processor inside the camera interpolates the raw file, assigns a camera profile, translates the resulting RGB numbers to a working space (usually sRGB but sometimes you can choose AdobeRGB, depending on the camera), does the jpeg compression, and stores the jpeg file on your camera card. So jpegs (or tiffs) from your camera NEVER need to be assigned a camera or input profile which is then translated to a working space via a PCS. Jpegs from a camera are already in a working space.

Third, in case anyone is unsure on this point, note that an interpolated raw file is no longer a raw file - it has been interpolated and then output as a tiff whose RGB values need to be translated to a working space, using the camera profile, the PCS, and lcms. Fourth (strictly for future reference), to introduce a bit of commonly heard color-management terminology here - the camera profile and your printer’s color profile are both device dependent, whereas the working space will be
device-independent - it can be used with any image, with any properly color-managed software, without regard for where the image originated.

Fifth, above I have used the words translate and translation as a descriptive metaphor for what lcms does when it translates RGB values from one color space to another via the PCS. The usual and correct terminology is convert and conversion, which I will use below. The four methods of conversion from one color space to another are: perceptual, relative colorimetric, absolute colorimetric, and saturation. Which method of conversion you should use for any given image processing step from raw file to final output image is beyond the scope of this tutorial. The standard advice is: when in doubt, use perceptual.

Sixth (and again, strictly for future reference), assign a profile means change the meaning of the RGB numbers in an image by embedding a new profile without changing the actual RGB numbers associated with each pixel in the image; convert means embed a new profile, but also change the RGB numbers at the same time so that the meaning of the RGB values - that is, the real-world visible color represented by the trio of RGB numbers associated with each pixel in an image - remains the same before and after the conversion from one space to another. You should be able to do multiple conversions of an image from one working space to another, and with a properly color-managed image editor, even though all the RGB numbers in the image will change with each conversion, the image on your screen should look the same (leaving aside the usually unnoticeable small but inevitable changes from accumulated gamut mismatches and mathematical rounding errors). However, every time you assign a new working space profile rather than convert to a new working space, the appearance of the image should more or less drastically change (usually for the worse).

Finally, (and this is a crucially important point), color management is NOT only relevant if you shoot raw. Color management affects every stage of the image processing pipeline, whether you start with a raw file that you, yourself interpolate and translate into a tiff, or if you start with a jpeg or tiff produced by your camera.

Copyrighted and copyleft working spaces:
I will take it as given that ALL the ordinarily encountered working spaces, such as:

1. The several variants of sRGB (see color.org).
2. BruceRGB.
3. The various ECI (European color initiative) working space profiles.
4. AdobeRGB, Adobe WideGamutRGB, and Kodak/Adobe ProPhotoRGB (Kodak and Adobe ProPhoto are the same, just branded differently) and their non-branded, non-copyrighted counterparts (Oyranos includes a non-branded version of AdobeRGB).
5. And quite a few others that could be added to this list are all more or less suitable as working spaces. Which working space you should use depends only and solely on YOU, on YOUR requirements as the editor of YOUR digital images with YOUR eventual output intentions (web, fine art print, etc.).

However, as a critical aside, if you are using Adobe (or other copyrighted) working space profiles, these profiles contain copyright information that shows up in your image exif information. Lately I’ve been perusing the openicc mailing lists. Apparently lcms can be used to produce non-branded, copyleft working space profiles that are just the same as - actually indistinguishable from - the branded, copyrighted working space profiles. It would be a wonderful addition to digikam if a set of “copyleft” working space profiles, including nonbranded, relabelled versions of ProPhotoRGB, AdobeRGB, and Adobe WidegamutRGB (perhaps in two flavors each: linear gamma and the usual gamma), could be bundled as part of the Showfoto package.

Which working space: gamma

Now, the next question is: which working space should I use? Wikipedia says:
The Showfoto Handbook

Working spaces, such as sRGB or Adobe RGB, are color spaces that facilitate good results while editing. For instance, pixels with equal values of RGB should appear neutral. Using a large (gamut) working space will lead to posterization, while using a small working space will lead to clipping. This trade-off is a consideration for the critical image editor.

Well, that quote from wikipedia is about as clear as mud and I don’t know if I will be able to explain it more clearly, but I will try. “[P]ixels with equal values of RGB should appear neutral” just means that for any given pixel in an image that has been converted to a suitable working space, if R=G=B you should see grey or black or white on your screen.

I am not aware of a list of other technical requirements for a suitable working space, though undoubtedly someone has produced such a list. But most working space profiles are characterized by:

1. RGB primaries which dictate the range of colors, that is, the gamut covered by a given profile.
2. White point, usually D50 or D65, which dictates the total dynamic range of the working space, from 0,0,0 (total black) to the brightest possible white.
3. Gamma.

The practical consequences that result from using different RGB primaries, leading to larger or smaller working spaces, are discussed below. The practical consequences for different choices for the working space white point are beyond the scope of this tutorial. Here I will talk a little bit about the practical consequences of the working space gamma (for an excellent article and references, look up gamma on wikipedia).

The gamma of a color profile dictates what power transform needs to take place to properly convert from an image’s embedded color profile (perhaps your working color space) to another color profile with a different gamma, such as (i) the display profile used to display the image on the screen or (ii) perhaps to a new working space, or (iii) perhaps from your working space to your printer’s color space.

Tip
Mathematically speaking, for a power transform you normalize the RGB numbers and raise the resulting numbers to an appropriate power depending on the respective gammas of the starting and ending color space, then renormalize the results to a new set of RGB numbers. Lcms does this for you when you ask lcms to convert from one color space to another; however, if ALL you are doing is a power transform, use imagemagick instead of lcms and just manipulate the RGB numbers directly - the results will be more accurate.

One practical consequence of the gamma of a working space is that the higher the gamma, the more tones are available for editing in the shadows, with consequently fewer tones available in the highlights. So theoretically, if you are working on a very dark-toned (low key) image you might want a working space with a higher gamma. And if you are working on a high key image, say a picture taken in full noon sunlight of a wedding dress with snow as a backdrop, you might want to choose a working space with a lower gamma, so you have more available tonal gradations in the highlights. But in the real world of real image editing, almost everyone uses working spaces with either gamma 1.8 or 2.2.

Some people are trying to standardize on gamma 2.0. sRGB and LStar-RGB are not gamma-based working spaces. Rather, sRGB uses a hybrid gamma, and LStar-RGB uses a luminosity-based tonal response curve instead of a gamma value - see here for more information, and then google around for more in-depth information.

In addition to gamma 1.8 and gamma 2.2 the only other gamma for a working space that gets much mention or use is gamma 1.0, also called linear gamma. Linear gamma is used in HDR (high...
dynamic range) imaging and also if one wants to avoid introducing gamma-induced errors into one’s regular low dynamic range editing. Gamma-induced errors is a topic outside the scope of this tutorial, but see Gamma errors in picture scaling, for gamma-induced color shifts.

Unfortunately and despite their undeniable mathematical advantages, linear gamma working spaces have so few tones in the shadows that (in my opinion) they are impossible to use for editing if one is working in 8-bits, and still problematic at 16-bits. When the day comes when we are all doing our editing on 32-bit files produced by our HDR cameras on our personal supercomputers, I predict that we will all be using working spaces with gamma 1; Adobe Lightroom is already using a linear gamma working space “under the hood” and Lightzone has always used a linear gamma working space.

Which working space: large gamut or small gamut

One major consideration in choosing a working space is that some working spaces are bigger than others, meaning they cover more of the visible spectrum (and perhaps even include some imaginary colors - mathematical constructs that don’t really exist). These bigger spaces offer the advantage of allowing you to keep all the colors captured by your camera and preserved by the lcms conversion from your camera profile to the really big profile connection space.

But keeping all the possible colors comes at a price. It seems that any given digital image (pictures of daffodils with saturated yellows being one common exception) likely only contains a small subset of all the possible visible colors that your camera is capable of capturing. This small subset is easily contained in one of the smaller working spaces. Using a very large working space mean that editing your image (applying curves, saturation, etc.) can easily produce colors that your eventual output device (printer, monitor) simply cannot display. So the conversion from your working space to your output device space (say your printer) will have to remap the out of gamut colors in your edited image, some of which might even be totally imaginary, to your printer color space with its much smaller gamut, leading to inaccurate colors at best and at worst to banding (posterization - gaps in what should be a smooth color transition, say, across an expanse of blue sky) and clipping (your carefully crafted muted transitions across delicate shades of red, for example, might get remapped to a solid block of dull red after conversion to your printer’s color space).

In other words, large gamut working spaces, improperly handled, can lead to lost information on output. Small gamut working spaces can clip information on input. Like Wikipedia says, it’s a trade-off. Here is some oft-repeated advice:

1. For images intended for the web, use (one of the) sRGB (variants - there are several).

2. For the most accuracy in your image editing (that is, making the most of your “bits” with the least risk of banding or clipping when you convert your image from your working space to an output space), use the smallest working space that includes all the colors in the scene that you photographed, plus a little extra room for those new colors you intentionally produce as you edit.

3. If you are working in 8-bits rather than 16-bits, choose a smaller space rather than a larger space.

4. For archival purposes, convert your raw file to a 16-bit tiff with a large gamut working space to avoid loosing color information. Then convert this archival tiff to your working space of choice (saving the converted working tiff under a new name, of course). See here for more details.

The whys of these bits of advice regarding which working space are beyond the scope of this tutorial. See Bruce Lindbloom’s excellent website (Info, Information about RGB Working Spaces) for a visual comparison of the gamut (array of included colors) of the various working color spaces. See here and here for a pro and con presentation, respectively, of the merits of using large gamut working spaces. And while you are on the cambridgeincolour.com website, check out the tutorial on color management.
3.2.3.2 Soft Proofing

Soft Proofing is a way of previewing on the screen (monitor) the result to be expected from an output on another device, typically a printer. Soft proofing will show you the difference to be expected before you actually do it (and waste your costly ink). So you can improve your settings without wasting time and money.

3.2.3.3 Rendering intention

Rendering intent refers to the way gamuts are handled when the intended target color space cannot handle the full gamut.

- **Perceptual**, also called Image or Maintain Full Gamut. This is generally recommended for photographic images. The color gamut is expanded or compressed when moving between color spaces to maintain consistent overall appearance. Low saturation colors are changed very little. More saturated colors within the gamuts of both spaces may be altered to differentiate them from saturated colors outside the smaller gamut space. Perceptual rendering applies the same gamut compression to all images, even when the image contains no significant out-of-gamut colors.

- **Relative Colorimetric**, also called Proof or Preserve Identical Color and White Point. Reproduces in-gamut colors exactly and clips out-of-gamut colors to the nearest reproducible hue.

- **Absolute Colorimetric**, also called Match or Preserve Identical Colors. Reproduces in-gamut colors exactly and clips out-of-gamut colors to the nearest reproducible hue, sacrificing saturation and possibly lightness. On tinted papers, whites may be darkened to keep the hue identical to the original. For example, cyan may be added to the white of a cream-colored paper, effectively darkening the image. Rarely of interest to photographers.

- **Saturation**, also called Graphic or Preserve Saturation. Maps the saturated primary colors in the source to saturated primary colors in the destination, neglecting differences in hue, saturation, or lightness. For block graphics; rarely of interest to photographers.

3.2.3.4 Links

- Color wiki
- CIELab
- Gamut explained

3.2.4 The Working Space

3.2.4.1 So I told Showfoto where to find my monitor profile and I have a camera profile that I applied to the image file produced by my raw processing software. What’s the next step in color management?

You need to choose a working color space so you can edit your image. LCMS will transform your image from your camera color space to your chosen working space, via the PCS specified by your camera color profile.
3.2.4.2 Why cannot I just edit my images in the color space described by the camera profile?

After all, the camera profile should provide the best “fit” to the colors recorded by my camera, as processed by my raw processing procedure, right? Wikipedia says, “Working spaces, such as sRGB or Adobe RGB, are color spaces that facilitate good results while editing. For instance, pixels with equal values of RGB should appear neutral.” “Pixels with equal values of RGB should appear neutral” just means that for any given pixel in an image that has been converted to a suitable working space, if R=G=B you should see grey or black or white on your screen. Many camera profiles violate this “neutral” condition. I am not aware of a list of other technical requirements for a suitable working space. However, I can think of another good reason why you wouldn’t want to edit your image in your camera profile color space. If you look at the size of a typical camera profile, it is on the order of a quarter to a half a megabyte or more. It’s got a lot of information about all the changes that need to be made at different regions of color and tonality in the original scene, to get accurate color rendition from the RGB values that come out of the raw processor. The camera profile is accurate (at least for colors in the original target) but not particularly mathematically smooth. Working space color profiles, on the other hand, are very small in size (half a kilobyte instead of half a megabyte) because they describe a color gamut in terms of smooth, continuous mathematical functions. Working space profiles don’t need to make allowances for the “messiness” of real world sensors, so the mathematical manipulations performed during image editing will go much more smoothly and accurately than if you try to edit your image while it is still in the camera color space.

3.2.4.3 Which working space should I choose?

Everyone has an opinion. I’m just going to lay out some of the bits of information needed to make an informed choice. Working space profiles are characterized by:

1. Gamma (or other transfer function), which dictates how much the original linear intensity values captured by the camera sensor (and subjected to the in-camera A-to-D conversion, then interpolated by the raw processing program to produce the image file) are altered to make editing easier or more precise.

2. RGB primaries which dictate the range of colors, that is, the color gamut, covered by a given profile.

3. White point (usually D50 or D65 though other values may be used), which specifies the color temperature of the white point of the working space.

3.2.4.4 What gamma should my working space have?

The gamma of a color profile dictates what power transform needs to take place to properly convert from an image’s embedded color profile (perhaps your working color space or your camera color profile) to another color profile with a different gamma, such as your chosen working space, or the display profile used to display the image on the screen or perhaps from one working space to another, or perhaps from your working space to your printer’s color space. Dcraw outputs a 16-bit image with a linear gamma, which means that a histogram of the resulting image file shows the actual amount of light that each pixel on the camera sensor captured during the exposure (paraphrasing this page). (Which is why at present applying a camera profile to the dcraw output also requires applying an appropriate gamma transform to get to the desired working space, unless the camera profile also uses gamma=1.)

One practical consequence of the gamma of a working space is that the higher the gamma, the more discrete tones are available for editing in the shadows, with consequently fewer tones available in the highlights. Changing the gamma of an image redistributes the number of tones available in the lighter and darker areas of an image. Theoretically, if you are working on a very dark-toned (low key) image you might want a working space with a higher gamma. And if you are working on a high key image, say a picture taken in full noon sunlight of a wedding dress
with snow as a backdrop, you might want to choose a working space with a lower gamma, so you have more available tonal gradations in the highlights.

Theory aside, in the real world of real image editing, almost everyone uses working spaces with either a gamma of either 1.8 or 2.2. sRGB and L*-RGB are two notable exceptions.

sRGB uses a transfer function close to that of a CRT (and thus not necessarily relevant to image editing or to display on an LCD). As Wikipedia notes, “Unlike most other RGB color spaces the sRGB gamma can not be expressed as a single numerical value. The overall gamma is approximately 2.2, consisting of a linear (gamma 1.0) section near black, and a non-linear section elsewhere involving a 2.4 exponent and a gamma (slope of log output versus log input) changing from 1.0 through about 2.3” (cited from this page), which makes for some complicated math during image processing.

L*-RGB uses as its transfer function the same perceptually uniform transfer function as the CIELab color space. “When storing colors in limited precision values” using a perceptually uniform transfer function “can improve the reproduction of tones” (cited from this page).

In addition to gamma=1.8 and gamma=2.2, the only other gamma for a working space that gets much mention or use is linear gamma, or gamma=1.0. As noted above, dcraw outputs linear gamma files if you ask for 16-bit output. Linear gamma is used in HDR (high dynamic range) imaging and also if one wants to avoid introducing gamma-induced errors into one’s regular low dynamic range editing.

“Gamma-induced errors” is a topic outside the scope of this tutorial. But see “Gamma errors in picture scaling” (cited from this page) for gamma-induced tonality shifts; and of course see Timo Autiojari’s informative (albeit somewhat infamous) website for a whole-hearted endorsement of using linear gamma working spaces (Timo’s website seems to be down at present, though archived copies of his articles are still available through google). Bruce Lindbloom mentions a commonly-encountered gamma-induced error that is caused by incorrectly calculating luminance in a nonlinear RGB working space (see this page, sidenote 1). And in a similar vein, the calculations involved in mixing colors together to produce new colors (such as using a digital filter to add warmth to an image) result in gamma errors unless the new colors are calculated by first transforming all the relevant values back to their linear values.

Unfortunately and despite their undeniable mathematical advantages, linear gamma working spaces have so few tones in the shadows that (in my opinion) they are impossible to use for editing if one is working in 8-bits, and still problematic at 16-bits. When the day comes when we are all doing our editing on 32-bit files produced by our HDR cameras on our personal supercomputers, I predict that we will all be using working spaces with gamma=1. Adobe Lightroom is already using a linear gamma working space “under the hood”, CS2 allows the option of using linear gamma for mixing colors, and Lightzone has always used a linear gamma working space.

3.2.4.5 How many discrete tonal steps are there in a digital image?

In an 8-bit image, you have 256 tonal steps from solid black to solid white. In a 16-bit image theoretically you have 65536 steps. But remember, those 16-bits started out as either 10 bits (= 1024 steps), 12 bits (= 4096 steps), or 14 bits (= 16384 steps) as produced by the camera’s A-to-D converter - the extra bits to reach 16-bits start out as just padding. The available tones are not distributed evenly from light to dark. In linear gamma mode (as the camera sensor sees things), there’s a whole lot more tones in the highlights than in the shadows. Hence the advice, if you shoot raw, to “expose to the right but don’t blow the highlights”. See Ron Bigelow’s articles on “why raw”, for a full discussion of the distribution of available tones in a raw image.

3.2.4.6 Should I use a large-gamut or a small-gamut working space?

One major consideration in choosing a working space is that some working spaces are bigger than others, meaning they cover more of the visible spectrum (and as a consequence include some imaginary colors - mathematical constructs that don’t really exist). These bigger spaces
The Showfoto Handbook

offer the advantage of allowing you to keep all the colors captured by your camera and preserved by the LCMS conversion from your camera profile to the super-wide-gamut profile connection space and out again to your chosen working space.

But keeping all the possible colors comes at a price, as explained below. And it seems that any given digital image likely only contains a small subset of all the possible visible colors that your camera is capable of capturing. This small subset is easily contained in one of the smaller working spaces (an exception requiring a larger color gamut would be a picture of a highly saturated object such as yellow daffodil).

Using a very large working space means that editing your image (applying curves, increasing saturation, etc.) can easily produce colors that your eventual output device (printer, monitor) simply cannot reproduce (you cannot see these colors while you’re editing, either). So the conversion from your working space to your output device space (say your printer) will have to remap the out-of-gamut colors in your edited image, some of which might even be totally imaginary, to your printer color space with its much smaller color gamut. This remapping process will lead to inaccurate colors and loss of saturation at best. Even worse, the remapping can easily lead to banding (posterization - gaps in what should be a smooth color transition, say, across an expanse of blue sky) and clipping (e.g. your carefully crafted muted transitions across delicate shades of red, for example, might get remapped to a solid block of dull red after conversion to your printer’s color space). Also, the experts say that 8-bit images just don’t have enough tones to stretch across a wide gamut working space without banding and loss of saturation, even before conversion to an output space. So if you choose a large gamut working space, make sure you start with a 16-bit image.

To summarize, large gamut working spaces, improperly handled, can lead to lost information on output. Small gamut working spaces can clip information on input. Medium-sized gamut working spaces try to strike a happy medium. Like Wikipedia says, it’s a trade-off.

Here are some oft-repeated bits of advice on choosing a working space:

1. For images intended for the web, use (or at least convert the final image to) sRGB.
2. For the most accuracy in your image editing (that is, making the most of your limited “bits” with the least risk of banding or clipping when you convert your image from your working space to an output space), use the smallest working space that includes all the colors in the scene that you photographed, plus a little extra room for those new colors you intentionally produce as you edit.
3. If you are working in 8-bits rather than 16-bits, choose a smaller rather than a larger working space to avoid clipping and banding.
4. For archival purposes, convert your raw file to a 16-bit tiff with a large gamut working space to avoid loosing color information. Then convert this archival tiff to your medium-gamut or large-gamut working space of choice (saving the converted working tiff under a new name, of course).

For more information on choosing a working space, see this page, Information about RGB Working Spaces for a visual comparison of the gamut (array of included colors) of the various working color spaces. See here and here for a pro- and con- presentation, respectively, of the merits of using large gamut working spaces. And while you are on the cambridgeincolour.com website, check out the tutorial on color management.

3.2.5 The sRGB color space

3.2.5.1 What is so special about the sRGB color space?

sRGB is widely accepted as a standard color profile by virtually everyone involved with consumer-oriented imaging. sRGB was proposed in 1996 by Hewlett Packard and Microsoft as a standardized color space for consumer-oriented applications. As stated in the initial HP/MS proposal:
Hewlett-Packard and Microsoft propose the addition of support for a standard color space, sRGB, within the Microsoft operating systems, HP products, the Internet, and all other interested vendors. The aim of this color space is to complement the current color management strategies by enabling a third method of handling color in the operating systems, device drivers and the Internet that utilizes a simple and robust device independent color definition. This will provide good quality and backward compatibility with minimum transmission and system overhead. Based on a calibrated colorimetric RGB color space well suited to Cathode Ray Tube (CRT) monitors, television, scanners, digital cameras, and printing systems, such a space can be supported with minimum cost to software and hardware vendors...

Currently, the ICC [International Color Consortium]... tracks and ensures that a color is correctly mapped from the input to the output color space... by attaching a profile for the input color space to the image in question. This is appropriate for high end users. However, there are a broad range of users that do not require this level of flexibility and control. Additionally, most existing file formats do not, and may never support color profile embedding, and finally, there are a broad range of uses [that] actually discourage people from appending any extra data to their files. A common standard RGB color space addresses these issues ... by merging the many standard and non-standard RGB monitor spaces into a single standard RGB color space. Such a standard could dramatically improve the color fidelity in the desktop environment. For example, if operating system vendors provide support for a standard RGB color space, the input and output device vendors that support this standard color space could easily and confidently communicate color without further color management overhead in the most common situations. (archived copy)

To summarize, the point of the by-now almost universally adopted sRGB color space was and is to make life easier for consumers (no need to worry about color management), less expensive for manufacturers (no need to worry about compatibility between consumer-level digital cameras or scanners, monitors, printers, and so forth), and more convenient for displaying images on the Internet (don’t worry about embedding and reading icc profiles - just assume sRGB).

So if sRGB works so well and makes life so easy for everyone, why use any other color space and thus be forced to worry about color management issues?

sRGB was designed to contain colors easily displayed on consumer-oriented monitors and printed by consumer-oriented printers manufactured in 1996. This least-common-denominator set of viewable and printable colors - the technical term is “color gamut” - is much smaller than the set of colors we can see in the real world, much smaller than the set of colors today’s digital cameras can capture, much smaller than the set of colors today’s printers can print, and much smaller than the color gamut of the new wide gamut monitors that are beginning to enter the consumer market. For anyone who wants to make use of the wider color gammut available today even at the consumer level, the gamut of sRGB is too small. Conversely, if you don’t intend to make use of an expanded gamut of colors at any point in your digital imaging workflow, then you don’t need to worry about non-sRGB color spaces and all the attending intricacies of color management.

3.2.5.2 How small is sRGB?

A visual representation of the limitations of sRGB compared to the colors we actually see in the real world is presented here after. It shows a two-dimensional representation of all the colors we can see (the horseshoe-shaped region) and the colors contained in the sRGB space (the smaller triangular region).
If you would like to see a two-dimensional representation of sRGB compared to some of the larger working color spaces, see Bruce Lindbloom’s excellent site, click on “Info” then on “Information About RGB Working Spaces”.

### 3.2.6 Calibrating and Profiling Your Monitor RGB

#### 3.2.6.1 If I choose to work exclusively in the sRGB color space, do I need to calibrate my monitor?

Yes! Whether you stay within the color gamut provided by sRGB or not, you need a properly calibrated monitor because sRGB assumes that your monitor is calibrated to sRGB. Your monitor calibration closes the loop. If you work within the color gamut provided by sRGB then you need to calibrate your monitor to the sRGB standard (or produce and use an accurate monitor profile, or both).

#### 3.2.6.2 What are the consequences of working with an uncalibrated monitor?

There are several possible consequences, none of them good. Every monitor, calibrated or otherwise, has a native (uncalibrated) white point, expressed as a temperature in degrees Kelvin. The white point of a monitor (calibrated or not) is the color you see when you are looking at a patch of pure white on your screen. Pure white is when the RGB values in your image all equal 255 (as expressed in 8-bits), such as the plain white background of a web page or an office document. You are thinking, “white is white” but if you were able to line up several monitors calibrated to different white points, you would see that the higher the temperature of the monitor’s white point, the bluer the screen looks in comparison with monitors with lower white points. If you can find the controls of your own monitor, change the temperature up and down (remembering to put it back to its initial setting when you are done, unless you decide you want a different white point). Your eyes, which adapt quickly to a constant white point, will easily discern the screen getting bluer and yellower as you move the white point higher and lower. If your uncalibrated monitor is too blue (native CRT color temperature is typically 9300K and sRGB assumes 6500K), as you edit your image you will overcompensate and produce images that will look yellowish and too warm on a properly calibrated monitor. Conversely, if your monitor is too yellow because the
The Showfoto Handbook

color temperature is set too low (I believe LCD native color temperature is around 5500K), your images will look blueish/too cool on a properly calibrated monitor.

Setting a proper white point is only part of monitor calibration. You also need a proper black point, brightness (luminance), and gamma (transfer) function. If your monitor is too dark because the black point is set too low, you will overcompensate and produce images that look washed out on a properly calibrated monitor. Conversely, if your monitor black point is set too high, your images will look too dark and overly saturated on a properly calibrated monitor.

If the brightness/contrast is set too high, you will assume your images have a lot more “pop” than they really have when viewed on a properly calibrated monitor, plus your eyes will hurt and your LCD screen will burn out faster.

If your monitor gamma is improperly set, your tonal variations from dark to light will be off. That is, the shadows or highlights might be overly compressed or expanded, leading you to compensate in the opposite direction. So when viewed on a properly calibrated monitor, the shadows might be too bright or dark (or the highlights too dark or bright), with the rest of the image suffering from tonal over-compression. And heaven help you if the internal R, G, and B guns (or LCD equivalent) of your monitor are improperly set (each gun has its own black point and gain), because the resulting color casts - too green, too magenta, too orange, etc. that you will inevitably create by “correcting” your image during editing - are very obvious when viewed on a properly calibrated monitor.

Whether or not your monitor is properly calibrated, you might be surprised by the results of comparing an image you’ve edited on your home monitor to the same image as displayed by other monitors in your house or on your friend’s and neighbor’s monitors. We certainly were - we have two Sony Trinitron monitors in our home, one with a failing (too high) green gun and one with a failing (too high) blue gun. Every image edited on either monitor looked very wrong on the other monitor, until we purchased a spectrophotometer to calibrate and profile both monitors. Unfortunately, at this point neither of these two monitors can be calibrated to display a proper black point, so they are no longer used for image editing - the point being that an additional benefit of using a spectrophotometer is you know when it’s time replace your monitor.

3.2.6.3 The meaning of “black point” and “brightness” seems pretty clear, but what does “gamma” mean?

See this Wikipedia article for an overview of the role of gamma in monitors and photography; the links at the bottom of the article are all excellent sources of additional information. Wikipedia says “Gamma compression, also known as gamma encoding, is used to encode linear luminance or RGB values into video signals or digital video file values; gamma expansion is the inverse, or decoding, process ... Gamma encoding helps to map data (both analog and digital) into a more perceptually uniform domain.” Yeah, I know, clear as mud. Read the Wikipedia article and study the pictures. Eventually it will sink in. If you wade very deeply into image editing and color management, eventually you will need to make decisions about what gamma (or other encoding/decoding function) you want to use when you calibrate your monitor, profile your digital camera, and choose a working color space. When in doubt (for those of you who just want to know which button to push!), gamma=2.2 is a widely-used value, both for monitor calibration and working color spaces.

3.2.6.4 What’s the difference between calibrating a monitor and profiling a monitor?

When first learning about color management, many people are confused about the difference between calibrating and profiling a monitor (I know I was). Quoting from Hal Engel’s excellent discussion in the Showfoto users forum:

Calibration is a process where a device is brought into some defined state by making adjustments to its controls or some other physical means. For example, the act of calibrating a monitor involves adjusting its white point, black level, luminosity
The Showfoto Handbook

Calibrating your monitor technically is not really part of color management. But obviously a properly calibrated and/or profiled monitor is a prerequisite for a color-managed workflow. This tutorial does not cover the important topics of how to calibrate and profile a monitor. The Argyll-CMS and LProf documentations are very good and highly recommended reading. To use either of this software to calibrate and/or profile your monitor, you will need a spectrophotometer. A spectrophotometer (sometimes called a “spider”) is a device for measuring the RGB values of color patches projected onto the monitor screen by calibration/profiling software such as Argyll and LProf. The Argyll website maintains an up-to-date list of supported spectrophotometers. I believe LProf can use all the spectrophotometers that Argyll can use, as the two programs share the relevant sections of code.

3.2.6.5 Can I calibrate my monitor without a spectrophotometer?

There are various methods given on the Internet for calibrating a monitor without using a spectrophotometer. These “eye-ball” methods are better than not calibrating your monitor at all, and depending your eyeball and your monitor, can produce quite usable results. But the eye-ball methods are not a substitute for a properly calibrated and profiled monitor. For the record, calibrating and profiling a monitor with a spectrophotometer, though intimidating at first, is not difficult. Spectrophotometers can be obtained for well under $100 US (if you opt for a more expensive model, make sure you are paying for a better piece of hardware, rather than just a more fully-featured accompanying bit of manufacturer’s software that won’t run under Linux). Argyll and/or LProf documentation will guide you through the process of calibrating and profiling your monitor, without your having to learn very much color management theory. And if/when you learn enough about color management to realize that you want or need a more detailed monitor profile of a particular type, for a particular purpose, these two softwares have all the advanced capabilities you could possibly hope for.

3.2.6.6 Assuming I’ve decided to work exclusively in the sRGB color space, what “Showfoto buttons” should I push after I calibrate my monitor?

If your monitor has been calibrated to the sRGB standard and you work exclusively in the sRGB color space, then you can disable color management in digikam. You don’t need to tell Showfoto what monitor profile to use because Showfoto defaults to using the sRGB color space as the monitor color space profile. And you don’t need to tell Showfoto to use a color-managed workflow because Showfoto defaults to using sRGB for your camera, printer, and working space, just as laid out by HP and MS back in 1996.

But if you want to take the first steps toward a color-managed workflow, then refer to corresponding page of Settings, enable color management, and select sRGB as your monitor profile, your camera profile, your working space profile, and your printer profile. If you’ve also used Argyll or LProf to produce a monitor profile after you calibrated your monitor - perhaps named
“mymonitorprofile.icc” - then tell Showfoto to use “mymonitorprofile.icc” instead of sRGB as your monitor profile.

3.2.6.7 Where are all the icc profiles are located on my computer?

Well, this is Linux® and it depends on where you put them. I put all my icc profiles in the /usr/share/color/icc folder, which is the closest there is at this moment to a standard Linux location for icc profiles. If you use this folder for your icc profiles, likely you will need to change permissions on the folder to allow your user read/write access. Then you just tell Showfoto where your profiles are located.

3.2.6.8 Does the lighting and wall/ceiling/drape/furniture colors near my monitor matter?

Yes! Good lighting is a prerequisite for proper image editing and for comparing prints to the image on your screen. If the lighting near your workstation is too bright, colors on your monitor look too dark, and conversely. If the light from the fixtures in your workroom have a low CRI (color rendering index, meaning you don’t have full spectrum bulbs), or if the light in your workroom comes from a window and so varies as the weather and time of day varies (or worse, is filtered through colored drapery), or if the walls and ceiling are creating color casts on your monitor, then your editing process will “correct” color casts that don’t really exist. Best advice, as far as is consistent with maintaining harmony in the family: neutral grey walls and ceiling, cover the windows, wear neutral clothing, set appropriate light levels using appropriate bulbs and fixtures. For more information on what are the appropriate light levels, bulbs and fixtures for editing images and viewing prints, see the following articles:

- http://www.creativepro.com/article/the-darkroom-makes-a-comeback
- http://www.creativepro.com/article/the-darkroom-makes-a-comeback-part-2-

3.2.7 The Camera Profile and Raw File Development

3.2.7.1 What’s the next step in color management?

First and for the record, many excellent professional and amateur photographers save all their images as in-camera jpegs and work exclusively in the sRGB color space. But if you want to work in a larger color space, or if you want to work with raw files (even if you output sRGB image files from your raw files), read on.

Judging from questions asked in the Showfoto user’s forum, if you are reading this tutorial you probably are shooting raw images with a digital dSLR and you are hoping that somewhere in the arcane waters of color management lies the answer to how to get a nice picture from your raw image file. And you’re right! The next thing you need is the right camera profile for developing your raw image. But first let’s answer the question you really might have been asking.

3.2.7.2 Why doesn’t the image produced by raw converters like dcraw or ufraw look like the embedded preview displayed by digikam?

Glad you asked. All digital camera images start out as raw files, whether or not the camera allows the user the option to save the image as a raw file. When you ask the camera to save jpegs instead of raw files, the camera uses its on-board processor to convert the raw file to a jpeg. That embedded preview is what your final image would have looked like if you had set your camera to save jpegs instead of raw files.
From here I will speak from my experience as a Canon user, but I will guess that most or all entry-level and mid-range dSLRs behave in a similar manner. Canon offers the user several picture styles - neutral, standard, portrait, landscape, and so forth - that determine what kind of processing will be done to the raw image file to produce the final image, whether or not the processing is done “in-camera” or later, using the proprietary Canon DPP software. The Canon DPP raw processing software does give the user additional control, but still manipulates the raw image file in accordance with the chosen picture style. Most of the Canon picture styles add a heavy S-curve and extra color saturation to give the picture more “pop”. Even if you choose the “neutral” picture style (the Canon picture style that gives you the least modified tonality); and select “less contrast”, “less saturation”, “no noise reduction”, and “no sharpening” in the DPP raw development dialog, you will find, if you know what to look for, that an S-curve and also shadow denoising has been applied to your image.

Libraw (which Showfoto uses to convert raw files to image files) doesn’t add an S-curve to your image tonality. Libraw gives you the lights and darks that are actually recorded by the camera sensor. According to Tindeman, an excellent read and source of good advice, with links to equally good sources of additional information, dcraw is one of only a handful of raw developers that actually gives you the “scene-referred” tonality. Ufraw also produces a scene-referred image by default (although ufraw gives the user the option to modify the scene-referred image by changing the tonal distribution and saturation). And the dcraw/ufraw scene-referred image is flat-looking, because the camera sensor records light linearly, whereas our eyes are constantly interacting with our brain to accommodate dim and bright areas in a scene, meaning our brain to some extent “applies an S-curve” to the scene to enable us to better focus in on the areas of particular interest as we look around.

3.2.7.3 The embedded jpeg preview looks so much nicer than dcraw’s output. What is the value in scene-referred tonality?

When you take a picture, presumably you have an idea of what you want the final image to look like. It is much easier to achieve that final image if you don’t have to “undo” stuff that has already been done to your image. Once Canon (or Nikon, or Bibble, etc.) has applied their proprietary S-curves and shadow-denosing, sharpening, etc. to your image, then your shadows, highlights, edge detail, etc. are already squashed, clipped, chopped, and otherwise altered and mangled. You’ve thrown information away and you cannot get it back. Especially in the shadows, even with 16-bit images (actually, 12- or 14-bits, depending on the camera, but it’s encoded as 16-bits for the computer’s convenience), there just isn’t that much information to begin with.

It seems to me that the heart and soul of image processing is the deliberate manipulation of image tonality, color, selective sharpening, and so forth, such that the viewer focuses in on what you, the photographer, found of particular interest when you took the picture. Why give the art of image processing over to some proprietary raw processing software? In other words, “flat is good” if you’d rather give your images your own artistic interpretation. The alternative is to let the canned, proprietary algorithms produced by Canon, Nikon, Bibble, etc. interpret your images for you. (On the other hand, there is no denying that for many images, those canned algorithms are really pretty good!)

3.2.7.4 I can see the value in starting my image-editing with a scene-referred rendition instead of the eye-popping rendition that I see in the embedded jpeg. But I’m telling you, the images produced by digiKam/libraw look really really bad! Why?

Well, that depends. If the image looks very dark, then you asked dcraw to output a 16-bit file and you have run into a problem with dcraw not applying a gamma transform before outputting the image file. You can use imagemagick to apply the appropriate gamma transform to the image file produced by Libraw. Or you can find or make a camera profile with a gamma of 1. Or you can use ufraw, which applies the gamma transform for you.

If your image has pink highlights, there’s a solution. For an explanation of the problem, along with the command line cure for this problem, see this “Luminous Landscape” forum post.
The Showfoto Handbook

If the image isn’t dark but it looks really weird, probably you made some injudicious choices in the Libraw user interface. The Libraw interface conveniently allows you to “dial in” options that you would otherwise have to specify at the command line. However, convenience always comes at a price. First, the interface might not provide access to all the options that are available at the command line. And second, to get the most from the Libraw interface, you have to know what the buttons, sliders, etc. in the interface actually do. Which means you need to know what happens at the command line if you want to get the best results from using the interface. (This tutorial will not attempt to document how to use the Libraw user interface. Digikam is developing at a rapid pace and anything I might write about the Libraw interface will surely be outdated in the near future.)

For example, if your embedded jpeg has very nice deep rich shadows but the Libraw-produced jpeg or tiff has blotchy red line patterns in the shadow areas, then you probably put an “x” in the “Advanced, Black point” option, with the slider set to 0. Uncheck the Black point box and try again. This box in the Libraw interface corresponds to the “-k” option when using dcraw at the command line. The “-k” option allows you to override dcraw’s best estimate of where, in the shadow tones of your image, does digital signal start to override background noise. If you don’t use the “-k” option at the command line, then dcraw calculates an appropriate value for you, based on its estimate of background noise. For my Canon 400di, the dcraw-calculated background noise value is usually around 256 (the command line option “-v” will tell dcraw to tell you what it’s doing as it processes your raw file). If, however, I use the “-K /path to blackframe.pgm” option to tell dcraw to subtract out a black frame, then dcraw will report the black point as “0”, as there is now no need to set it higher to avoid the deepest shadows in the image, where noise typically drowns out signal. (A “black frame” is an exposure taken with the lens cap on, with the same exposure settings as, and ideally right after, taking the image being processed. The “-K” option allows dcraw to subtract background noise from the image.)

3.2.7.5 Where do I find good information on digital noise?

See the following excellent articles:


3.2.7.6 Why are the Canon and Nikon colors better than the colors produced by Libraw?

Color rendition is one place where the Canon (and presumably Nikon) proprietary raw developing software does a really, really good job. Why? Because the proprietary raw processing software is coupled with camera profiles that are specific to raw images coming from your make and model of camera, when processed using your make and model camera’s proprietary raw processing software. I’ve checked extensively, using an “eyedropper” to compare the output of various raw developers using various camera profiles from various sources - a very tedious though instructive process. With ufraw and dcraw (from the command line if not from digikam’s dcraw user interface), you can apply Canon’s camera-model-picture-style-specific color profile(s) to the dcraw output during the raw development process, and the colors will still NOT be exactly the same as what Canon produces. Likewise, Bibble profiles work pretty well with the Bibble software, but they don’t work quite as well, in my opinion, with Libraw as they do with Bibble’s own software. And so on. And so forth.

3.2.7.7 Why is a camera profile specific to a given make and model of camera?

Digital cameras have an array of millions of little light sensors inside, making up either a CCD or a CMOS chip. These light-sensing pixels are color-blind - they only record the amount, not
the color, of light falling on them. So to allow pixels to record color information, each pixel is
capped by a transparent red, green, or blue lens, usually alternating in what is called a Bayer
array (except for Faveon sensors, which work differently). A raw image is nothing more than an
array of values indicating “how much light” passed through the red, blue, or green lens cap to
reach the sensor.

Clearly, pixel response to light is the result of lots of camera-specific factors including: the nature
of the sensor array itself, the precise coloring/transmissive qualities of the lens caps, and the
particular analog-to-digital conversion and post-conversion processing that happens inside the
camera to produce the raw image that gets stored on the card.

3.2.7.8 What does “analog-to-digital conversion” mean?

“Analog” means continuously varying, like how much water you can put in a glass. “Digitizing”
an analog signal means that the continuously changing levels from the analog signal source are
“rounded” to discrete quantities convenient to the binary numbers used by computers. The
analog-to-digital conversion that takes place inside the camera is necessary because the light-
sensing pixels are analog in nature - they collect a charge proportionate to the amount of light
that reaches them. The accumulated charge on each pixel is then turned into a discrete, digital
quantity by the camera’s analog-to-digital converter. Which by the way explains why a 14-bit
converter is better than a 12-bit converter - more precision in the conversion output means less
information is thrown away in the conversion process.

3.2.7.9 Why is a camera profile specific to the raw processing program used to develop the
raw file?

The whole point of interpolation using demosaicing algorithms such as dcraw’s default AHD
is to guess what color and intensity of light actually fell on any given pixel by interpolating
information gathered from that single pixel plus its neighboring pixels (see Wikipedia article).
Every raw processing program makes additional assumptions such as “when is it signal and
when is it background noise?”, “at what point has the sensor well reached full saturation?”,
and so forth. The resulting output of all these algorithms and assumptions that raw processing
software makes is a trio of RGB values for each pixel in the image. Given the same raw file,
different raw processors will output different RGB values.

3.2.7.10 Where do I find a generic profile for my camera?

The ufraw website section on color management has information on where to find ready-made
camera profiles. If you poke around the Showfoto users forum archives, you’ll find additional
advice. If you keep hunting and experimenting, likely you will find a generic profile that works
“well enough”. However, as stated above, it’s an unfortunate fact of digital imaging that the
camera profiles supplied by Canon, Nikon, and the like don’t work as well with raw converters
other than each camera manufacturer’s own proprietary raw converter. Which is why Bibble and
Phase One, for example, have to make their own profiles for all the cameras that they support. So
eventually you may decide that you want a camera profile that is specific to your camera, your
lighting conditions, and your raw processing workflow.
3.2.7.11  How do I get a camera profile specific to my camera, lighting conditions, and raw workflow?

Many commercial services provide profiling services, for a fee, of course. Or you can use LProf to profile your camera yourself. If you want to profile your own camera, you will need an “IT8 target”, that is, an image containing squares of known colors. Along with the IT8 target, you will receive the appropriate set of known values for each square of color on the target.

If you plan to use LProf to profile your camera, check the documentation for a list of recommended targets. To profile your camera, you photograph the IT8 target under specified lighting conditions (for example, in daylight, usually taken to mean noon on a sunny day in the summer, with nothing nearby that might cast shadows or reflect color casts) and save the image as a raw file. Then you process the raw file using your particular raw processing software+settings and run the resulting image file through the profiling software. The profiling software compares the RGB values in the image produced by your camera+lighting conditions+raw processing routine with the RGB values in the original target and then produces your camera (icc) profile.

Profiling a camera is exactly analogous to profiling a monitor. When profiling a monitor, the profiling software tells the graphics card to send squares of color with particular RGB values to the screen. The spectrophotometer measures the actual color that is produced on the screen. When profiling a camera, the known colors are the RGB colors in the original patches on the IT8 target, which the profiling software compares to the colors produced by the digital image of the target, which was photographed in selected lighting conditions, saved as raw, then processed with specific raw processing software plus settings.

Here is a link to a “how to” for using LProf v1.11 and ufraw (and by analogy, any other raw processor) to produce a camera profile. Debian Lenny has LProf 1.11.4 in the APT repositories. More recent versions can be built from CVS. And here is a link to an affordable, well-regarded IT8 target.

3.2.7.12  How do I apply a camera profile to the 16-bit image file produced by my open source raw processing software?

If you are using the Libraw interface, here is how to tell Showfoto which camera profile to use. If you are using dcrave from the command line, you have the choice of outputting your 16-bit image...
image file with or without the camera profile already applied. If you ask dcrw to output the
file without applying the camera profile, you can use LCMS’s tifficc utility (also at the command
line) to apply the camera profile. The advantage of using tifficc is that you can tell LCMS to use
high quality conversion (dcrw seems to use the LCMS default medium). The disadvantage, of
course, is that applying your camera profile from the command line adds one extra step to your
raw workflow. If you are using ufraw, consult the ufraw user’s guide.

3.2.8 The Profiles Point to Real Colors in the Real World

3.2.8.1 Camera, scanner, working space, monitor, printer - what do all these color profiles
really do?

A color profile describes the color gamut of the device or space to which it belongs by specifying
what real color in the real world corresponds to each trio of RGB values in the color space of the
device (camera, monitor, printer) or working space.

The camera profile essentially says, “for every RGB trio of values associated with every pixel in
the image file produced from the raw file by the raw processing software, “this RGB image file
trio” corresponds to “that real color as seen by a real observer in the real world” (or rather, as
displayed on the IT8 target if you produced your own camera profile, but it amounts to the same
thing - the goal of profiling your camera is to make the picture of the target look like the target).

You cannot see an image by looking at its RGB values. Rather you see an image by displaying
it on a monitor or by printing it. When you profile your monitor, you produce a monitor profile
that says “this RGB trio of values that the graphics card sends to the screen” will produce on the
screen “that real color as seen by a real observer in the real world”.

What the monitor profile and the camera profile have in common is the part (in italics above)
about “that real color as seen by a real observer in the real world.” Different trios of RGB numbers
in, respectively, the monitor and camera color spaces point to the same real, visible color in the
real world. Real colors in the real world provide the reference point for translating between all
the color profiles your image will ever encounter on its way from camera to screen to editing
program to print or the web.

3.2.8.2 How can a color profile point to a real color in the real world?

Real people don’t even see the same colors when they look at the world, do they?

A long time ago (1931, although refinements continue to be made), the International Color Con-
sortium decided to map out and mathematically describe all the colors visible to real people
in the real world. So they showed a whole bunch of people a whole bunch of colors and asked them
to say when “this” color matched “that” color, where the two visually matching colors were in
fact produced by differing combinations of wavelengths. What was the value of such a strange
procedure? Human color perception depends on the fact that we have three types of cone re-
ceptors with peak sensitivity to light at wavelengths of approximately 430, 540, and 570 nm, but
with considerable overlap in sensitivity between the different cone types. One consequence of
how we see color is that many different combinations of differing wavelengths of light will look
like “the same color”.

After extensive testing, the ICC produced the CIE-XYZ color space which mathematically de-
scribes and models all the colors visible to an ideal human observer (“ideal” in the sense of
modeling the tested responses of lots of individual humans). This color space is NOT a color pro-
file in the normal sense of the word. Rather it provides an absolute “Profile Connecting Space”
(PCS) for translating color RGB values from one color space to another. (See here and here.)

CIE-XYZ is not the only PCS. Another commonly used PCS is CIE-Lab, which is mathematically
derived from the CIE-XYZ space. CIE-Lab is intended to be “perceptually uniform”, meaning “a
change of the same amount in a color value should produce a change of about the same visual
importance” (cited from Wikipedia article). Wikipedia says “The three coordinates of CIELAB
represent the lightness of the color (L* = 0 yields black and L* = 100 indicates diffuse white; specular white may be higher), its position between red/magenta and green (a*, negative values indicate green while positive values indicate magenta) and its position between yellow and blue (b*, negative values indicate blue and positive values indicate yellow)” (cited from Wikipedia article).

To be useful, color profiles need to be coupled with software that performs the translation from one color space to another via the PCS. In the world of Linux® open source software (and also many closed source, commercial softwares), translation from one color space to another usually is done by LCMS, the “little color management software”. For what it’s worth, my own testing has shown that LCMS does more accurate color space conversions than Adobe’s proprietary color conversion engine.

3.2.9 Printer Profiles with Rendering Intents and Soft-Proofing

3.2.9.1 Where do I get a printer profile?

Whew! We’ve come a long way - almost ready to print that image! Where do I get a printer profile? Well, you already know the answer. You can use the generic profile that comes with your printer. You can purchase a professionally produced profile. If you ask, some commercial printing establishments will send you their printer profiles (which won’t work with your printer!). You can make your own printer profile using Argyll, in which case your profile can be tailored to your particular paper, inks, and even image characteristics (if you are printing a series of images with a color palette limited to subdued browns, you don’t need a printer profile that tries to make room for saturated cyans and blues). I cannot offer any more advice or links to more information on this subject because I’ve just started to learn about printing images (previously I’ve only viewed and shared my images via monitor display). But do see this page for an excellent presentation of the benefits of producing your own printer profile, plus a resoundingly positive endorsement of using Argyll for making your printer profile.

3.2.9.2 What about rendering intents?

“Rendering intent” refers to the way color gamuts are handled when the intended target color space (for example, the monitor or the printer) cannot handle the full gamut of the source color space (for example the working space).

There are four commonly-used rendering intents: perceptual, relative colorimetric, absolute colorimetric, and saturation. I have searched the Internet looking for the best write-up on rendering intents and the trade-offs involved in choosing one rendering intent over another. I believe I found that article. See this page. Briefly quoting from the Cambridge in Color article on color space conversion:

Perceptual and relative colorimetric rendering are probably the most useful conversion types for digital photography. Each places a different priority on how they render colors within the gamut mismatch region.

Relative colorimetric maintains a near exact relationship between in gamut colors, even if this clips out of gamut colors.

In contrast, perceptual rendering tries to also preserve some relationship between out of gamut colors, even if this results in inaccuracies for in gamut colors...

Absolute is similar to relative colorimetric in that it preserves in gamut colors and clips those out of gamut, but they differ in how each handles the white point... Relative colorimetric skews the colors within gamut so that the white point of one space aligns with that of the other, while absolute colorimetric preserves colors exactly (without regard to changing white point)... Saturation rendering intent tries to preserve saturated colors.
I would quote the entire article (it’s that good), but that would involve "unfair usage" I am sure. So go check out the article for yourself. The illustrations in the article really help to clarify what the different rendering intents actually do and the compromises involved in choosing one rendering intent over another.

For another excellent source of information on rendering intents with accompanying illustrations, see this page.

3.2.9.3 What rendering intent should I use for displaying images on my monitor?

The usual choice is relative colorimetric. I would suggest that you not use absolute colorimetric (e.g. with ufraw) unless you want very strange results.

3.2.9.4 What is soft-proofing?

Soft-proofing will show you the differences to be expected between what you see on your screen and what you will see when you make a print. To soft-proof, you need a profile for your printer (actually, for your printer-paper combination, as the paper used affects the ink colors and the white point). If you don’t like the soft-proofed image, you can make changes (in your working space, not after converting the image to your printer space!) to bring the soft-proofed image more in line with how you want the final print to look.

3.2.9.5 What rendering intent should I use when I soft-proof?

I’ve always heard that you ought to use "perceptual intent" when transforming an image from a larger working space to a smaller printer space. But especially in light of reading the afore-mentioned Cambridge in Color article, it seems that perceptual intent may or may not give the best results, depending on the respective gamuts of the image and printer/paper combination in question. I’ve been experimenting quite a bit lately with output intents for printing. I find that for my images, the colorimetric intents give clearer, brighter colors, albeit at the cost of having to carefully re-edit the image to avoid clipping highlights and shadows. Perusal of the various photography forums and articles available on the Internet indicates that "perceptual intent" is just an option, not by any means always "the best" option.

3.2.9.6 And what about black point compensation?

The clearest definition I could find about black point compensation is as follows: "BPC is a way to make adjustments between the maximum black levels of digital files and the black capabilities of various digital devices [such as a printer]" (cited from this page).

The article from which this definition comes offers a very clear explanation (albeit Adobe-centric) of how black point compensation works and the practical consequences of using or not using it. The bottom line advice is, it depends. Try soft-proofing with black point compensation on. If you like it, use it. Otherwise, don’t use it.

3.2.9.7 Can all of the rendering intents be used when converting from one color space to another?

In a word, no. Which rendering intents are available when converting from one profile to another depends on the destination profile. Not every profile supports every rendering intent. What happens when you select an unsupported rendering intent is that LCMS quietly uses the profile’s default rendering intent.

For an informative and humorous discussion of myths surrounding the use of various rendering intents, see here and here.
3.2.9.8 Why does the perceptual rendering intent get recommended so often as the “photographic” rendering intent?

It’s a safe choice because it prevents clipping of shadows and highlights, although possibly at the expense of desaturating all your colors. So if you don’t want to bother doing any soft-proofing, choose the perceptual rendering intent (if you don’t want to soft-proof, probably you should also stick with sRGB).

3.3 Showfoto Configuration

3.3.1 Introduction

Showfoto tries to give you as much control over how it works as possible. There are many options that change the behavior of the application. To access these settings select Settings → Configure Showfoto... from the menubar. The configuration dialog is separated by categories displayed in separated pages. You can change between these pages by clicking on the icons on the left-hand side of the dialog.

3.3.2 Tooltip Settings

This setup page covers all options of information appearing when the mouse hovers over a file icon in the Image Area. According to the checked options they will be shown or not.

See below an example of the information displayed in a tooltip over an icon with the relevant settings done in the configuration page.
3.3.3 Metadata Settings

3.3.3.1 Introduction

Image files can have some metadata embedded into the image file format. These metadata can be stored in a number of standard formats as JPEG, TIFF, PNG, JPEG2000, PGF, and RAW files. Metadata can be read and written in the EXIF, IPTC, and XMP formats if they are present in the file.

3.3.3.2 Behavior Settings

3.3.3.2.1 Rotate Actions

Show images/thumbnails rotated according to orientation tag: this will use any orientation information that your camera has included in the EXIF information to automatically rotate your photographs so that they are the correct way up when displayed. It will not actually rotate the image file, only the display of the image on the screen. If you want to permanently rotate the image on file, you can click with the right mouse button on the thumbnail and select Auto-rotate/flip according to EXIF orientation. The image will then be rotated on disk and the tag will be reset to “normal”. If your camera routinely gets this orientation information wrong you might like to switch this feature off.

Set orientation tag to normal after rotate/flip: the Auto Rotate option automatically corrects the orientation of images taken with digital cameras that have an orientation sensor. The camera adds an orientation tag to the image’s EXIF metadata. Showfoto can read this tag to adjust the image accordingly. If you manually rotate an image, these metadata will be incorrect. This option will set the orientation tag to “Normal” after an adjustment, assuming that you rotated it to the correct orientation. Switch this off if you don’t want Showfoto to make changes to the orientation tag, when you rotate or flip the image.

3.3.3.3 Metadata Filters

For each Metadata viewers available in metadata sidebar tab, you can customize which tab can be visible or not when you switch metadata tags list-view in filter mode. Exif, Makernotes, Iptc, and Xmp tags managed by Exiv2 shared library in background are listed in these filters list and the tags selection will be saved by Showfoto. To help you to choose the right tags to filter, a search engine is provided on the bottom of lists. For each tag, a helper description is provided. Three buttons permit to Clear current selection, Select All tags from the list, or only the Default list grouping the most common tags to use while photographs review.

NOTE
Remember that from metadata sidebar tab, you can switch from one photo to another with the same active tags filter to quick compare embedded information from files.
The Showfoto Handbook

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBRedLevel</td>
<td>WB red level</td>
</tr>
</tbody>
</table>

**Photograph Information**

- **ApertureValue**: The lens aperture. The unit is the APEX value.
- **BodySerialNumber**: This tag records the serial number of the body of the camera that was used to take the picture.
- **BrightnessValue**: The value of brightness. The unit is the APEX value. Ordinarily it is given in the context of the light source.
- **CFAPattern**: Indicates the color filter array (CFA) geometric pattern of the image.
- **CameraOwnerName**: This tag records the owner of a camera used in photography as an APEX value.
- **ColorSpace**: The color space information tag is always recorded as the color space...
- **ComponentsConfiguration**: Information specific to compressed data. The channels of each component...
- **CompressedBitsPerPixel**: Information specific to compressed data. The compression mode used...
- **Contrast**: This tag indicates the direction of contrast processing applied by the device.
- **CustomRendered**: This tag indicates the use of special processing on image data, such as sharpening.
- **DateTimeOriginal**: The date and time when the original image data was generated. For example, it is used to determine the age of the image.
- **DateTimeDigitized**: The date and time when the image was stored as digital data.
- **DeviceSettingDescription**: This tag indicates information on the picture-taking conditions of a device.
- **DigitalZoomRatio**: This tag indicates the digital zoom ratio when the image was shot. If there is no digital zoom, it is set to 1.
- **ExifVersion**: The version of this standard supported. Nonexistence of this field is also possible.
- **ExposureBiasValue**: The exposure bias. The units are the APEX value. Ordinarily it is given as a number.
- **ExposureIndex**: Indicates the exposure index selected on the camera or input device.

**SuperimposedDisplay**

- **SuperimposedDisplay**: Superimposed display

**Canon Cs**

- **AESetting**: AE setting
- **AFPoint**: AF point selected
- **ColorTone**: Color tone
- **Contrast**: Contrast setting
- **DigitalZoom**: Digital zoom
- **DisplayAperture**: Display aperture
- **DriveMode**: Drive mode setting
- **EasyMode**: Easy shooting mode
- **FlashActivity**: Flash activity
- **FlashDetails**: Flash details
- **FlashMode**: Flash mode setting
- **FocalUnits**: Focal units
- **FocusContinuous**: Focus continuous setting
- **FocusMode**: Focus mode setting
- **FocusType**: Focus type setting
- **ISOspeed**: ISO speed setting
3.3.4 Editor Settings

3.3.4.1 Editor Window Settings

By default the Image Editor will use a black background behind photographs when they are displayed. If you prefer a different background color you can choose one here. You can also turn off the ToolBar when the Image Editor is in full screen mode.
Over and underexposed areas of an image can be indicated by dark and light marker colors that can be defined here. In the editor this viewing mode can be switched on and off with F10 and F11 respectively. The thresholds for over- and under-exposure can be set by the adjustment bars “... percents”. Check **Indicate exposure as pure color** if you want only pure black (RGB 0,0,0) indicated as under-exposure and only pure white (RGB 8 bit 255,255,255 respectively RGB 16 bit 65535, 65535, 65535) indicated as over-exposure.

### 3.3.4.2 Save Image Options

When changes are made to JPEG files and they are saved back to the hard disk the JPEG file must be re-encoded. Each time a JPEG file is encoded a decision must be made on the level of quality that is to be applied. Unfortunately the level of quality applied is not recorded in the image file. This means that the Image Editor cannot use the same quality ratio when saving an altered image as was used for the original image. You can change the default level of quality that the Image Editor will apply when it saves altered images by moving the **JPEG quality** slider (1: low quality / 100: high quality and no compression). At the time of writing, metadata is supported.

Chroma subsampling is the practice of encoding images by implementing more resolution for luminance information than for color information. Please read this Wikipedia article for a full explanation.
With **PNG compression** option, you can reduce PNG image files size. This operation does not reduce image quality because PNG uses a lossless algorithm. The only effect is that image data needs more time to compress/decompress. If you have a fast computer you can change this value to use a high compression factor (1: low compression / 9: high compression). At the time of writing, metadata is supported.

With **Compress TIFF** option, you can toggle to use Deflate compression algorithm with TIFF image files. This will reduce TIFF image files sizes. It has no image quality effect because Deflate is a lossless algorithm. At the time of writing, metadata is supported.

With the **LossLess JPEG 2000 files** option allows for lossless storage, or, if the lossy options is selected, even then the quality for comparative files size is much better than normal JPEG. At the time of writing, metadata is supported.

With the **LossLess PGF files** option allows for lossless storage, or, if the lossy options is selected, even then the quality for comparative files size is much better than normal JPEG-2000. At the time of writing, metadata is supported.

### 3.3.4.3 Image Versioning Settings

Non-Destructive Editing and Versioning gives you the freedom of editing your images, trying out whatever you want without worrying that you might regret later what you did. Showfoto takes care of the original and every important intermediate step if you want.
In the checkbox at the top you can enable or disable Non-Destructive Editing and Versioning.

In the first field you can choose the file format used for saving the intermediate steps and the final result. Remember that JPEG - like in the screenshot above - is a lossy format. So if you need to start over from an intermediate step it wouldn't be really non-destructive. If you can afford it in terms of space on the harddisk and loading/saving speed you better choose a lossless format like PNG or PCF for instance. Please click the information button on the right side for more detailed information.

In the next field you can decide whether the editor will save changes automatically on exit or should ask first.

In the third field you decide on which occasions you want the editor to save intermediate steps. Please click the information button on the right side for more detailed information.

In the last field you can adjust whether you want only the last version to be shown in the Image View (default, none of the boxes checked) or if you also want to see icons of the original version and/or intermediate steps.

### 3.3.4.4 RAW Decoding Settings

In the early versions of Showfoto the Image Editor was just a viewer for photographs, but it is rapidly developing into a very useful photo manipulation tool. This dialog allows you to control how the Image Editor will behave when opening RAW files.

*Fast and simple, as 8 bit image*
RAW files will be decoded to 8-bit color depth with a BT.709 gamma curve and a 99th-percentile white point. This mode is faster than 16-bit decoding. In 8-bit mode only the **Auto Brightness** setting will be taken into account (dcraw limitation).

**Use the default settings, in 16 bit**

If enabled, all RAW files will be decoded to 16-bit color depth using a linear gamma curve and according to the settings in the **RAW Default Settings** tab. To prevent dark image rendering in the editor, it is recommended to use Color Management in this mode.

**Always open the Raw Import Tool to customize settings**

With this option checked the Raw Import Tool will open at the Right Side Bar in the Image Editor so that you can set individual parameters for every image you open.

### 3.3.4.5 RAW Default Settings

Demosaicing

A **demosaicing** algorithm is a digital image process used to interpolate a complete image from the partial raw data received from the color-filtered image sensor internal to many digital cameras in form of a matrix of colored pixels. Also known as CFA interpolation or color reconstruction.

**Interpolate RGB as four colors**

The default is to assume that all green pixels are the same. If even-row green pixels of the CCD sensor are more sensitive to ultraviolet light than odd-row this difference causes a mesh pattern in the output; using this option solves this problem with minimal loss of detail. To resume, this option blurs the image a little, but it eliminates false 2x2 mesh patterns with VNG quality method or mazes with AHD quality method.

**Do not stretch or rotate pixels**

**Todo**

**Quality:**

TODO Showfoto and Dcraw offer us three alternatives: bi-linear, VNG interpolation, AHD interpolation. It seems that **AHD interpolation** (for Adaptive Homogeneity-Directed) is the best choice.
for quality according to some test that I have performed and the paper of the person that implemented it. \textit{VNG interpolation} (Variable Number of Gradients) was the first algorithm used by Dcraw but suffers from color artifacts on the edge. \textit{Bilinear} is interesting if you are looking for speed with a acceptable result.

\textbf{Pass:}
TODO

\textbf{Refine interpolation}

This option is available only for DCB and VCD/AHD. TODO

\textbf{White Balance Method}

Four options are available here: Default D65, Camera, Automatic and Manual. ‘Default D65’ reflects normal daylight conditions. ‘Camera’ uses the camera’s custom white-balance settings if set. ??? ‘Automatic’ The default is to use a fixed color balance based on a white card photographed in sunlight. ??? ‘Manual’ will adjust colors according to the T(K) (color temperature in degrees Kelvin) and Green settings. TODO

\textbf{Highlights}

This is the story of the three highlight options, courtesy of Nicolas Vilars:

Default is here to consider highlights (read: part of your images that are burned due to the inability of your camera to capture the highlights) as plain / solid white (\textbf{solid white} option). You can get some fancy results with the \textbf{unclip} option which will paint the highlights in various pinks. At last you can try to consider recovering some parts of the missing information from the highlights (\textbf{reconstruct} option).

This is possible because the blue pixels tends to saturate less quickly than the greens and the reds. Showfoto/dcraw will try to reconstruct the missing green and red colors from the remaining none saturated blue pixels. Of course here everything is a question of tradeoff between how much color or white you want.

If you select \textbf{Reconstruct} as the option, you will be given the choice to set a level. A value of 3 is a compromise and can/should be adapted on a per image basis.

\begin{Verbatim}
\textbf{NOTE}
A small warning here, for the few curious that have read the man pages of Dcraw, the author says that 5 is the compromise, 0 is solid white and 1 unclip. This is because in Showfoto 0 and 1 are the “solid white” and “unclip” options in the drop down menu (if you select these, the level slider will be grayed out). Therefore, the slider in Showfoto with the “reconstruct” option will let you choose between 0 to 7 (instead of 0 to 9 in Dcraw command line) where 3 is the compromise instead of 5 in “native” Dcraw command line tool.
\end{Verbatim}

\textbf{Exposure Correction (E.V)}

TODO

\textbf{Correct false colors in highlights}

TODO

\textbf{Auto Brightness}

TODO

\textbf{Corrections}

\textbf{Noise Reduction}

TODO While demosaicing your image you can additionally ask for noise reduction (at a slight speed penalty). This option applies a noise reduction algorithm while the image still is in CIE Lab color space. Because the noise is only applied to the Luminosity layer (the “L” of the Lab), it
The Showfoto Handbook

should not blur your image as traditional noise reduction algorithms do in RGB mode. So, if you converted an image from RAW and it appears noisy, rather than applying a denoiser, go back and re-convert with this option enabled. The defaults are: Threshold = 100. Higher values will increase the smoothing, lower will decrease smoothing.

Enable chromatic aberration (CA) correction

If you know the CA of your lenses you can set the red and blue correction values here. This is certainly the optimal method for CA correction as it is done during RAW conversion.

3.3.5 Color Management Settings

Showfoto is color-management enabled. RAW files - as they come - are not color managed at all. Your camera provides the data it has captured in a raw format and will let you manage all the processing. Every camera has its specifics as to how it captures color information, therefore you will need to apply a specific profile to the images you want to process. Please refer to the section ICC color profile management for more details an explanations.

Basically, a profile “maps” the color information and gives information on how one should render them. It gives also information to LCMS and Showfoto on how to translate the color information from one color space to an other in order to keep the colors as accurate as possible across all rendering media.

- The Use color managed view is an alternative to using Xcalib or Argyll. Only your image will be color managed, not your entire screen!

**Behavior** Ask when opening an image in image editor / Launch Color Management tool with RAW files

**Color Profiles Directory** : set this to the folder where you store all your profiles e.g. “/usr/share/color/icc” or “/home/user/.color/icc”. Showfoto will scan this folder when starting up.

**ICC Profiles Settings** : here you are given the ability to provide “default” choices for your profiles. Everything is adaptable later-on at the opening of a RAW file.

- The Use color managed view is an alternative to using Xcalib or Argyll. Only your image will be color managed, not your entire screen!
• You have to provide a workspace profile (linear profiles such as sRGB, ECI-RGB, LStar-RGB, Adobe-RGB or CIE-RGB). If you want to print your images, you may want to opt for Adobe RGB, if it is only for web publishing, sRGB is better (Adobe RGB will be displayed slightly dull in non color managed enabled software such as browsers). However you may change this later of course (by attributing another profile), therefore Adobe RGB can be a good choice for storing and image handling as you can always change it to sRGB before releasing an image for your blog. Note: Do not use non-linear profiles as they will change the color-balance.

• The input profile should match the camera maker and model you are using. ‘Not all profiles are created equal’, there are some that have no tone mapping/gamma correction included (Canon). As of now, dcraw does not correct gamma for 16 bit depth conversion, which means that you have to do the tone mapping yourself.

• There are some other options such as the soft proof profile which enables you to emulate, granted that you have a profile for it, how your image will render for a particular device. It is useful before printing for instance because your printer has a smaller gamut than your camera and some colors might look saturated. You may want to fix this manually instead of relying on the “blind” algorithm of your printer.

For most cameras it is pretty obvious what color profile they propose for the type at hand, not so for the Canon’s. Here is a table of camera/profiles matches, it is non-authoritative of course:

<table>
<thead>
<tr>
<th>Camera</th>
<th>Profile series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canon 1D mark II</td>
<td>6051</td>
</tr>
<tr>
<td>Canon 1D mark II</td>
<td>6111</td>
</tr>
<tr>
<td>Canon 1Ds</td>
<td>6021</td>
</tr>
<tr>
<td>Canon 1Ds mark II</td>
<td>6081</td>
</tr>
<tr>
<td>Canon 5D</td>
<td>6091</td>
</tr>
<tr>
<td>Canon 10D</td>
<td>6031</td>
</tr>
<tr>
<td>Canon 20D</td>
<td>6061</td>
</tr>
<tr>
<td>Canon 30D</td>
<td>6112</td>
</tr>
<tr>
<td>Canon 40D</td>
<td>6101</td>
</tr>
<tr>
<td>Canon 300D</td>
<td>6031</td>
</tr>
<tr>
<td>Canon 350D</td>
<td>6111 or 6071</td>
</tr>
<tr>
<td>Canon 400D</td>
<td>6131</td>
</tr>
</tbody>
</table>

The Canon profile extension betray the target style: F for Faithful Style, L for Landscape Style, N for Neutral Style, P for Portrait Style, S for Standard Style.

Here you find a typical RAW workflow scenario.
3.3.6 Slide-Show Settings

The slide show setup should be easy to understand. The upper slider adjusts the time between image transitions; usually a time of 4-5 seconds is good. The other check boxes enable/disable the metadata to be shown on the bottom of the slide show images during display.
3.3.7 Miscellaneous Settings

3.3.7.1 General Settings

With the **Images Sort Order** setting, you can select whether newly-loaded images are sorted by their date, name, or size on disk.

With the **Reverse ordering** setting, newly-loaded images will be sorted in descending order.

With the **Show image Format** setting, you can show image format over image thumbbar thumbnail.

With the **Show Geolocation Indicator** setting, you can show over image thumbbar thumbnail an indication if image has geolocation information.
3.3.7.2 Application Behavior Settings

With the **Scroll current item to center of thumbbar** setting, you can force thumbbar to center current selected item with mouse pointer on the center of visible area.

With the **Show splash screen at startup** setting, you can switch off the display of the splash screen when application loads. This may speed up the start time slightly.

With the **Sidebar tab title** setting, you can set how sidebars on the sides will show the tab titles. Use **Only For Active Tab** option only if you use a small screen resolution as with a laptop computer. Else **For All Tabs** will be a best choice to discover quickly all internal features of Showfoto.

With the **Widget style** setting, you can choose the default application window decoration and looks. **Fusion** style is the best choice under all desktop.

With the **Icon theme** setting, you can choose the default application icon theme. Theme availability depends of desktop used to run Showfoto.

3.3.8 The Theme Setup

Color schemes are supplied like themes to personalize Showfoto main interface for you pleasure. To access these settings select **Settings → Themes** from the menubar and select your preferred theme to use.
Chapter 4

Acquire Images Tool

The Acquire Images tool is dedicated to scan images using a flat scanner.

This tool can be used to scan images using a flat scanner. The tool uses libksane, an interface for SANE library to control flat scanners.

It can save images in all main image containers, as for example the following formats:

- png (8 and 16 bits per color)
- jpeg, jpg, jpeg 2000
- tiff

NOTE
You can check the status of your scanner support from the SANE project website by entering the information on this search page: http://www.sane-project.org/cgi-bin/driver.pl.

4.1 Scanner Selection

If the selected scanner cannot be opened or if no default scanner is provided, a scanner selection dialog is opened.

The user can choose the scanner to be used and press OK to open the scanner. Pressing Cancel will cause the tool to exit.

No scanner found

In case no devices were found, maybe because the scanner is not plugged in or switched off, correct that. Then the Reload device list can be used to reload the list of scanners.

NOTE
Not all drivers/backends support this feature. In that case quit the tool, connect your scanner and restart the application.
4.2 Main Dialog

Main dialog

In the main window, the user has two sets of scan options: Basic Options and Scanner Specific Options. The Basic Options tab contains the most common parameters that the SANE scanner backends provide, while the Scanner Specific Options tab contains all the options of the backend. The options listed here depend on SANE support for your driver: libksane (which the tool uses) should be able to display most of the types of parameters that SANE provides (analog gamma tables are not supported at this time).

Scanner Specific Options tab

The scanner specific options contain more detailed options of the backends. The tool does not have any special handling for these options.

If you are satisfied with your settings, you can use the little arrow on the top of the options splitter. When clicked it collapses or expands the options. The collapsor can overlap the preview area, but fades away when the mouse cursor moves out of the collapsor.

4.3 Scanning

To scan an image, the user can start with a preview scan and then select the part of the scan area to do the final scan on. The preview scan is started by pressing the preview button.

The Preview Button

When the preview is scanned the area for the final image can be selected.

Selection and zoom

To better select the image the user can zoom in, out, to the current selection or zoom to fit the whole preview to the window.

The ”zoom to fit” button

When the image is selected the final image can be acquired by pressing the final scan button.

The final scan button

You will see the progress of the scan.

Scanning in progress

4.4 Scanning Multiple Selections

Sometimes you need only certain parts of an image. Instead of scanning the whole picture and then using a graphics application (e.g., KolourPaint) to save the different image parts into separate files, use the tool multiple selection feature.

Multiple Selections

Scan a preview and then use the left mouse button to select the first part of the image in the preview. Hover the selected area with mouse cursor and click on the green + icon to select the area. Selected areas are indicated by a red border. Now select the next parts of the image in the same way.

To remove a single selection hover the area with the mouse cursor and click on the red - icon. With Clear Selections from the context menu launched with the right mouse button all selections in a preview can be removed.

If you placed two separate images or photos on your scanner and started a preview the tool automatically preselect the different areas.

If you are satisfied with your choice starting the final batch scan of all selections. The selected parts of the image are scanned and saved separately into different files.
4.5 Help and Close

At the bottom of the main window you find the Help and Close buttons. The Help button brings up the menu described in the section Help Menu. The Close button is used to exit the tool.
Chapter 5

Geolocation

Geolocation means assigning, editing and using metadata which describe the geographic place where images or videos were taken. The source of these metadata can be your camera, a separate GPS receiver or other means of geographical information, in particular maps.

Not only for professional photographers can it be interesting to link an image to a precise geographical location. Not everybody uses an airplane to overfly and scan a certain area with automatic GPS data recording. Environmental planners, military, police, construction bureaus, real estate agencies, all will have an immediate application.

But if, after some time, one has forgotten where the image was taken, if one loves the nice feature to open with a simple click a browser displaying a zoom of the area, if you like to send your image as a postcard to another Showfoto user (who is then able to locate your shot), or if you simply need the documentation aspect of it - having position data stored in a photo is great.

GPS (global positioning system) is used as a generic term throughout this document. It just means a location in the common spherical coordinate system that can be displayed on a map. The actual technical implementation that provides the data can be the American GPS, the Russian GLONAS, the European GALILEO or any other system.

There are four tools regarding geolocation in digiKam and two in Showfoto:

1. The Map mode of the Image Area which displays images with GPS data on a map depending on the selection on the Left Sidebar, e.g. the images in the album you selected in the Album View, the images with a certain tag assigned (selected in the Tag View), with a certain label and so on. This is only available in digiKam.

2. The Map View on the Left Sidebar of digiKam which is the search tool for finding images by their GPS data. This is also only available in digiKam.

3. The Geolocation Editor we describe a little bit further below and which is accessible via Item → Edit Geolocation... (Ctrl+Shift+G) (File → Edit Geolocation... in Showfoto).

4. The Map tab on the Right Sidebar which shows the location of the image on a map and is purely informative.

All four are based on the Marble widget.

NOTE
These tools only work for image formats that have EXIF or XMP metadata supported by Exiv2 library.
5.1 Geolocation Editor

The Geolocation Editor allows for adding and editing GPS coordinates of picture metadata. The geo-data is stored into the image (EXIF tags) and the location can be displayed in an internal or external browser map. The Geolocation Editor also offers a Reverse Geocoding tool.

Geolocation Editor can be opened via menu entry **Item → Edit Geolocation** or via pressing **Ctrl+Shift+G**. It requires at least one image to be selected otherwise it will not open.

The Geolocation Editor provides the tools to localize pictures geographically in the common spherical coordinate system (used by GPS/Galileo). Altitude, latitude and longitude, speed, number of satellites, fix type and DOP are editable.

The editor has two methods to mark the pictures with coordinates:

- Semi-automatic coordinate attribution to single pictures, accessible via the **Details** tab on the Right Sidebar.
- Batch correlation of GPS tracking data with a series of images you will find in the **GPS Correlator** tab.

Furthermore the Right Sidebar offers three more tools:

- The **Undo/Redo** tab.
- The **Reverse Geocoding** tab which allows to find geographic names (cities, street names, ...) by using a public reverse geocoding service and the GPS data of an image.
- The **Search** tab which allows to find positions on the map from geographic names (cities, monuments, ...) by using a public geoname service (GeoNames and OpenStreetMap at the time of writing).
5.1.1 The map

For navigating on the map refer to Marble handbook, Chapter 2. Also for the sky context menu see Marble documentation.

Right under the map you find a row of buttons. I shall use the tooltip texts as designations in the following description. From left to right we have

- The Map-settings button opens a small menu which allows you to choose between Google Maps and Marble and depending on that choice to choose the kind of map you want to use. Furthermore you can select the projection for Marble (spherical, Mercator, equirectangular) and you can display a few additional tools like compass and scale on the map.
- The Zoom-in button.
- The Zoom-out button.
- The Switch-between-markers-and-thumbnails button lets you choose whether you want the positions of your images indicated by a marker symbol or by a thumbnail on the map. If you choose thumbnails the next two buttons are of particular interest.
- The Increase-the-thumbnail-size-on-the-map button is doing just that and ...
- ... the Decrease-the-thumbnail-size-on-the-map button as well.
- The Pan-mode button lets you move the map by click with the left mouse button and holding on it and then drag it with the mouse to where you need it. The cursor symbol will change to a hand.
- The Zoom-into-a-group button is useful if you have images so close to each other on the map that all but the topmost are obscured. Once you click on the visible image the zoom factor will be adjusted so that all the other images behind it become visible. If you click on a group of images and nothing really happens they either have exactly the same geographic position and/or the zoom factor is already at its maximum.

Note that ‘group’ in this context here has nothing to do with grouped images as described in chapter 2 of the digiKam Handbook. Here the term refers to images which are very close to each other on the map (depending on the zoom factor) or have exactly the same geographic position.

- The Select-images button toggles the selection of an image or a group of images in the list of images right below the buttons once you click on it on the map. The selection status of all other images in the list remain unchanged. Be aware of the fact that there is a kind of two-stage selection! If you click on a thumbnail or marker on the map the selected image(s) in the list of images will become a light blue background. If you click on it in the list the background will become a darker blue and if there where more than one image with light blue background before the others will become un-selected. Only clicking on an image in the list will let its preview appear to the right of the list.

- The Display-bookmarked-positions-on-the-map button is not working at the time of writing because the whole bookmark issue needs to be reorganized. This also affects the Bookmarks → Edit Bookmarks... item in the context menu on the list of images below the map and the Add Bookmark item in the context menu on the map.

**Warning**
The use of Add Bookmark in the context menu on the map can lead to loss of your bookmarks in Marble!

From the context menu on the map only Copy Coordinates is of interest for geotagging. It copies the geographic coordinates at the cursor position to the clipboard. For all other menu items see Marble handbook.

Note that you can change the layout from one map to two maps, beside or above each other via the little drop-down menu at the bottom of the Geolocation Editor.
5.1.2 Edit Coordinates

The coordinates can be set manually in the Details tab (see screenshot above). The location can be found and fixed iteratively with the displayed map. Move the mouse cursor to the region of interest, zoom in, adjust location, zoom in again, and so on until sufficient accuracy is achieved. Note that the zoom center will always be at the cursor position. Eventually you click with the right mouse button at the desired position and choose Copy Coordinates. Now you can go to the list of images below the map, select one or more images, click with the right mouse button on them and choose Paste Coordinates. The coordinates will then be displayed in the Latitude and Longitude fields to the right of the map. To save your changes you click the Apply button right under the DOP field.

If you have one or more images that already have GPS data you can copy the coordinates from one of those and paste them to one or more other images by using the respective items from the context menu on the list of images. This comes in handy if there is a series of photos taken at the same location.

To the right of the map there are, beside latitude and longitude, fields for altitude, speed, number of satellites, fix type and uncertainty (DOP). You may see these fields already filled in if you select a photograph where your camera wrote these information into the EXIF data. Otherwise you can fill them in manually if you have these data from somewhere else, e.g. a separate GPS receiver. Note that you have to check the relevant checkbox before you can edit a field (under Windows® you may have to double-click it). Only for Altitude the context menu on the list of images offers Look up missing altitude values which causes the editor to look up these data in the map data provided the position (latitude and longitude) is already assigned to the photograph.

To delete geolocation data you got to un-check the relevant checkbox and click the Apply button right under the DOP field. Other than that the context menu on the list of images offer items to remove some of the data from the image. Regarding the last item Bookmarks see here.

5.1.3 The Correlator

In order to correlate your images with geographic data you need to have a GPS tracking information available as a XML file in gpx format (gpsbabel and gpsman can download and convert tracking data from a GPS device for you). The idea is: while taking your pictures just keep a GPS device running and carry it around with the camera. Once you are done, download the pictures and the GPS tracks, and run the correlator.
Select the images you want to correlate in the application main view, then call the geolocation editor with (Ctrl+Shift+G) and switch to the GPS Correlator tab on the Right Sidebar. The above dialog will show up with the selected images in the list below the map. To indicate possible time/location correlation you have to load a track file with Load GPX File that contains GPS data taken at the same time and location as the pictures.

When the file is loaded and Show tracks on map is checked the track is displayed on the map. You can load more than one file and Showfoto will assign different colors to them and display the tracks on the map accordingly.

GPS track data is invariably recorded in UTC (Universal Time Coordinated), so you need to match the camera time with UTC, which can be done with Camera time zone. Select Same as system if you took the photographs in your home time zone and Showfoto will figure out the difference to UTC from your system time. If you took the photographs somewhere else you got to check Manual: and choose the appropriate difference from the drop-down field to the right. You can use the same mechanism as well to correct a simple mis-adjustment of your camera time for whatever reasons or an offset of a gpx-file due to quirks of a software used to convert other track file formats into gpx. Here comes Fine offset (mms) into play where you can add or subtract up to 59 minutes and 59 seconds to your time difference chosen in the field above.

The Max. time gap (sec.): setting specifies the limit within which GPS time and camera time shall be deemed coincident. The maximum value is 2000 seconds. This means that if no entry in the gpx-file matches the time stamp of the photograph exactly, the position of the entry with the smallest time gap to the photograph will become assigned to it as long as this time gap is smaller than the Max. time gap (sec.): setting. If you wonder which value you should specify here a look into the settings of your track recording device/software or into the gpx-file (which is easily possible with a text editor) might help. The faster you were moving while taking the photograph(s) the more important this decision will be.

Interpolate offers another option in case there is no exact match between the time stamp of your photograph(s) and an entry in the gpx-file and as long as you were moving more or less straight between two recorded GPS positions it will be the more precise option. Here the position of the photograph is calculated (linear interpolated) from the positions of the two closest entries in the gpx-file and the respective differences in time. If, for instance, the time gaps between the two closest entries and the photograph are equal the position assigned will be on a straight line between the positions of the two entries right in the middle.
Max. interpol. time gap (min): has nothing to do with policeman Max from Interpol ;-) Instead it determines whether a GPS point is eligible for interpolation. If its time is farther away from the picture time than this limit, it cannot be used. 240 minutes is the maximum time difference that can be introduced here.

Once your settings are done you click on the Correlate button. If there is no match at all you will get the message “Could not correlate any image - please make sure the timezone and gap settings are correct.” Otherwise you will get something like “2 out of 4 images have been correlated. Please check the timezone and gap settings if you think that more images should have been correlated.” Best case you get “All images have been correlated. You can now check their position on the map.”

If you want to follow this recommendation it is a good idea to change to the Details tab since there you have a preview of the images which can help a lot to identify them on the map. Remember that you always have to click on an image in the list under the map to make its preview show up. Once you are satisfied with the results click the Apply button at the bottom of the Geolocation Editor to save the changes to the image file and the database.

5.1.4 Undo/Redo

In the Undo/Redo tab a history is being recorded about all the changes you apply to the images loaded into the Geolocation Editor. The history shows changes made in only one tab or in several tabs and will be deleted only once you leave the editor. After a few actions in the different tabs the record might look like this:

```
<empty>
Coordinates pasted
Image tags are changed.
Details changed
1 image moved to 'La Matanza de Acentejo'
```

The last step is highlighted when you enter the tab. The first step is always labeled ‘empty’ and represents the status the images had when they were loaded. You can click on every step and, depending on what kind of changes you did, you might see the images appearing, disappearing or moving on the map or see the differences in the list of images under the map. Note that the list is configurable by clicking with the right mouse button on the header.

Now let’s assume that you realize that the move in the last step was wrong. You just click on the step before (Details changed), you go to the Search tab (described further below) and you do another move. After returning to the Undo/Redo tab it might look like this:
5.1.5 Reverse Geocoding

In this tab you can use a public geoname service to look up address details of the geographic position of one or more images and convert them into tags. In order to do that you need a few preparations. You should be already familiar with the idea of tags and how to create, edit and use them. The best entry into this issue you find in the Tags View section of Chapter 2 of the digiKam handbook.

First you should create a root tag in the Tag Manager or in the tag tree of the Left or Right Sidebar. You might name it Location or Places or ...

Then you select the image(s) you want to tag (they need to have GPS data assigned), open the Geolocation Editor and click the Reverse Geocoding tab. You will see your tag tree and if you click with the right mouse button over a tag, preferable the one you created for the geo tags, you will see this context menu:
In the main section the tags you can add are sorted from the largest region (country) down to the smallest (house number). If you choose **Add all address elements** and then fold out the Location tag and all the sub-tags you will have this:

These red tags in curly brackets are called control tags. They determine which address elements you want the reverse geolocation service you have chosen at the top under **Select service** to look for. You can still delete some of them with the help of the context menu if you feel that you don’t need them or modify the structure by deleting some control tags and add them in other places of the tree or even build a new tree parallel to the first by adding a control tag to the root tag (here: Location). Arranging the control tags on the same level instead of a tree structure can save a lot of redundant tags since the same city or town name exists in more than one state or country let
alone street names. But it can make the whole location branch of your tag tree quite long and therefore incalculable. This is to say that you have to find your own solution to this problem depending on your needs, maybe a mix, and the sooner you find it the less work you have to invest in editing your tag tree and the control tags.

Let us assume you use the control tags as shown in the above screenshot, select the images you want to tag from the list of images to the left and click **Apply reverse geocoding**. Then the tag tree might look similar to this:

The green tags represent the search result of the selected public reverse geocoding service and are already assigned to the image(s). To save these tags to the image file and the Showfoto database click **Apply**. The tags will appear as regular tags in your tag tree which you can see already here or in the tag tree of the Left or Right Sidebar. Of course you can still edit them like any other tag in the Tag Manager or in the Left or Right Sidebar, but not here in the Geolocation Editor.

### 5.1.6 Search

In the **Search** tab you can look up places by their geographic names using public geoname services (GeoNames and OpenStreetMap at the time of writing). You just type in a name of a place (city, monument, hotel, ...) into the input field at the top and click **Search**. In the result list below you will get something like this:

Obviously Paris does not only exist in France. So if you were looking for the capital of France you can either scroll down the list until you find an entry that undoubtedly belongs to there like “Arc de Triomphe” and click on it or specify your search a little bit more precise like “Paris, Arc de Triomphe” or “Paris, France”. Once you click on an entry in the list the map will become centered to that place and you can now zoom in with the zoom-in button (second from the left below the map). Using this example with GeoNames you will notice that you still get a lot of results and even two labeled only “Arc de Triomphe”, the second one a street a few hundred meters away from the arch. With OSM you get only one result. You got to play a bit with the different services in different regions, with more or less precise search terms and then you will get an idea about how to best conduct your searches.

For the buttons right above the result list refer to their tooltips! The context menu on search result entries offers
The Showfoto Handbook

- **Copy coordinates** which you can paste later to one or more images in the image list under the map.

- **Move selected images to this position** which is basically the same but more straightforward provided you have the images already loaded into the geolocation editor.

- **Remove from results list** which is particularly useful in conjunction with the Keep-the-results-of-old-searches-... button above the results list.
Chapter 6

Presentation Tool

The ‘Presentation’ tool creates a configurable full screen slide-show of your images using advanced visual effects.

With this tool you can create a perfect slide show with just three mouse clicks.

6.1 The Settings Dialog

When opening the tool, the Presentation window will appear asking questions as to how you want to stage your slide show. You can choose between the selected images or all images in the same album.

The Use OpenGL Slideshow Transitions checkbox enables very smooth image transitions using the OpenGL display mode. Be sure you have OpenGL enabled on your graphics card, since otherwise the slideshow will be very slow.

The Print Filename checkbox enables displaying the image filename in the lower left corner.

The Loop checkbox will enable running the whole show in an endless loop (until manually stopped with Esc).

The Shuffle Image checkbox will enable displaying the images randomly (not using the current images collection order).

The Delay Between Images may be set in millisecond steps. 1500 milliseconds correspond to 1.5 seconds and is a good default value. The best timing depends also a bit on your computer power and the transition effect. Try it out before you show it to your friends!

There are more than a dozen Transition Effects available to choose from. The Random selection will change the transition effect with every image.

Figure 6.1: The Presentation Dialog

6.2 Presentation Tool in Action

During the slide show, you can access a toolbar on the upper left screen corner. Move the mouse cursor to the top left of the screen to access it.
With this tool bar, you can drive the progress of the slide show. You can pause or play the slide show, go back to the preview image, go to the next image, and stop the slide show.

In the lower left screen corner you can see the current image file name, the current image ID, and the total number of images included in the slide show.

Figure 6.2: The Presentation Tool in Action
Chapter 7

Metadata Editor

The Metadata Editor is a tool for adding and editing EXIF, IPTC, or XMP metadata attached to an image.

Image metadata is textual information that can be attached to digital images in order to annotate, describe and categorise them. This information is useful for searching and indexing images and for accessibility services. There are three standard formats in which image metadata can be stored: EXIF, IPTC and XMP. They concentrate on different properties of the image and are used for different purposes. Showfoto provides tools for viewing and editing image metadata in all these formats.

The application offers metadata editing tools available through the Edit Metadata menu entry. The metadata editor conveniently arranges all metadata into sections for each kind of metadata chunk, making it easier to find and edit specific entries. For example, to edit hardware-related information, switch to the Device section. Here you can modify device manufacturer, device model, exposure-related settings, and other information.
In addition to EXIF, IPTC and XMP formats are supported, so you can perform the described actions on metadata stored in these metadata chunks as for EXIF. Remember that EXIF is dedicated to store camera information, where IPTC and XMP are more used to store post-process text information such as rights management. So, it is not recommended to edit the metadata injected by the camera that took the photograph; on the other hand, you can add information about the author, copyright, etc. Detailed description of supported entries is available online.

Note that you can synchronise some specific metadata entries from one chunk to another one, as for example the comments which is available in EXIF, IPTC, and XMP as separate entries. Mark the check boxes corresponding to the entries you wish to copy from one format to another.

**CAUTION**

Note that synchronising metadata may produce undesired results because EXIF is limited to pure ASCII character set.
Chapter 8

Menu Descriptions

8.1 The Image Editor

8.1.1 The File Menu

File → Back (PgUp)
Display the previous image of the current Album.

File → Forward (PgDn)
Display the next image of the current Album.

File → First (Ctrl+Home)
Display the first image of current Album.

File → Last (Ctrl+End)
Display the last image of current Album.

File → Save (Ctrl+S)
Save the current image if it has been modified.

File → Save As...
Save the current image in a new file.

File → Revert
Restore the current image from the original file if it has been modified.

File → Delete File Move to trash (Shift-Del)
Delete/Move to trash the current image from the current Album.

File → Print Image... (Ctrl+P)
Print the current image.

File → Quit (Ctrl-Q)
Quit Showfoto Image Editor.
8.1.2 The Edit Menu

**Edit → Copy (Ctrl+C)**
Copy the current image selection in the clipboard.

**Edit → Undo (Ctrl+Z)**
Cancel the last action applied to the current image using history.

**Edit → Redo (Ctrl+Shift+Z)**
Redo the last action applied to the current image using history.

8.1.3 The Color Menu

**Color → Auto-Correction (Ctrl+Shift+B)**
Automatic color/exposure correction of the current image by an histogram manipulation (help).

**Color → White Balance**
Image Editor tool to adjust white color balance on the current image (help).

**Color → Brightness/Contrast/Gamma**
Exposure correction of the current image by Brightness, Contrast, or Gamma adjustments (help).

**Color → Hue/Saturation/Lightness (Ctrl+U)**
Color correction of the current image by Hue, Saturation, or Lightness adjustments (help).

**Color → Color Balance (Ctrl+B)**
Color correction of the current image by Red, Green, or Blue adjustments (help).

**Enhance → Curves Adjust**
Image Editor tool to adjust curves manually on the current image (help).

**Color → Levels Adjust**
Image Editor tool to adjust levels manually on the current image (help).

**Color → Channel Mixer**
Image Editor tool to mix color channels on the current image.

**Color → Invert (Ctrl+I)**
Invert image colors.

**Filter → Black & White**
Open the Black & White filter dialog for the current image.

**Color → Color Management**
Invokes the interactive Color Management editor.

**Color → Depth**
Toggle between 8 bit and 16 bit format on color channels.
8.1.4 The Enhance Menu

Enhance → Sharpen
Classical image sharpening operation (help).

Enhance → Blur
Image softening operation by blurring (help).

Enhance → Red Eye Reduction
Red Eye correction tool using the current selection (help).

Enhance → Inpainting
Image Editor tool to remove unwanted areas and specs (help).

Enhance → Noise Reduction
Image Editor tool to reduce the noise with a Despeckle filter (help).

Enhance → Restoration
Image Editor tool to reduce artifacts on the current image (help).

Enhance → Hot Pixels Correction
Image Editor tool to remove hot pixels on the current image (help).

Enhance → Anti Vignetting
Image Editor tool to correct vignetting of the current image (help).

Enhance → Lens Distortion Correction
Image Editor tool to correct lens distortion of the current image (help).

8.1.5 The Transform Menu

Transform → Rotate → -90 degrees (Ctrl+Shift+Left)
Left rotation of the current image.

Transform → Rotate → 90 degrees (Ctrl+Shift+Right)
90 degrees rotation of the current image.

Transform → Free Rotation
Image Editor tool to rotate the current image by any angle in degrees (help).

Transform → Flip → Horizontally (Ctrl+*)
Horizontal flip of the current image.

Transform → Flip → Vertically (Ctrl+/)
Vertical flip of the current image.

Transform → Crop (Ctrl+X)
Crop image to the current selection.

Transform → Resize
Resize (reduce or blow-up) the current image to the appropriate factor or dimensions (help).

Transform → Aspect Ratio Crop
Crop the current image using an constrained aspect ratio (help).
Transform → Shear
Image Editor tool to shear the current image horizontally or vertically (help).

Transform → Perspective Adjustment
Image Editor tool to adjust perspective of the current image (help).

8.1.6 The Decorate Menu

Decorate → Apply Texture
Image Editor tool to apply decorative texture to the current image.
See the dedicated Apply Texture manual for more information.

Decorate → Add Border
Image Editor tool to add a decorative border around the current image (help).

Decorate → Insert Text
Image Editor tool to insert text in the current image (help).

8.1.7 The Effects Menu

Effects → Color Effects
Set of four Image Editor tools: Solarize, Vivid (Velvia), Neon and Edge (help).

Effects → Add Film Grain
Image Editor filter for to adding Film Grain (help).

Effects → Oil paint
Image Editor filter to simulate Oil Painting (help).

Effects → Charcoal Drawing
Image Editor filter to simulate Charcoal Drawing (help).

Effects → Emboss
Image Editor Emboss filter (help).

Effects → Distortion Effects
Image Editor filter set with distortion special effects (help).

Effects → Blur Effects
Image Editor filter set with blurring special effects on (help).

Effects → Raindrops
Image Editor filter to add Rain Drops (help).
8.1.8 The View Menu

**View → Zoom In (Ctrl++)**
Increase the zoom factor on the current image.

**View → Zoom Out (Ctrl+-)**
Decrease the zoom factor on the current image.

**View → Fit to Window (Ctrl+Shift+A)**
Toggle between fit-to-window zoom or 100% image zoom size.

**View → Fit to Selection (Ctrl+Shift+S)**
Make the selection fit the window.

**View → Histogram**
Display superposed histogram on current image (Luminosity, Red, Green, Blue, Alpha).

**View → Slideshow**
Start a slideshow of the current album.

8.1.9 The Settings Menu

**Settings → Full Screen Mode (Ctrl+Shift+F)**
Toggles the graphic interface to full screen mode.

**Settings → Configure Shortcuts**
Configure the Showfoto image editor shortcuts.

**Settings → Configure Toolbars**
Configure the Showfoto image editor toolbars.

8.1.10 The Help Menu

**Help → Showfoto Handbook (F1)**
Invokes the KDE Help system starting at the Showfoto help pages. (this document).

**Help → What’s This? (Shift+F1)**
Changes the mouse cursor to a combination arrow and question mark. Clicking on items within Showfoto will open a help window (if one exists for the particular item) explaining the item’s function.

**Help → Report Bug...**
Opens the Bug report dialog where you can report a bug or request a ‘wishlist’ feature.

**Help → Switch Application Language...**
Opens a dialog where you can edit the Primary language and Fallback language for this application.

**Help → About Showfoto**
This will display version and author information.

**Help → About KDE**
This displays the KDE version and other basic information.
Chapter 9

Credits and License

Program copyright 2001-2017, digiKam developers team
Documentation copyrighted by:

- 2001-2018
  - Gilles Caulier caulier_dot_gilles_at_gmail_dot_com
- 2001-2005
  - Renchi Raju renchi_dot_raju_at_gmail_dot_com
- 2003-2005
  - Richard Taylor r_dot_taylor_at_bcs_dot_org_dot_uk
  - Ralf Hoelzer kde_at_ralfhoezer_dot_com
  - Joern Ahrens kde_at_jokele_dot_de
  - Oliver Doerr oliver_at_doerr-privat.de
The Showfoto Handbook

- 2006
  - Elle Stone jrle1_at_twcnry_dot_rr_dot_com

- 2007
  - Kåre Särä kare_dot_sars_at_iki_dot_fi
  - Anne-Marie Mahfouf annma_at_kde_dot_org

- 2003-2010
  - Gerhard Kulzer gerhard_at_kulzer_dot_net

- 2017-2018
  - Antoni Bella Pérez antonibella5_at_yahoo_dot_com>

This documentation is licensed under the terms of the GNU Free Documentation License. This program is licensed under the terms of the GNU General Public License.
Chapter 10

Index

C
Comments, 170

E
EXIF, 170

F
Flat scanner, 155

G
GPS, 158

I
IPTC, 170

M
Makernote, 170
Map, 158
Metadata, 170

P
Presentation, 168

X
XMP, 170